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The information provided in this documentation contains general descriptions and/or technical 
characteristics of the performance of the products contained herein. This documentation is not 
intended as a substitute for and is not to be used for determining suitability or reliability of these 
products for specific user applications. It is the duty of any such user or integrator to perform the 
appropriate and complete risk analysis, evaluation and testing of the products with respect to the 
relevant specific application or use thereof. Neither Schneider Electric nor any of its affiliates or 
subsidiaries shall be responsible or liable for misuse of the information contained herein. If you 
have any suggestions for improvements or amendments or have found errors in this publication, 
please notify us. 
You agree not to reproduce, other than for your own personal, noncommercial use, all or part of 
this document on any medium whatsoever without permission of Schneider Electric, given in 
writing. You also agree not to establish any hypertext links to this document or its content. 
Schneider Electric does not grant any right or license for the personal and noncommercial use of 
the document or its content, except for a non-exclusive license to consult it on an "as is" basis, at 
your own risk. All other rights are reserved.
All pertinent state, regional, and local safety regulations must be observed when installing and 
using this product. For reasons of safety and to help ensure compliance with documented system 
data, only the manufacturer should perform repairs to components.
When devices are used for applications with technical safety requirements, the relevant 
instructions must be followed. 
Failure to use Schneider Electric software or approved software with our hardware products may 
result in injury, harm, or improper operating results.
Failure to observe this information can result in injury or equipment damage.
© 2018 Schneider Electric. All rights reserved.
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Safety Information
Important Information

NOTICE
Read these instructions carefully, and look at the equipment to become familiar with the device 
before trying to install, operate, service, or maintain it. The following special messages may appear 
throughout this documentation or on the equipment to warn of potential hazards or to call attention 
to information that clarifies or simplifies a procedure.
EIO0000001505 09/2018 9



PLEASE NOTE
Electrical equipment should be installed, operated, serviced, and maintained only by qualified 
personnel. No responsibility is assumed by Schneider Electric for any consequences arising out of 
the use of this material.
A qualified person is one who has skills and knowledge related to the construction and operation 
of electrical equipment and its installation, and has received safety training to recognize and avoid 
the hazards involved.
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About the Book
At a Glance

Document Scope
This manual describes how to use the Wireless Remote Control System.

Validity Note
This document has been updated for the eXLhoist Firmware version V4.
The technical characteristics of the devices described in the present document also appear online. 
To access the information online:

The characteristics that are presented in the present document should be the same as those 
characteristics that appear online. In line with our policy of constant improvement, we may revise 
content over time to improve clarity and accuracy. If you see a difference between the document 
and online information, use the online information as your reference.

Step Action
1 Go to the Schneider Electric home page www.schneider-electric.com.
2 In the Search box type the reference of a product or the name of a product range.

 Do not include blank spaces in the reference or product range.
 To get information on grouping similar modules, use asterisks (*).

3 If you entered a reference, go to the Product Datasheets search results and click on the 
reference that interests you.
If you entered the name of a product range, go to the Product Ranges search results and click 
on the product range that interests you.

4 If more than one reference appears in the Products search results, click on the reference that 
interests you.

5 Depending on the size of your screen, you may need to scroll down to see the data sheet.
6 To save or print a data sheet as a .pdf file, click Download XXX product datasheet.
EIO0000001505 09/2018 11
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Related Documents

You can download these technical publications and other technical information from our website 
at https://www.schneider-electric.com/en/download

Product Related Information

Title of Documentation Reference Number
Quick Start Guide NHA45689
Instruction Sheet System XARS8L HRB57247
Instruction Sheet System XARS•D HRB57248
Instruction Sheet Accessory Charger HRB57251
Instruction Sheet Accessory Soft & Cables HRB57273
Instruction Sheet Accessory Shoulder Harness HRB57274
Instruction Sheet Accessory Remote Holder HRB57277
Instruction Sheet Accessory Rubber Protection EAV52994
Instruction Sheet Accessory Pad & Trigger EAV52985
Instruction Sheet Accessory External Antenna EAV59906
Instruction Sheet Added Features Card ZARCFBA01 PHA16126

DANGER
HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH
 Disconnect all power from all equipment including connected devices prior to removing any 

covers or doors, or installing or removing any accessories, hardware, cables, connectors or 
wires except under the specific conditions specified in this user guide.

 Always use a properly rated voltage sensing device to confirm that the power is off.
 Unplug the power cable from both the equipment and the power supply.
 Replace and secure all covers, accessories, hardware, cables, and wires and confirm that a 

proper ground connection exists before applying power to the equipment.
 Use only the specified voltage when operating this equipment and any associated products.
Failure to follow these instructions will result in death or serious injury.
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WARNING
UNINTENDED EQUIPMENT OPERATION
 Do not open the Remote Device.
 Do not replace internal parts of the Base Station.
 After a Base Station power off, wait until the POWER LED becomes OFF (around 20 seconds) 

before removing the cover.
 Always comply with the local requirements regarding installation and use of the hoisting 

devices.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

WARNING
UNINTENDED EQUIPMENT OPERATION
 Only use software approved by Schneider Electric for use with this equipment.
 Update your application program every time you change the hardware configuration.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

NOTE: 
To increase the system security, it is recommended to use Configuration File transfer password 
(see page 210).
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Battery Warning Notes
Carefully read all instructions in this user guide, and look at the equipment to become familiar with 
the device before trying to install, operate, or maintain it.
For more information, contact us at www.schneider-electric.com or contact your local reseller.

WARNING
EXPLOSION, FIRE, OR CHEMICAL HAZARD
 Electric devices that have reached the end of their life must be collected separately and 

returned to an environmentally compatible recycling facility in accordance with national law.
 In case of electrolyte leak from battery, use adapted safety equipment and put the device in a 

sealed package. 
 If you come into contact with electrolyte, immediately thoroughly wash the involved parts with 

clear water and call medical assistance.
 Do not incinerate the device.
 Do not drop or hit the device.
 Do not use a damaged device.
 Do not replace Remote Device battery by yourself. In case of Remote Device battery 

malfunction or for any maintenance, contact us at www.schneider-electric.com or contact your 
local reseller.

Failure to follow these instructions can result in death, serious injury, or equipment damage.

NOTE: Advice to improve battery life:

 Charge the battery before device requires it.
 Charge the battery with room temperature within 10…40 °C (50…104 °F).
 Charge the battery once in every six months if you do not use it for a long time.
14 EIO0000001505 09/2018
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Wireless Remote Control System

Chapter 1
Wireless Remote Control System

What Is in This Chapter?
This chapter contains the following sections:

Section Topic Page
1.1 Description 16
1.2 Parts Identification 24
1.3 Description and Safety Function Capability 37
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Wireless Remote Control System
Description

Section 1.1
Description

What Is in This Section?
This section contains the following topics:

Topic Page
Wireless Remote Control System Overview 17
Single Mode 18
Multi Base Control Mode 21
Package Contents 23
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Wireless Remote Control System
Wireless Remote Control System Overview

Overview
The Harmony™ eXLhoist range of wireless remote control systems is an operator control station 
used in hoisting and material handling applications.
The Wireless Remote Control System is based on 2 types of devices:
 Remote Device, which is the operator command device to interface with the machine.
 Base Station, which is hardwired to the machine. It receives control commands from the Remote 

Device and transmits information to the operator.
The Wireless Remote Control System is a combination of these devices which communicate by 
radio transmission.

Radio Communication
Each Base Station have a unique ID managed by Schneider Electric. 
Technology used permits up to 50 single systems working at same time without perturbation in a 
100 x 100 meter area.

Main Applications
Main applications modes are available:
 Single mode = one Remote Device commands one Base Station.

For more information, refer to Single Mode (see page 18).
 Multi Base Control (MBC) = one Remote Device commands up to two Base Stations 

simultaneously or individually.
For more information, refer to MBC Mode (see page 21).
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Wireless Remote Control System
Single Mode

Overview
Single Mode = one Remote Device commands one Base Station.

Auxiliary Selector
One auxiliary selector can be configured to select devices (hooks or trolleys):
 3 positions (for example: for trolleys)
 2 positions (for example: for hooks)

Example of Single with 1 Trolley
The Remote Device controls one trolley.

1 Remote Device
2 Trolley
3 Base Station
4 Electrical cabinet
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Wireless Remote Control System
 

Example of Single with 2 Trolleys
By using the auxiliary selector button (3 positions), the Remote Device separately controls the 
trolley 1, trolley 1+2 or the trolley 2.

1 Remote Device
2 Trolley 1
3 Trolley 2
4 Base Station
5 Electrical cabinet
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Wireless Remote Control System
Example of Single with 2 Hooks
By using the auxiliary selector button (2 positions), the Remote Device separately controls the 
hook 1 or the hook 2.

1 Remote Device
2 Hook 1
3 Hook 2
4 Base Station
5 Electrical cabinet
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Wireless Remote Control System
Multi Base Control Mode

Overview
Multi Base Control (MBC) = one Remote Device commands one or two Base Stations.
There are 4 kinds of Multi Base Control (MBC) configuration:

On a Master Remote Device, a base selector button allows you to choose one of the following:
 “A”: The Remote Device communicates only with Base Station A as if it was in single/slave 

mode
 “B”: The Remote Device communicates only with Base Station B as if it was in single/slave 

mode.
 “A+B”: The Remote Device communicates simultaneously with both Base Station A and Base 

Station B. The 2 Base Stations are controlled simultaneously.

STANDALONE MASTER / SLAVE MASTER / MASTER LARGE CRANE

One Master Remote Device 
controls 2 machines 
simultaneously or 
individually (Base Station A, 
B, or A+B).

The Master Remote Device 
controls 2 machines 
simultaneously or 
individually (Base Station A, 
B, or A+B).
The Slave Remote Device 
can only control one 
machine (Base Station B).

Identical to Master/slave 
except that both Remote 
Devices can be the Master 
Remote Device.

One Master Remote Device 
controls 2 machines 
simultaneously (Base 
Station A+B).
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Wireless Remote Control System
Auxiliary Selector
Up to 2 Auxiliary selectors can be configured to select devices (hooks or trolleys):
 3 positions (for example: for trolleys)
 2 positions (for example: for hooks)
Auxiliary selector button of the Remote Device can be assigned to:
 2 Base Stations (same action to the 2 Base Stations in the same time).
 1 Base Station (each Auxiliary selector of Base Stations is assigned to a different Auxiliary 

selector button of the Remote device). 
 1 Auxiliary selector can be assigned to only one Base Station.

Example of Multi Base Control with 1 Trolley Per Base Station
By using the Base selector button, the Remote Device separately controls the bridge A, 
bridge A+B, or the bridge B.

1 Remote Device
2 Base Station A
3 Bridge A
4 Base Station B
5 Bridge B
6 Electrical cabinets
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Wireless Remote Control System
Package Contents

Overview
Applicable items that could be included in the XARS package:

1 Base Station
2 Remote Device
3 Set of labels to customize the Remote Device buttons
4 Instruction Sheet and Quick Start Guide
5 Charger of the Remote Device battery (included in starting kits)
6 Shoulder belt for the Remote Device (included in starting kits)
7 Cable to connect the Remote Device to a PC (included in starting kits)
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Wireless Remote Control System
Parts Identification

Section 1.2
Parts Identification

What Is in This Section?
This section contains the following topics:

Topic Page
Wireless Remote Control System Overview 25
Base Station Parts Identification and Main Features 27
Remote Device Parts Identification and Main Features 30
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Wireless Remote Control System
Wireless Remote Control System Overview

Wireless Remote Control System Overview
The Wireless Remote Control System is a combination of 2 kinds of devices:
Base Station:

Remote Device:

Systems and Starting Kits
Therefore, 3 levels of complexity for Wireless Remote Control System: 

References ZARB12W• ZARB12H• ZARB18W• ZARB18H•
Connectors Cable gland for wires Industrial plug Cable gland for wires Industrial plug
Nb. of inputs 0 18
Nb. of relays 12 18

Features ZART8L• ZART8D• ZART12D•
Number of configurable buttons 8 8 12
Operator interface LEDs Display Display

Complexity level description Reference
Wireless Remote 
Control System

Remote Device Base Station

Basic system:
For simple applications, which include 
up to 2 auxiliary buttons

XARS8L12W ZART8L ZARB12W

XARS8L12H ZART8L ZARB12H

Extended system:
For adapted applications which 
include up to 2 auxiliary buttons

XARS8D18W ZART8D ZARB18W

XARS8D18H ZART8D ZARB18H

Complex system:
For complex applications which 
include up to 6 auxiliary buttons

XARS12D18W ZART12D ZARB18W

XARS12D18H ZART12D ZARB18H
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Wireless Remote Control System
Starting kits: 

NOTE: These systems and starting kits do not include MBC (Multiple Base Control) function.
For MBC function, it is needed to buy the Remote Device and Base Station separately 
(see page 26).

Multi Base Control
Remote Devices and Base Stations references: 

Reference
Starting Kit System Accessories

XARSK8L12W XARS8L12W ZARC01 + ZARC02
XARSK8L12H XARS8L12H ZARC01 + ZARC02
XARSK8D18W XARS8D18W ZARC01 + ZARC02
XARSK8D18H XARS8D18H ZARC01 + ZARC02

XARSK12D18W XARS12D18W ZARC01 + ZARC02
XARSK12D18H XARS12D18H ZARC01 + ZARC02

Reference Single Mode
MBC Mode

Slave Master
Remote Device ZART8L ✓

ZART8D ✓
ZART12D ✓
ZART8LM ✓ ✓
ZART8DM ✓ ✓ ✓

ZART12DM ✓ ✓ ✓
Base Station ZARB12W ✓

ZARB12H ✓
ZARB18W ✓
ZARB18H ✓

ZARB18WM ✓ ✓
ZARB18HM ✓ ✓
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Wireless Remote Control System
Base Station Parts Identification and Main Features

Base Station Parts Identification
 

Side Description
Bottom
ZARB•W•

Bottom
ZARB•H•
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Wireless Remote Control System
 

Front 
without 
the cover

Part Description
A M12 for external antenna (covered by cap)
B Status LEDs
C M20 for the safeguarding function input wires (covered by cap)
D 62 pins connector (covered by cap)
E M25 for output wires (covered by cable gland)
F M25 for detected applicative alarms input wires (covered by cap)
G 4 holes for standard mounting on support

Side Description
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Wireless Remote Control System
Base Station Main Features
 

References ZARB12W• ZARB12H• ZARB18W• ZARB18H•
Radio communication via 
internal antenna

Yes

External antenna connector Yes
Connections Screw terminals Industrial plug Screw terminals Industrial plug
Q0 safety relays outputs 2 (Q0_A, Q0_B)
IN0 / S2_S3 feedback loop 
terminals for mirror contacts 
from safety actuator

1

Configurable inputs for 
detected applicative alarms

0 6 (IN1…IN6)

Inputs dedicated for 
safeguarding function

0 12 (IN7…IN18)

Motion & auxiliary standard 
relays

12 (Q1…Q12) 18 (Q1…Q18)

Power supply 24…240 Vac 
50/60 Hz

24…240 Vdc

24…48 Vac 
50/60 Hz

24…48 Vdc

24…240 Vac 
50/60 Hz

24…240 Vdc

24…48 Vac 
50/60 Hz

24…48 Vdc
Current consumption AC 535 mA 

(24 V)…250 mA 
(240 V)

535 mA 
(24 V)…312 mA 

(48 V)

535 mA 
(24 V)…250 mA 

(240 V)

535 mA 
(24 V)…312 mA 

(48 V)
DC 328 mA 

(24 V)…44 mA 
(240 V)

328 mA 
(24 V)…155 mA 

(48 V)

328 mA 
(24 V)…44 mA 

(240 V)

328 mA 
(24 V)…155 mA 

(48 V)
System earthing TN, TT
Q0_A contact voltage 24…240 Vac/dc 24…48 Vac/dc 24…240 Vac/dc 24…48 Vac/dc
Q0_B contact voltage
Motion / auxiliary contact 
voltage used by group
Motion / auxiliary relay group  Q1…Q3

 Q4…Q6
 Q7…Q9
 Q10…Q12

 Q1…Q3
 Q4…Q6
 Q7…Q9
 Q10…Q12
 Q13…Q16

Motion / auxiliary relay in 
NO+NC type

- Q17, Q18
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Wireless Remote Control System
Remote Device Parts Identification and Main Features

Remote Device Views Parts Identification
 

 

ZART8D• ZART12D• ZART8L• ZART•

Part Description
1, 1H, 2, 2H, 3, 3H, 4, 4H, 5, 6 Motion buttons
7 Trigger button
8 OFF/STOP button
9 ON/START/Horn button
10, 11, 12, 13, 14, 15 Auxiliary buttons
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Wireless Remote Control System
Remote Device Rear View Parts Identification

Part Description
1 Cover
2 RJ45 socket
3 Reset button
4 2 Torx screws, diameter 3.5 mm (0.14 in)
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Wireless Remote Control System
Remote Device Bottom View Parts Identification

Part Description
1 Remote Device battery charge connector
2 Protective plug
3 E-STOP button

DANGER
OBSTRUCTED PUSH-BUTTON MOTION
Ensure push-button will fully operate.
Failure to follow these instructions will result in death or serious injury.
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Wireless Remote Control System
ZART•D• Display Parts Identification

Part Description
1 Battery level (see page 177)
2 Padlock displayed when a password is requested.

Padlock displayed when a password is requested for:
 Configuration File transfer (see page 210)
 E-STOP reset or START access (see page 223)

3 Radio communication level (see page 178)
4 Operating status (see page 130)
5 Detected applicative alarms (see page 180)
6 Base Station labels
7 Auxiliary Selector status
8 E-STOP LED (see page 179)
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Wireless Remote Control System
Base Stations labels and Auxiliary selectors states:

Part Description
1 Label of the primary Base Station(1)

2 State of the Auxiliary selector S1 associated to the primary Base Station(2)

3 State of the Auxiliary selector S2 associated to the primary Base Station(2)

4 State of the Auxiliary selector S1 associated to the secondary Base Station(2)

5 State of the Auxiliary selector S2 associated to the secondary Base Station(2)

6 Label of the secondary Base Station(1)

1 For more information, refer to MBC Base selector (see page 150)
2 For more information, refer to Auxiliary selector (see page 152)
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Wireless Remote Control System
ZART8L• Display Parts Identification

For more information, refer to ZART8L• diagnostic (see page 182).

Part Description
1 Battery level LED
2 START LED
3 Auxiliary Selector S1 LEDs
4 E-STOP LED
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Wireless Remote Control System
Remote Device Functionalities
 

Description ZART8L• ZART8D• ZART12D•
Number of configurable buttons 8 8 12
OFF/STOP button Yes
ON/START/Horn button Yes
Motion & Stop function Yes
2 or 3 positions selector (1, 1+2, 2) Yes
E-STOP function Yes
Optional E-STOP RESET sequence Yes
Optional START Access sequence Yes
Optional automatic STOP function after a timeout Yes
Optional automatic Power OFF function after a timeout Yes
Information LEDs Yes No
Display function No Yes
Vibrate facility function in case of detected applicative alarms No Yes
Embedded accelerometer Yes
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Wireless Remote Control System
Description and Safety Function Capability

Section 1.3
Description and Safety Function Capability

What Is in This Section?
This section contains the following topics:

Topic Page
Certifications and Standards 38
Accessories 41
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Wireless Remote Control System
Certifications and Standards

Environment
The Wireless Remote Control System devices are compliant with:
 WEEE, directive 2002/96/EC
 REACH, regulation 1907/2006
 RoHS, directive 2011/65/EU

Overall Standards
 

Criteria Level
Principles of design for safety EN IEC 60204-1

EN ISO 13849-1
EN ISO 13849-2
EN IEC 62061
EN IEC 61508
EN ISO 13850

Specific standards for hoisting applications EN IEC 60204-32
EN 13557

Low voltage equipment EN IEC 61010-1
EN IEC 60947-5-1
EN IEC 60947-5-4
EN IEC 60947-5-5

Electromagnetic compatibility IEC 61000-6-2
Transmission frame format EN 60870-5-1
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Wireless Remote Control System
Local Standards and Certifications
Schneider Electric submitted this product for independent testing and qualification by third party 
listing agencies.

Criteria Description
CE marking Machinery directive 2006/42/EC

Low voltage directive 2006/95/EC
EMC directive 2004/108/EC
R&TTE directive 1999/05/EC 

Low voltage equipment EN 50178
European specific standards for 
hoisting applications

EN 13557
EN 12077-2

European specific standards for 
hoisting machines

EN 15011 (overhead traveling cranes)
EN 14439 (tower cranes)
EN 14492 (block hoists and winches)

Countries certifications (electrical 
devices)

UL508
CSA C22-2 n°14
EAC

Standards for radio frequencies ETSI EN 301 489 -1 
ETSI EN 301 489 -3
ETSI EN 301 489-17 
ETSI EN 300 440-2
ETSI EN 300 328 
FCC part 15
RSS GEN issue 3
RSS 210 issue 8
ARIB STD-T81
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Wireless Remote Control System
Radio Frequencies Certification
The eXLhoist devices obtained the radio frequency conformity delivered by the following 
certification organisms: 

For Multi Base Control (MBC) references, certification is on going.

Certification organism Certification organism 
country

Certification marks

CNC Argentina See on www.schneider-electric.com.
RCM Australia/New-Zealand See on the device
ANATEL Brazil See on www.schneider-electric.com.
IC Canada See on the device
SUBTEL Chile See on the device
SRRC China SRRC See on the device
- Hong Kong Ready for importation.
Government of India India See on www.schneider-electric.com.
Technical Conformity Mark Japan See on the device
SIRIM Malaysia See on the device
COFETEL Mexico See on the device
ASEP Panama See on www.schneider-electric.com.
ICASA Republic of South 

Africa
See on the device

EAC Russia See on the device
- Saudi Arabia Ready for importation.
IDA Singapore

KCC South Korea See on the device
NCC Taiwan See on the device
NTC SDoC Thailand See on www.schneider-electric.com.
R&TTE UE See on the device
FCC USA See on the device
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Wireless Remote Control System
Accessories

Base Station Accessories
 

Remote Device Accessories
 

Reference  Description
ZARC03 External antenna for Base Station:

The use of this accessory allows an increase of the radio range in severe environment 
conditions.

ZARC05 Connector plug female with cable 1.5 m (4.92 ft) for ZARB•H
ZARC12 Connector plug female with cable 3 m (9.84 ft) for ZARB•H
ZARC18 Connector plug female with cable 5 m (16.4 ft) for ZARB•H
ZARC06 Cable gland kit with wire grommets
ZARC09 Fixation kit with silent block:

Use this accessory in case of applications with severe vibration constraints.
ZARC091 Fixation kit with magnet supports
ZARCFBA01 Added Features Card (see page 261)

Reference  Description
ZARC01 Charger
ZARC02 Shoulder belt
ZARC04 Remote Holder for Remote Device
ZARC07 Kit of adhesive labels in black and white for Remote Device
ZARC08 Kit of adhesive labels in color for Remote Device and hoisting system
ZARC20 Push button and trigger bellows set kit
ZARC21 Rubber protection
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Specifications

Chapter 2
Specifications

What Is in This Chapter?
This chapter contains the following sections:

Section Topic Page
2.1 Base Station Specifications 44
2.2 Remote Device Specifications 56
2.3 Dimensions 59
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Base Station Specifications

Section 2.1
Base Station Specifications

What Is in This Section?
This section contains the following topics:

Topic Page
Base Station Specifications 45
RADIO Specification 53
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Base Station Specifications

Environment
The Base Station specifications are described in the table:

Specifications Details Value
ZARB•H• ZARB•W•

Product certifications - CE, UL/cULus/CSA, EAC
Environment - RoHS compliant
Life time - 10 years
Degree of protection - IP65
Degree of pollution - 3
Operating temperature For 24…48 V ac/dc power 

supply
-25…70 °C (-13…158 °F)

For 48…120 V ac/dc power 
supply

- -25…70 °C 
(-13…158 °F)

For 120…240 V ac/dc power 
supply

- -25…50 °C 
(-13…122 °F)

Storage temperature - -40…70 °C (-40…158 °F)
Corrosive atmosphere 
withstands

IEC-60721-3-3 Level 3C2 on H2S / SO2 / NO2 / Cl2

Fire withstands Power on parts 960 °C 30s / 30s according to IEC 60695-2-10 
and IEC-60695-2-11

Other parts 650 °C 30s / 30s according to IEC 60695-2-10 
and IEC-60695-2-11

Salt mist IEC 60068-2-52 Severity 2
Operating humidity range - 0...97 %
Storage humidity range - 0...97 %
Altitude Operation 

Storage
0...2000 m (0...6561.7 ft)
0...3000 m (0...9842.5 ft)

Vibration resistance 
According to IEC-60068-2-6

Without mounting 
accessories

5…100 Hz, Acceleration 39.2 m/s² (4 gn)

With silent block and 
aluminum frame ZARC09

2…100 Hz, Acceleration 39.2 m/s² (4 gn)

With magnet support and 
aluminum frame  ZARC091 

5…100 Hz, Acceleration 19.6 m/s² (2 gn)

With aluminum frame (from 
ZARC09 or  ZARC091) 

2…100 Hz, Acceleration 39.2 m/s² (4 gn)
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Shock resistance
According to IEC 60068-2-27

Without mounting 
accessories

147 m/s² (15 gn), for 11 ms

With silent block and 
aluminum frame ZARC09

147 m/s² (15 gn), for 11 ms

With magnet support and 
aluminum frame  ZARC091 

98.1 m/s² (10 gn), for 11 ms

Only with aluminum frame 
(from ZARC09 or  ZARC091) 

147 m/s² (15 gn), for 11 ms

Power supply 
Over voltage category

- OVC 2 OVC 3

Voltage dips IEC-61000-4-11 20 ms at 24 Vac (IEC-61000-4-11)
140 ms at 48 Vac
2 s at 240 Vac

Resistance to electrostatic 
discharges

IEC 61000-4-2 4 kV on contact
8 kV in air

Resistance to radiated fields IEC 61000-4-3 10 V/m
Immunity to fast transient IEC 61000-4-4 Power line: 4 kV (direct)

Outputs: 4 kV (direct)
Inputs: 2 kV (coupling)

Surge immunity IEC 61000-4-5 between the 
ground and power supply 
wires (Common mode)

2 kV

IEC 61000-4-5 between the 
power supply wires 
(Differential mode)

1 kV

Immunity to conducted 
magnetic fields 

Conforming to IEC-61000-4-6 10 V from 150 kHz to 80 MHz

Emission disturbances Conducted & radiated 
disturbances

Class B

Weight - 1.43 kg
(3.152 lb.)

1.45 kg
(3.197 lb.)

Specifications Details Value
ZARB•H• ZARB•W•
46 EIO0000001505 09/2018



Safety Specifications
The main safety specifications are described in the table:

Safety Relays
The safety relays specifications are described in the table:

Specifications Details Value
Safety relays function
Safety specifications

According to IEC 61508 Ed 2 Up to SIL3 capability
According to IEC 62061 Ed 1 Up to SIL3 CL capability
EN ISO 13849-1 Up to performance level “e”

Up to category 4
Motion relays function
Safety specifications

According to IEC 61508 Ed 2 SIL1 capability
According to IEC 62061 Ed 1 SIL1 CL capability
EN ISO 13849-1 Performance level “c”

Category 2
IN7...IN18 safeguarding inputs According to IEC 61508 Ed 2 SIL1 capability

According to IEC 62061 Ed 1 SIL1 CL capability
EN ISO 13849-1 Performance level “c”

Category 2

Specifications Details Value
ZARB•H• ZARB•W•

Number of contacts The Base Station internally 
implements 2 safety relays in 
serial. Each safety relay has 2 
contacts.

2

Logical type - NO
Insulation between Q0A and 
Q0B

- SELV insulation between (Q0A1, Q0A2) 
and (Q0B1, Q0B2) for voltage up to 

240 Vac
Q0A voltages - Up to 48 Vac 24...240 Vac
Q0B voltages -
Q0A, Q0B
Maximum Ie current 
24...240 Vac

- 4 A 6 A

Relay type according to EN/IEC 
60947-5-1 

AC15 C300 B300
DC13 - R300

B10 with maximum load - 200 000 cycles
Minimum output current - 10 mA / 24 Vdc
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Safety relays internal wiring:

1 Safety relay 1
2 Safety relay 2

Motion/Auxiliary Relays
The motion/auxiliary relay specifications are described in the table:

Specifications Details Value
ZARB12H• ZARB12W• ZARB18H• ZARB18W•

Number of motion/auxiliary relays - 12 18
Normally open (N0) relays - 12 (Q1…Q12) 16 (Q1…Q16)
Normally open + normally closed 
(N0+NC) relays

- 0 2 (Q17, Q18)

Nominal output voltage - 24…48 V 
ac/dc ±20 %

24…240 V 
ac/dc ±20 %

24…48 V 
ac/dc ±20 %

24…240 V 
ac/dc ±20 %

Relay type according to  
EN/IEC 60947-5-1 

AC15 B300
DC13 R300

B10 with maximum load Relays NO contact
Up to 48 V

700 000 cycles

Relays NO contact
Over than 48 V

- 500 000 
cycles

- 500 000 
cycles

Relays NC contact - 500 000 cycles
Minimum output current 6.8 mA with 24 Vdc 

voltage
6.8 mA

Maximum operating rate - 0.5 Hz
Weight - 1.34 kg

(2.954 lb.)
1.36 kg

(2.998 lb.)
1.43 kg

(3.152 lb.)
1.45 kg

(3.197 lb.)
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AC15: rated voltage/rated current

It is recommended to use the following contactors:

DC13: rated voltage/rated current

It is recommended to use the following contactors:

Rated operational voltage 
Ue (Vac)

Rated operational current 
Ie (A) 

Make VA rating 
(VA)

Break VA rating 
(VA)

24 0.31

70 7.5
48 0.16

120 0.06
240 0.03

AC voltage contactor 
coil (V)

TeSys D contactor reference

24 LC1D09B7, LC1D12B7, LC1D18B7, LC1D25B7, LC1D32B7, LC1D38B7
48 LC1D09E7, LC1D12E7, LC1D18E7, LC1D25E7, LC1D32E7, LC1D38E7

120 LC1D09FE7, LC1D12FE7, LC1D18FE7, LC1D25FE7, LC1D32FE7, LC1D38FE7
240 LC1D09U7, LC1D12U7, LC1D18U7, LC1D25U7, LC1D32U7, LC1D38U7

Rated operational voltage 
Ue (Vdc)

Rated operational current 
Ie (A) 

Make VA rating 
(W)

Break VA rating (W)

24 0.10

2.4 2.4
48 0.05

120 0.02
240 0.01

DC voltage 
contactor coil (V)

TeSys D contactor reference

24 LC1D09BL, LC1D12BL, LC1D18BL, LC1D25BL, LC1D32BL, LC1D38BL 
LC1DT09BL, LC1DT12BL, LC1DT18BL, LC1DT25BL, LC1DT32BL, LC1DT38BL

48 LC1D09EL, LC1D12EL, LC1D18EL, LC1D25EL, LC1D32EL, LC1D38EL 
LC1DT09EL, LC1DT12EL, LC1DT18EL, LC1DT25EL, LC1DT32EL, LC1DT38EL

110 LC1D09FL, LC1D12FL, LC1D18FL, LC1D25FL, LC1D32FL, LC1D38FL 
LC1DT09FL, LC1DT12FL, LC1DT18FL, LC1DT25FL, LC1DT32FL, LC1DT38FL

220 LC1D09ML, LC1D12ML, LC1D18ML, LC1D25ML, LC1D32ML, LC1D38ML 
LC1DT09ML, LC1DT12ML, LC1DT18ML, LC1DT25ML, LC1DT32ML, LC1DT38ML

250 LC1D09UL, LC1D12UL, LC1D18UL, LC1D25UL, LC1D32UL, LC1D38UL 
LC1DT09UL, LC1DT12UL, LC1DT18UL, LC1DT25UL, LC1DT32UL, LC1DT38UL
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DC resistive (PLC (Programmable Logic Controller) DC 24 V inputs): rated voltage/rated current

Power Supply

Protective Earth Ground
The protective earth ground must be connected to the machine to avoid maloperation due to earth 
faults (IEC 60204-1, Protection against maloperation due to earth faults).

Rated operational voltage Ue (Vdc) Rated operational current Ie
24 5 mA minimum

300 mA maximum

NOTICE
INOPERABLE EQUIPMENT
The ZARB•H• Base Station must be powered with a voltage:
 From 24 Vac -15 % to 48 Vac +10 % with frequency of 50 Hz -6 %/+4 % and frequency of 

60 Hz -6 %/+4 %.
 From 24 Vdc -15 % to 48 Vdc +20 %.
The ZARB•W• Base Station must be powered with a voltage:
 From 24 Vac -15 % to 240 Vac +10 % with frequency of 50 Hz -6 %/+4 % and frequency of 

60 Hz -6 %/+4 %.
 From 24 Vdc -15 % to 240 Vdc +20 %.
Failure to follow these instructions can result in equipment damage.

WARNING
UNINTENDED EQUIPMENT OPERATION
Connect the Base Station protective earth ground connection to the machine ground.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

DANGER
HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH
Connect the Base Station protective earth ground connection to the machine ground.
Failure to follow these instructions will result in death or serious injury.
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The PE must be connected to the machine ground (IEC 60204-1, protection against electric 
shock). If not then the Base Station inputs voltage (IN_COM, S2_S3, IN0…IN18) could increase to 
a dangerous voltage because of the possible static electricity induced by the machine motions. 

ZARB18W Power Dissipation
This graphic shows the ZARB18W• dissipated power on an indicative basis: 

IN0
The IN0 input specifications are:
 Static input type
 Current source logic
 Compatible only with 2 wiring:
 Connection of IN0 to one side to the auxiliary contact of the main contactor and connection 

of S2_S3 output port to the other side of the auxiliary contact of the main contactor.
 Direct connection to the S2_S3 output.

 20 mA typical pulsed input current
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IN1…IN18
The IN1 to IN18 input specifications are:
 Static input type
 Current source logic
 Compatible only with 2 wiring:
 Connection of INi (i=1…18) in one side of a dry contact and connection of IN_COM output to 

the other side of the dry contact.
 No INi (i=1…18) connection.

 20 mA typical pulsed input current

Response Time

Input/Output Maximum response time (ms)
E-STOP 500
STOP 500
Motion/Auxiliary 500
Selector 500
Input 500
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RADIO Specification

RADIO Specification
 

FCC USA and IC Canada Compliance Statement
This device complies with part 15 of the FCC Rules and Industry Canada licence-exempt RSS 
standard(s). Operation is subject to the following two conditions: 
1) This device may not cause harmful interference, and 
2) this device must accept any interference received, including interference that may cause 

undesired operation.
Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio 
exempts de licence. L'exploitation est autorisée aux deux conditions suivantes : 
1) l'appareil ne doit pas produire de brouillage, et 
2) l'utilisateur de l'appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage 

est susceptible d'en compromettre le fonctionnement.

Specification Details Value
Frequency of radio 
communication

International frequency range 2.4 GHz

Number of working 
systems in the same area

- Up to 50 systems in a 100 x 100 meter 
area

Radio range In free field > 300 m (984 ft)
In industrial environment Up to 50 m (164 ft) typical

Antenna (Possible ZARC03 external antenna 
use)

Internal

Working channel 
selection

No impact for the customer (during 
installation, use and maintenance)

Automatic

ID - MAC address reserved by Schneider 
Electric
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Changes or modifications not expressly approved by the party responsible for compliance could 
void the user's authority to operate the equipment. This equipment has been tested and found to 
comply with the limits for a Class B digital device, pursuant to part 15 of the FCC Rules. These 
limits are designed to provide reasonable protection against harmful interference in a residential 
installation. This equipment generates, uses and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interference will not occur in a particular 
installation. If this equipment does cause harmful interference to radio or television reception, 
which can be determined by turning the equipment off and on, the user is encouraged to try to 
correct the interference by one or more of the following measures:
 Reorient or relocate the receiving antenna.
 Increase the separation between the equipment and receiver.
 Connect the equipment into an outlet on a circuit different from that to which the receiver is 

connected.
 Consult the dealer or an experienced radio/TV technician for help.
The base complies with FCC's radiation exposure limits set forth for an uncontrolled environment 
under the following conditions: 
1) This equipment should be installed and operated such that a minimum separation distance of 

20 cm is maintained between the radiator (antenna) and user's/nearby person's body at all 
times. 

2) This transmitter must not be co-located or operating in conjunction with any other antenna or 
transmitter.

The remote device with it's antenna complies with FCC's radiation exposure limits set forth for an 
uncontrolled environment. To maintain compliance, follow the instructions below: 
1) This transmitter must not be co-located or operating in conjunction with any other antenna or 

transmitter. 
2) Avoid direct contact to the antenna, or keep contact to a minimum while using this equipment.

Under Industry Canada regulations, these radio transmitters may only operate using an antenna 
of a type and maximum (or lesser) gain approved for the transmitter by Industry Canada. To reduce 
potential radio interference to other users, the antenna type and its gain should be so chosen that 
the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for successful 
communication. These radio transmitters (IC:7002CZARB and IC:7002CZART) have been 
approved by Industry Canada to operate with the antenna type ZARC03 with the maximum 
permissible gain and required antenna impedance. Any other antenna types having a gain greater 
than the maximum gain indicated for that type, are strictly prohibited for use with this device.
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Conformément à la réglementation d'Industrie Canada, les présents émetteurs radio peuvent 
fonctionner avec une antenne d'un type et d'un gain maximal (ou inférieur) approuvé pour 
l'émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage radioélectrique à 
l'intention des autres utilisateurs, il faut choisir le type d'antenne et son gain de sorte que la 
puissance isotrope rayonnée équivalente (p.i.r.e.) ne dépasse pas l'intensité nécessaire à 
l'établissement d'une communication satisfaisante. Les présents émetteurs radio (identifier 
IC:7002CZARBo and IC:7002CZARTo) ont été approuvés par Industrie Canada pour fonctionner 
avec le type d'antenne ZARC03 ayant un gain admissible maximal et l'impédance requise. 
D'autres types d'antenne dont le gain est supérieur au gain maximal indiqué, sont strictement 
interdits pour l'exploitation de l'émetteur.

Any changes or modifications not expressly approved by Schneider Electric could void the user's 
authority to operate the equipment.

Product 
reference

Maximum gain of internal 
antenna (dB)

Maximum gain of external 
antenna (dB)

(including cable)

Allowed impedance (Ω)

ZART8L• 4.5 – –
ZATL8D• 5.5

ZART12D•
ZARB12H• 4.5 1 50
ZARB12W•
ZARB18H•
ZARB18W•
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Remote Device Specifications

Section 2.2
Remote Device Specifications

What Is in This Section?
This section contains the following topics:

Topic Page
Remote Device Specifications 57
Remote Device Charger Specification 58
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Remote Device Specifications

Environment
 

Specification Details Value
Product certifications - CE, UL/CSA, EAC
Battery life time Conforming to IEC 62133 > 2 years
Battery type - LiFePO4

Battery voltage - 3.3 Vdc
Mechanical life Motion buttons 5 000 000 cycles
Mechanical life Auxiliary buttons 1 000 000 cycles
Temperature Storage -20…45 °C (-4…113 °F)

Operating -20…60 °C (-4…140 °F)
Relative humidity Operating/Storage 0 %...95 %, without condensation
Corrosive atmospheres 
resistance

IEC 60721-3-3 Level of 3C2 on H2S / SO2 / NO2 / Cl2

Degree of protection - IP65 and NEMA type 4
Altitude Operation

Storage
0...2000 m (0...6561.7 ft)
0...3000 m (0...9842.5 ft)

Vibration resistance Conforming to IEC 60068-2-6 10…55 Hz, amplitude 0.75 mm, 
acceleration 15 gn

Shock resistance Conforming to IEC 60068-2-27 100 gn
Mechanical protection - Bumper
Resistance to electrostatic 
discharges

Conforming to IEC 61000-4-2 4 kV on contact
8 kV in air

Resistance to radiated fields Conforming to IEC 61000-4-3 10 V/m
Immunity to fast transient Conforming to IEC 61000-4-4 1 kV, on power supply
Immunity to power 
frequency magnetic field 

- 30 A/m minimum

Mechanical materials - Bumper in OnFlex™
Weight - 594 g (21 oz)
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Remote Device Charger Specification

Environment
 

Specification Value
Location to be used Residential, commercial, and light-industrial environment (IEC 61000-6-3)
Product certifications CE, UL/CSA, EAC
Degree of protection IP2x
Degree of pollution 2
Operating temperature 10…40 °C (50…104 °F)
Storage temperature -20…60 °C (-4…140 °F)
Primary supply voltage 90…264 Vac
Primary supply voltage 
frequency

47…63 Hz

Secondary output voltage 12 Vdc, SELV voltage
Secondary output power 30 W minimum
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Dimensions

Section 2.3
Dimensions

What Is in This Section?
This section contains the following topics:

Topic Page
Base Station Dimensions 60
Remote Device Dimensions 61
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Base Station Dimensions

Dimensions
The following figure shows the Base Station dimensions:
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Remote Device Dimensions

Dimensions
The following figure shows the Remote Device dimensions:
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Functional Safety

Chapter 3
Functional Safety

What Is in This Chapter?
This chapter contains the following sections:

Section Topic Page
3.1 Generalities 64
3.2 Description and Safety Function Capability 72
3.3 Functional Safety Function Commissioning 83
3.4 Functional Safety Requirements for Maintenance 86
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Functional Safety
Generalities

Section 3.1
Generalities

What Is in This Section?
This section contains the following topics:

Topic Page
Introduction 65
Standards and Terminology 66
Basics 67
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Functional Safety
Introduction

Overview
The safety functions incorporated in eXLhoist allow you to develop applications oriented towards 
protection of people and machinery.
Some safety functions are configured with eXLhoist Configuration Software.
Integrated safety functions provide the following benefits:
 Additional standards-compliant safety functions
 No need for external safety devices
 Reduced wiring effort and space requirements
 Reduced costs
The eXLhoist is compliant with the requirements of the standards in terms of implementation of 
safety functions.
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Functional Safety
Standards and Terminology

Overview
The technical terms, terminology, and the corresponding descriptions in this manual normally use 
the terms or definitions in the relevant standards.
In the field of Wireless Remote Control System, this includes, but is not limited to, terms such as 
safety function, safe state, fault, fault reset, failure, error, error message, warning, warning 
message, and so on. 
These standards include:
 IEC 61508 Ed.2 series: Functional safety of electrical/electronic/programmable electronic 

safety-related systems
 EN 62061 Ed.1.0: Safety of machinery - Functional safety of safety-related electrical, electronic, 

and programmable electronic control systems
 EN ISO 13849-1 & 2: Safety of machinery - Safety related parts of control systems

EC Declaration of Conformity
The EC declaration of conformity for the machine directive 2006/42/EC can be obtained on 
www.schneider-electric.com.

Functional Safety Conformity
The integrated safety functions are compliant with:
 EN 15011: 2014
 EN 14492-2: 2009
 EN 14439: 2009
 EN 13557: 2008
 IEC 60204-1: 2009
 IEC 60204-32: 2008
The listed standards set out safety-related considerations of Wireless Remote Control System 
safety related in terms of the framework of the ISO13849-1 and ISO13849-2 standards.
The defined safety functions are:
 SIL1, SIL2, and SIL3 capability in compliance with the IEC 61508 Ed.2 series.
 Performance Level c, d, and e in compliance with ISO 13849-1.
 Compliant with category 2, 3, and 4 of European standard ISO 13849-1.
Also refer to Safety Function Capability (see page 72).
The safety demand operating mode is considered to be high demand or continuous mode of 
operation according to the IEC 61508-1 standard.
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Functional Safety
Basics

Functional Safety
Automation and safety engineering are 2 areas that were separate in the past but have recently 
become more and more integrated.
The engineering and installation of complex automation solutions are greatly simplified by 
integrated safety functions.
Usually, the safety engineering requirements depend on the application.
The level of requirement results from the risk and the hazard potential arising from the specific 
application.

IEC 61508 Standard
The standard IEC 61508 functional safety of electrical/electronic/programmable electronic safety-
related systems covers the safety-related function.
Instead of a single component, an entire function chain (for example, from a sensor through the 
logical processing units to the actuator) is considered as a unit.
This function chain must meet the requirements of the specific safety integrity level as a whole.
Systems and components that can be used in various applications for safety tasks with comparable 
risk levels can be developed on this basis.
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Functional Safety
EN ISO 13849 Standard or EN 62061 Standard
Designers can follow either EN ISO 13849-1 or EN 62061 to demonstrate conformity with the 
Directive 2006/42/EC on machinery. These 2 standards consider not only whether a fault will 
occur, but also how likely it is to occur.
This means that there is a quantifiable, probabilistic element in compliance: machine builders must 
be able to determine whether their safety circuit meets the required Safety Integrity Level (SIL) or 
Performance Level (PL). Panel builders and designers should be aware that manufacturers of the 
components used in safety circuits (such as safety detection components, safety logic solvers, and 
output devices like contactors) must provide detailed data on their products.
Safety standards:

SIL - Safety Integrity Level
The standard IEC 61508 defines 4 Safety Integrity Levels (SIL) for safety functions.
SIL1 is the lowest level and SIL4 is the highest level.
A hazard and risk analysis serves as a basis for determining the required SIL.
This is used to decide whether the relevant function chain is to be considered as a safety function 
and which hazard potential it must cover.
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Functional Safety
PF - Probability of Failure
The standard IEC 61508 defines SIL using requirements grouped into 2 broad categories: 
hardware safety integrity and systematic safety integrity. A device or system must meet the 
requirements for both categories to achieve a given SIL.
The SIL requirements for hardware safety integrity are based on a probabilistic analysis of the 
device. To achieve a given SIL, the device must meet targets for the maximum probability of 
dangerous failure and a minimum Safe Failure Fraction. The concept of “dangerous failure” must 
be rigorously defined for the system in question, normally in the form of requirement constraints 
whose integrity is verified throughout system development. The actual targets required vary 
depending on the likelihood of a demand, the complexity of the devices, and types of redundancy 
used.
The Probability of Failure on Demand (PFD) of low demand operation for different SILs are defined 
in IEC 61508 are as follows:

In continuous operation, these change to the following:

A function is considered as "on demand" if the demand rate is lower than one activation per year. 
Otherwise, the function is considered as "High demand or continuous operation".
The hazards of a control system must be identified then analyzed in a risk analysis. These risks 
are gradually mitigated until their overall contribution to the hazard is deemed to be acceptable. 
The tolerable level of these risks is specified as a safety requirement in the form of a target 
probability of a dangerous failure over a given period, stated as a discrete SIL level.

SIL Average Probability of a Dangerous Failure on Demand of the safety function
PFD

SIL4 < 10-4

SIL3 ≥ 10-4 to < 10-3

SIL2 ≥ 10-3 to < 10-2

SIL1 ≥ 10-2 to < 10-1

SIL Average Frequency of a Dangerous Failure on Demand of the safety function (h-1)
PFH

SIL4 ≥ 10-9 to < 10-8

SIL3 ≥ 10-8 to < 10-7

SIL2 ≥ 10-7 to < 10-6

SIL1 ≥ 10-6 to < 10-5
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Functional Safety
PL - Performance Level
The standard EN ISO 13849-1 defines 5 Performance Levels (PL) for safety functions.
"a" is the lowest level and "e" is the highest level.
5 levels (a, b, c, d, and e) correspond to different values of average probability of dangerous failure 
per hour.

HFT - Hardware Fault Tolerance and SFF - Safe Failure Fraction
Depending on the SIL for the safety system, the IEC 61508 standard requires a specific HFT in 
connection with a specific proportion of safe failures SFF.
The HFT is the ability of a system to execute the required safety function in spite of the presence 
of one or more hardware faults.
The SFF of a system is defined as the ratio of the rate of safe failures to the total failure rate of the 
system.
According to IEC 61508, the maximum achievable SIL of a system is partly determined by the HFT 
and the SFF of the system.
IEC 61508 distinguishes 2 types of subsystem (type A subsystem, type B subsystem).
These types are specified on the basis of criteria which the standard defines for the safety-relevant 
components.

PL Probability of a Dangerous Hardware Failure Per Hour
e ≥ 10-8 to < 10-7

d ≥ 10-7 to < 10-6

c ≥ 10-6 to < 3x10-6

b ≥ 3x10-6 to < 10-5

a ≥ 10-5 to < 10-4

SFF HTF
Type A subsystem Type B subsystem
0 1 2 0 1 2

< 60 % SIL1 SIL2 SIL3 - SIL1 SIL2
60 %…< 90 % SIL2 SIL3 SIL4 SIL1 SIL2 SIL3
90 %…< 99 % SIL3 SIL4 SIL4 SIL2 SIL3 SIL4
≥ 99 % SIL3 SIL4 SIL4 SIL3 SIL4 SIL4
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Functional Safety
Systematic Safety Integrity & Detect Fault Avoidance Measures
Systematic errors in the specifications, in the hardware and the software, usage faults and 
maintenance faults in the safety system must be avoided to the maximum degree possible. To 
reach these requirements, IEC 61508 specifies a number of measures for fault avoidance that 
must be implemented depending on the required SIL. These measures for fault avoidance must 
cover the entire life cycle of the safety system, that is, from design to decommissioning of the 
system.
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Functional Safety
Description and Safety Function Capability

Section 3.2
Description and Safety Function Capability

What Is in This Section?
This section contains the following topics:

Topic Page
Wireless Remote Control System Safety Functions Are Part of an Overall System 73
Getting and Operating the Safety Function 74
E-STOP 75
STOP Function 76
Standard Motion & Auxiliary Functions 77
Safeguarding 78
Priority of Safety Functions 79
Safe State of the Wireless Remote Control System 80
Legal RFU (Recommendation for Use) 81
Summary of the Reliability Study 82
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Functional Safety
Wireless Remote Control System Safety Functions Are Part of an Overall System

Overview
The qualitative and quantitative safety objectives determined by the final application require some 
adjustments to ensure safe use of the safety functions. The integrator of the Wireless Remote 
Control System is responsible for these additional changes (for example, managing the 
mechanical brake on the motor).
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Functional Safety
Getting and Operating the Safety Function

Overview
The SISTEMA software allows machine developers and testers of safety-related machine controls 
to evaluate the safety standard or level of their machine in the context of EN ISO 13849-1. The tool 
allows you to model the structure of safety-related control components based on the designated 
architectures, allowing automated calculation of the reliability standards with various levels of 
detail, including that of the Performance Level (PL).
The eXLhoist SISTEMA libraries are available from www.schneider-electric.com.
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Functional Safety
E-STOP

Overview
For general descriptions, refer to E-STOP function (see page 133).
The E-STOP is not configurable.
The undesired event of the E-STOP function is the non-execution of the E-STOP activation.
The safe state of the E-STOP function is to open safety relays.

For a SIL3 PLe E-STOP, auxiliary contact of contactors must be mechanically linked. Contactors 
shall be compliant with EN 60947-4-1:2010 Annex F (preferred) - Requirements for auxiliary 
contact linked to power contact (mirror contact).
In order to be compliant with the Common Cause of Failure (CCF), wiring of redundant contactors 
or drives must be by different path. 
The standard E-STOP function of eXLhoist is limited to a stop category 0 according to IEC 60204-
32. If some applications require an E-STOP function with a stop category 1, then a safety relay type 
Preventa XPSATE or XPSAV or similar must be used.
In order to justify of the safety category 4 according to EN ISO 13849-1, an automatic diagnostic 
is realized on IN0 terminal thanks to the S2_S3 terminal (Pulsed 12 V). An external supply of IN0 
input cannot be used.
E-STOP function is a passive stop (function activated when an invalid frame is detected).

Function Installation IEC 60204-32 IEC 61508 EN 62061 EN ISO 13849
STOP category SIL SIL CL Safety 

category
PL

E-STOP With auxiliary 
contact feedback 
loop between 
S2_S3 and IN0

Category 0 SIL3 SIL3 CL Safety 
category 4

PL e

Without auxiliary 
contact feedback 
loop between 
S2_S3 and IN0

SIL2 SIL2 CL Safety 
category 3

PL d
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Functional Safety
STOP Function

Overview
For general descriptions, refer to STOP function (see page 135).
The undesired event of the STOP function is the non-execution of the STOP activation.
The safe state of the STOP function is to open safety relays.

STOP function is a passive stop (function activated when an invalid frame is detected).

Function Installation IEC 60204-32 IEC 61508 EN 62061 EN ISO 13849
STOP category SIL SIL CL Safety 

category
PL

STOP Without UOC Category 0 SIL2 SIL2 CL Safety 
category 3

PL d
With UOC Category 1
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Functional Safety
Standard Motion & Auxiliary Functions

Overview
For general descriptions, refer to Standard Motion (see page 147) and Auxiliary functions 
(see page 149).
A relay assignment can be done for the Remote Device motion buttons with the eXLhoist 
Configuration Software. An UOC relay (see page 114) can be associated to a motion axis (and its 
motion relays) thanks to the eXLhoist Configuration Software.
Auxiliary functions can be assigned to auxiliary buttons and relays thanks to the eXLhoist 
Configuration Software.
The undesired event of standard motion & auxiliary functions is the unintended standard motion or 
auxiliary function activation.
The safe state of the standard motion & auxiliary function is to open safety relays.

In order to justify of the safety category 2, an automatic diagnostic is realized on buttons of the 
Remote Device during a START of the machine. So during this phase, the operator must not push 
any motion or auxiliary buttons.
Standard motion & auxiliary functions are passive stop functions (functions activated when an input 
signal is detected).

Function Installation IEC 60204-32 IEC 61508 EN 62061 EN ISO 13849
STOP category SIL SIL CL Safety category PL

Standard 
motion & 
auxiliary 
functions

No UOC Category 2 SIL1 SIL1 CL Category 2 for 
electronic parts
Category 1 for 
electromechanical 
parts

PL c
With UOC
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Functional Safety
Safeguarding

Overview
For general description, refer to Safeguarding function (see page 116).
Safeguarding can be assigned to a motion direction thanks to the eXLhoist Configuration Software.
The undesired event of Safeguarding function is the no disabling of motion buttons.
Safeguarding limit switches contacts must be NC contacts.
The safe state of the Safeguarding function is to open safety relays.

In order to justify of the safety category 2, an automatic diagnostic is realized on the Safeguarding 
inputs thanks to the IN_COM output port. An external power supply of Safeguarding inputs cannot 
be used.
Safeguarding is a passive STOP function (function activated when an input signal is detected).

Function Installation IEC 60204-32 IEC 61508 EN 62061 EN ISO 13849
STOP category SIL SIL CL Safety category PL

Safeguarding NC Category 2 on 
the motion 
direction

SIL1 SIL1 CL Category 2 for 
electronic parts
Category 1 for 
electromechanical 
parts

PL c
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Functional Safety
Priority of Safety Functions

Overview

Priority of safety functions Safety functions
1 E-STOP
2 STOP
3 Safeguarding
4 Standard motion & auxiliary functions
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Functional Safety
Safe State of the Wireless Remote Control System

Overview
Safe states of the Base Station are:
 SAFE-STOP failure: if a failure is detected by the Base Station, the Base Station opens safety 

relays with a stop category 0, stops the radio communication with the Remote Device, and 
restart.

 SAFE-STOP radio: if the Base Station looses the communication with the Remote Device, the 
Base Station opens the safety relays in stop category 0 or stop category 1 according to the 
commissioning.

The Safe state position of the Remote Device is no communication with the Base Station: if a failure 
is detected in the Remote Device, the Remote Device stops the radio communication. So the Base 
Station goes to SAFE-STOP radio mode and opens the safety relays in stop category 0 or stop 
category 1 according to the commissioning.
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Functional Safety
Legal RFU (Recommendation for Use)

Overview
According to the machinery directive 2006/42/EC and the amendment - RECOMMENDATION 
FOR USE n°CNB/M/11.050 rev02, functional test (automatic or manual) shall be performed within 
the following test intervals:
 At least every month for PL e with category 3 or category 4 (according to EN ISO 13849-1) or 

SIL3 with HFT = 1 (according to EN 62061);
 At least every 12 months for PL d with category 3 (according to EN ISO 13849-1) or SIL2 with 

HFT = 1 (according to EN 62061).
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Functional Safety
Summary of the Reliability Study

Synthesis of Reliability Study in Configuration 1 Remote Device & 1 Base Station

(1) EN 62061 standard concerns integration. This standard distinguishes the overall safety 
function (classified SIL1, SIL2, or SIL3 according to diagrams in Appendix A) from components 
which constitute the safety function (classified SIL1 CL, SIL2 CL or SIL3 for eXLhoist).
NOTE: The table above is not sufficient to evaluate the PL of the hoisting system. The PL 
evaluation has to be done at the system level. The fitter of the integrator of the eXLhoist has to do 
the PL evaluation by including sensors and actuators data numbers from the table above. 
SISTEMA software can evaluate the PL of the system. 
NOTE: The radio communication of the Wireless Remote Control System is compliant with 
IEC 61784-3 Ed2 2010.

Standard Safety features E-STOP STOP Standard motion & 
auxiliary functions

Limit 
switch

With 
auxiliary 
contact

Without 
UOC

UOC Without 
UOC

UOC NC 
contact

IEC 61508 Ed 2 SFF per channel 97.8 % 85 % 84.8 % 90.1 % 95 %

PFH (10-9 h-1) 7.32 7.54 7.57 52.3 51.8 17.9

Type B
HFT 1 0
Diagnostic Coverage 
per channel

99.3 % 90.5 % 90.3 % 73.8 % 90 %

SIL capability 3 2 1
EN 62061 (1) SIL CL capability 3 2 1
EN ISO 13849-1 2008 PL e d c

Safety category 4 3 2
MTTFd in years 15584 15130 15070 2183 2202 6380

Proof test interval (manual functional test) Once per 
month

Once per year

Maximum response time 500 ms
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Functional Safety
Functional Safety Function Commissioning

Section 3.3
Functional Safety Function Commissioning

What Is in This Section?
This section contains the following topics:

Topic Page
Safety Parameters and Steps to Configure the Safety Functions 84
Wireless Remote Control System Safety Signature 85
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Functional Safety
Safety Parameters and Steps to Configure the Safety Functions

Commissioning of Safety Functions 
The commissioning type of safety function is:

Some passwords/codes can be configured on the eXLhoist Configuration Software:
 E-STOP RESET sequence on the Remote Device
 Start access sequence on the Remote Device
 Transfer password:
 For the read of the Configuration File in a Remote Device
 For the transfer of the Configuration File between a Remote Device and a Base Station.

Functions UOC delay time Relay assignment Remarks
E-STOP - - No commissioning
STOP Yes - Safety relays cannot be 

commissioned
Motion & auxiliary functions Yes Yes -
Safeguarding - Yes Delay and NO/NC contact 

assignment

Passwords/codes Default value
E-STOP RESET sequence -
Start access sequence -
Configuration File transfer password -
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Functional Safety
Wireless Remote Control System Safety Signature

Overview
The verification test for systems with safety integrated functions focuses on validating the 
functionality of safety integrated monitoring and stop functions configured in the Wireless Remote 
Control System.
The purpose of the test is to verify proper configuration of the defined safety functions and test 
mechanisms and to examine the response of dedicated monitoring functions to explicit input of 
values outside the tolerance limits.
The test must cover all Wireless Remote Control System-specific safety configured monitoring 
functions and global safety integrated functionality in eXLhoist.

Condition Prior to Verification Test
 The machine is wired up correctly.
 All safety devices such as limit switches, overload sensors, and emergency stop switches are 

connected and ready for operation.
 All commissioning parameters must be correctly set on the Wireless Remote Control System.
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Functional Safety
Functional Safety Requirements for Maintenance

Section 3.4
Functional Safety Requirements for Maintenance

What Is in This Section?
This section contains the following topics:

Topic Page
Maintenance 87
Base Station or Remote Device Replacement 88
Changing Machine Equipment 89
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Functional Safety
Maintenance

E-STOP
By way of preventive maintenance and according to the Recommendation For Use (see page 81), 
the E-STOP and the STOP function must be activated at least once a month. The Remote Device 
and the Base Station must be switched OFF and then ON (power cycle) before carrying out this 
preventive maintenance.

Others Safety Functions
By way of preventive maintenance and according to the Recommendation For Use (see page 81), 
the STOP, motion, auxiliary, limit switch functions must be activated at least once a year. The 
Remote Device and the Base Station must be switched OFF and then ON (power cycle) before 
carrying out this preventive maintenance.
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Functional Safety
Base Station or Remote Device Replacement

Overview
You can replace the Base Station part and the Remote Device part.
If you replace the Base Station or the Remote Device configured, you will not lose your safety 
configuration thanks to the maintenance / device replacement procedure but you need to repeat 
the verification test to avoid incorrect wiring or incorrect behavior of the safety function.
NOTE: For more product information, see the Maintenance / Device Replacement (see page 245).
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Functional Safety
Changing Machine Equipment

Overview
If you need to change any parts of the hoisting system (contactor, drive, …) you must repeat the 
verification test (see page 85).
NOTE: For more product information, see the installation part (see page 91).
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Harmony eXLhoist
Installation and Wiring
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Installation and Wiring

Chapter 4
Installation and Wiring

What Is in This Chapter?
This chapter contains the following sections:

Section Topic Page
4.1 Base Station Installation 92
4.2 Base Station Wiring 95
4.3 Functionalities Description 108
4.4 Remote Device Installation 122
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Installation and Wiring
Base Station Installation

Section 4.1
Base Station Installation

Base Station Installation Precaution

Installation Precaution
Example of a recommended Base Station location: 

Base Station location:
The Base Station must be installed vertically, on a flat and rigid surface, with the cable at the 
bottom.
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Installation and Wiring
Consider the wiring limitation and the radio communication limitation to choose the Base Station 
location.
Do not create obstacle between the Base Station and the Remote Device to optimize the radio 
communication level.
The Base Station must not be installed inside closed metal containers.
To prevent communication perturbation:
 Do not place cables or metallic parts in front of the Base Station cover.
 Do not place obstacles between the Base Station and the Remote Device.
According to IEC 61010-1, it is recommended to install the power switch of the Base Station close 
to the Base Station.
To be compliant with IEC 61508, EN 62061 and EN ISO 13849, cable ends must be used for the 
output wiring of the ZARB•W•.

DANGER
HEAVY LOAD MOVING HAZARD
The working range must be free of people when the hoisting system is operating. 
Failure to follow these instructions will result in death or serious injury.

WARNING
UNINTENDED EQUIPMENT OPERATION
Install and operate this equipment according to the environmental conditions described in the 
operating limits.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

WARNING
UNINTENDED EQUIPMENT OPERATION
 Use appropriate safety interlocks where personnel and/or equipment hazards exist.
 Use the sensor and actuator power supplies only for supplying power to the sensors or 

actuators connected to the device.
 Power line must be wired and protected with fuse or thermal magnetic switch (ex: Schneider-

Electric GV2) in compliance with local and national regulatory requirements for the rated 
current and voltage of the particular equipment.

 Do not disassemble, repair, or modify this equipment.
 Do not drill hole in the Base Station.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
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Installation and Wiring
Installation
 

Use the ZARC09 silent blocs in case of applications with severe vibration constraints.

Step Action
1 Unscrew the 4 screws at the front of the Base Station.
2 Remove the cover.
3 Introduce the 4 screws in the dedicated holes (legend G):

4 Screw the 4 mounting M04 screws. Engage at least 6 mm (0.23 in) of the thread in mounting 
plate.

5 Install the Base Station cover.
6 Screw the 4 screws to fasten the Base Station cover.
7 To help the Base Station identification, write its ID address on a dedicated adhesive label and 

stick it on an appropriate place. These labels are provided with the device or on the accessories 
ZARC07 and ZARC08.
You can also stick the yellow label “Radio controlled device” on an appropriate place. This label 
is present on the accessory ZARC08.
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Installation and Wiring
Base Station Wiring

Section 4.2
Base Station Wiring

What Is in This Section?
This section contains the following topics:

Topic Page
Base Station Wiring 96
Wiring Best Practices 101
Factory Setting Description 104
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Installation and Wiring
Base Station Wiring

ZARB•W•
Wiring procedure: 

ZARB•W• terminals:

 
 

Step Action
1 Unscrew the 4 screws at the front of the Base Station.
2 Remove the cover.
3 When necessary, remove the cap of the Base Station dedicated hole and install a cable gland 

from the kit ZARC06 (see page 41) (Tightening torque = 4±0.2 N.m (35.4±0.2 lb.-in)).
4 Introduce the cable through the dedicated cable gland.
5 Connect the wires in the dedicated terminals. Use, if necessary, cable ends.
6 Tight the cable gland.
7 Install the Base Station cover.
8 Screw the 4 screws to fasten the Base Station cover.
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Installation and Wiring
Insulation: 
The group of relays (Q1…Q3), (Q4…Q6), (Q7…Q9), (Q10…Q12) and (Q13…Q18), as well as the 
group of inputs (IN0…IN18) and the group of power supply (AC_Phase/+, AC_Neutral/-) respect a 
SELV insulation between each other.
For more details on the relays/terminals, refer to Motion/Auxiliary relays wiring. (see page 109).
A single 24 V insulation shall be respected inside the (IN0…IN18) group.

ZARB•H•
The input/output are wired to the connector (except the safeguarding inputs).
To connect the Base Station, respect the connector description:

DANGER
HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH 
The devices connected to the Base Station IN0…IN18 inputs must respect a SELV insulation 
between their dry contact output and any external voltage.
Failure to follow these instructions will result in death or serious injury.

Pin 
nb.

ZARB-
18H•

ZARB-
12H•

Pin nb. ZARB-
18H•

ZARB-
12H•

Pin nb. ZARB-
18H•

ZARB-
12H•

Pin nb. ZARB-
18H•

ZARB-
12H•

1 CR_18 - 17 CT_16 - 33 CT_7 49 -
2 CC_18 - 18 CT_15 - 34 CC_Y 50 -
3 CT_18 - 19 S2/S3 35 CT_2 51 -
4 CT_13 - 20 IN3 - 36 IN1 - 52 -
5 CR_17 - 21 CC_16 - 37 Q0A_1 53 -
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Installation and Wiring
If the ZARC03 external antenna is used, refer to the dedicated Instruction Sheet (see page 12). 

Safeguarding Inputs
Safeguarding inputs wiring procedure: 

6 CC_17 - 22 CC_15 - 38 Q0A_2 54 -
7 CT_17 - 23 - 39 CT_3 55 -
8 CC_13 - 24 IN2 - 40 IN4 - 56 -
9 CT_14 - 25 CT_9 41 Q0B_1 57 -

10 CC_12 26 CT_8 42 Q0B_2 58 -
11 CT_11 27 CT_5 43 CT_1 59 -
12 CC_10 28 IN_COM - 44 IN5 - 60 AC_Neutral
13 CC_14 - 29 CC_Z 45 PE 61 -
14 CT_12 30 CT_6 46 - 62 AC_Phase
15 CC_11 31 CT_4 47 CC_X - -
16 CT_10 32 IN0 48 IN6 - - -

Pin 
nb.

ZARB-
18H•

ZARB-
12H•

Pin nb. ZARB-
18H•

ZARB-
12H•

Pin nb. ZARB-
18H•

ZARB-
12H•

Pin nb. ZARB-
18H•

ZARB-
12H•

Step Action
1 Unscrew the 4 screws at the front of the Base Station.
2 Remove the cover.
3 Remove the cap of the Base Station dedicated hole and install a cable gland from the kit 

ZARC06 (see page 41) (Tightening torque = 3±0.2 N.m (26.5±0.2 lb.-in)).
4 Introduce the cable through the Base Station dedicated hole.
5 Connect the wires in the dedicated terminals.
6 Tight the cable gland.
7 Install the Base Station cover.
8 Screw the 4 screws to fasten the Base Station cover.
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Installation and Wiring
Input/Output Possible Uses

Power Supply

Protective Earth Ground
The electrical isolation of the Base Station power supply from machine ground could cause static 
electricity damages. The limit switch could unexpectedly operates in case of ground fault.

Input/Output Possible uses (Depending on the configuration)
IN0 Feedback loop input (see page 121)
IN1…IN6 Detected Applicative Alarm (see page 113)
IN7…IN18 Safeguarding (see page 116)
S2_S3 Terminals for SIL2 / SIL3 E-STOP Configuration (see page 121)
Q0A, Q0B Safety relay (see page 121)
Q1…Q9 Motion relays (see page 109)
Q10…Q16 (NO type)
Q17, Q18 (NO+NC type)

Auxiliary relays (see page 110)
Selector (see page 111)
UOC (see page 114)
Specific relays (see page 119)

NOTICE
INOPERABLE EQUIPMENT
The ZARB•H Base Station must be powered with a voltage:
 From 24 Vac -15 % to 48 Vac +10 % with frequency of 50 Hz -6 %/+4 % and frequency of 

60 Hz -6 %/+4 %.
 From 24 Vdc -15 % to 48 Vdc +20 %.
The ZARB•W Base Station must be powered with a voltage:
 From 24 Vac -15 % to 240 Vac +10 % with frequency of 50 Hz -6 %/+4 % and frequency of 

60 Hz -6 %/+4 %.
 From 24 Vdc -15 % to 240 Vdc +20 %.
Failure to follow these instructions can result in equipment damage.

WARNING
UNINTENDED EQUIPMENT OPERATION
Connect the Base Station protective earth ground connection to the machine ground.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
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Installation and Wiring
The equipment could non-stop in case of ground fault on any control circuits.

NOTE: For EMC purpose, input (ex: IN1...IN6) and IN_COM signal wires must be wired in same 
cable.

Factory Setting
For details on factory setting (wiring and configuration), refer to factory setting description 
(see page 104).

General Wiring Rules

The input and power supply cables should be cross-sectional conductor area = 0.75 mm2 
(AWG 18).

The output cables should be cross-sectional conductor area = 1.3 mm2 (AWG 16).
The inputs and power supply cable lengths should not exceed 50 m (164 ft).
Follow the recommended cable diameter in the cable gland:

For more details, refer to Wiring Best Practices (see page 101).

Added Features Card Wiring
For details, refer to Added Features Card wiring (see page 268).

WARNING
UNINTENDED EQUIPMENT OPERATION
Insulate the products connected to inputs (applicative alarm, feedback loop, and safeguarding 
functions) from the electrical installation and the protective earth ground.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

Cable gland Recommended cable diameter
M20 10…14 mm (0.39…0.55 in)
M25 13…18 mm (0.51…0.71 in)
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Installation and Wiring
Wiring Best Practices

Overview
This section describes the wiring guidelines and associated best practices to be respected when 
using the system.

1 For additional information, refer to NEMA ICS 1.1 (latest edition), "Safety Guidelines for the 
Application, Installation, and Maintenance of Solid State Control" and to NEMA ICS 7.1 (latest 
edition), "Safety Standards for Construction and Guide for Selection, Installation, and Operation of 
Adjustable-Speed Drive Systems" or their equivalent governing your particular location.

DANGER
HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH
 Disconnect all power from all equipment including connected devices prior to removing any 

covers or doors, or installing or removing any accessories, hardware, cables, or wires except 
under the specific conditions specified in the appropriate hardware guide for this equipment.

 Always use a properly rated voltage sensing device to confirm that the power is off where and 
when indicated.

 Replace and secure all covers, accessories, hardware, cables, and wires and confirm that a 
proper ground connection exists before applying power to the unit.

 Use only the specified voltage when operating this equipment and any associated products.
Failure to follow these instructions will result in death or serious injury.

WARNING
LOSS OF CONTROL
 The designer of any control wiring diagram must consider the potential failure modes of control 

paths and, for certain critical control functions, provide a means to achieve a safe state during 
and after a path failure. Examples of critical control functions are emergency stop and 
overtravel stop, power outage and restart.

 Separate or redundant control paths must be provided for critical control functions.
 System control paths may include communication links. Consideration must be given to the 

implications of unanticipated transmission delays or failures of the link.
 Observe all accident prevention regulations and local safety guidelines.1
 Each implementation of this equipment must be individually and thoroughly tested for proper 

operation before being placed into service.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
EIO0000001505 09/2018 101



Installation and Wiring
Protective Earth Ground (PE) on the Backplane
The protective earth ground (PE) is connected to the conductive backplane by a heavy-duty wire, 
usually a braided copper cable with the maximum allowable cable section.

1Multipoint grounding is permissible if connections are made to an equipotential ground plane 
dimensioned to help avoid cable shield damage in the event of power system short-circuit currents

Wiring Guidelines
The following rules must be applied when wiring the system:
 I/O wiring must be kept separate from the power wiring. Route these 2 types of wiring in 

separate cable ducting.
 Verify that the operating conditions and environment are within the specification values.
 Use proper wire sizes to meet voltage and current requirements.
 Use copper conductors (highly recommended).
 Use twisted pair, shielded cables.

WARNING
IMPROPER GROUNDING CAN CAUSE UNINTENDED EQUIPMENT OPERATION
 Use cables with insulated shielded jackets for I/O signals.
 Ground shielded cables for I/O signals at a single point 1.
 Always comply with local wiring requirements regarding grounding of cable shields.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

WARNING
UNINTENDED EQUIPMENT OPERATION
 Use shielded cables wherever specified for inputs and outputs connections.
 Properly ground the cable shields as indicated in the related documentation.
 Route I/O cables separately from power cables.
Failure to follow these instructions can result in death, serious injury, or equipment damage.

WARNING
UNINTENDED EQUIPMENT OPERATION
Power line must be wired and protected with fuse or thermal magnetic switch (ex: Schneider 
Electric GV2) in compliance with local and national regulatory requirements for the rated current 
and voltage of the particular equipment.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
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Installation and Wiring
Rules for Screw Terminal Block
The following tables show the cable types and wire sizes for a 5.08 mm (0.19 in) pitch screw 
terminal block:

The use of copper conductors is required.
The use of cable ends is required.

DANGER
HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH 
The devices connected to the Base Station IN0…IN18 inputs must respect a SELV insulation 
between their dry contact output and any external voltage.
Failure to follow these instructions will result in death or serious injury.

DANGER
FIRE HAZARD
Use only the recommended wire sizes for I/O channels and power supplies.
Failure to follow these instructions will result in death or serious injury.

NOTICE
INOPERABLE EQUIPMENT
Do not tighten screw terminals beyond the specified maximum torque (Nm / lb-in.).
Failure to follow these instructions can result in equipment damage.
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Installation and Wiring
Factory Setting Description

General Parameters

Machine Protection Passwords

Detected Applicative Alarms
Base Station wiring:

General Label Factory setting value
Parameter Standby Time-out (see page 224) Enabled

15 minutes
Power saving Time-out (see page 224) Enabled

15 minutes
Horn duration (see page 234) 1 second
Radio range 
(see page 221)

Primary Base radio range Nominal
Remote radio range Nominal
Primary Base Restricted pairing Enabled

Remote Fall and Shock detection (see page 224) Disabled

General Label Factory setting value
Protection SART access sequence (see page 223) Disabled

E-STOP RESET sequence (see page 223) Disabled
SET UP access sequence (see page 224) Disabled
Configuration File Transfer Password (see page 210) Disabled
Data Storage Password (see page 314) Disabled

Label Wiring description Factory setting description Factory setting Value
IN1 Sensor input Overload pre-alarm Active state = High
IN2 Sensor input Overload alarm
IN3 Sensor input Over wind pre-alarm
IN4 Sensor input Over wind alarm
IN5 Sensor input Over speed alarm
IN6 Sensor input Generic alarm
IN_COM Common output port (to be 

connected to the other side of the 
dry contact connected to the 
IN1…IN6 inputs)

- -
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Installation and Wiring
Safeguarding Function (Only for ZARB18•)
Base Station wiring:

Motion Relays
Base Station wiring:

Label Wiring description Factory setting description
IN7 Limit switch input (for button 1) IN7…IN18 are not activated on the factory setting.
IN8 Limit switch input (for button 1H)
IN9 Limit switch input (for button 2)
IN10 Limit switch input (for button 2H)
IN11 Limit switch input (for button 3)
IN12 Limit switch input (for button 3H)
IN13 Limit switch input (for button 4)
IN14 Limit switch input (for button 4H)
IN15 Limit switch input (for button 5)
IN16 Limit switch input (for button 5 +7)
IN17 Limit switch input (for button 6)
IN18 Limit switch input (for button 6 +7)
IN_COM Common output port (to be 

connected to the other side of the 
dry contact connected to the 
IN7…IN18 inputs)

-

Label Wiring description Factory setting description
Motion relays (for axis X)
CC_X Common for relays 1…3 -
CT_1 Output of motion relay 1 Command for motion direction 1

Relay is ON when button 1 or 1H is pressed
CT_2 Output of motion relay 2 Command for motion direction 2

Relay is ON when button 2 or 2H is pressed
CT_3 Output of motion relay 3 Command for high speed

Relay is ON when button 1H or 2H is pressed
Motion relays (for axis Y)
CC_Y Common for relays 4…6 -
CT_4 Output of motion relay 4 Command for motion direction 1

Relay is ON when button 3 or 3H is pressed
CT_5 Output of motion relay 5 Command for motion direction 2

Relay is ON when button 4 or 4H is pressed
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Installation and Wiring
Auxiliary Relays
Base Station wiring:

CT_6 Output of motion relay 6 Command for high speed
Relay is ON when button 3H or 4H is pressed

Motion relays (for axis Z)
CC_Z Common for relays 7…9 -
CT_7 Output of motion relay 7 Command for motion direction 1

Relay is ON when button 5 or 5+7 is pressed
CT_8 Output of motion relay 8 Command for motion direction 2

Relay is ON when button 6 or 6+7 is pressed
CT_9 Output of motion relay 9 Command for high speed

Relay is ON when button 5+7 or 6+7 is pressed

Label Wiring description Factory setting description

General Label Wiring description Factory setting description
Auxiliary relay 10 CC_10 Common Selector

Relay 10 is ON when the Selector (button 10) is 
in position 1 or 1+2
Relay 11 is ON when the Selector (button 10) is 
in position 2 or 1+2

CT_10 Output (NO type)
Auxiliary relay 11 CC_11 Common

CT_11 Output (NO type)
Auxiliary relay 12 CC_12 Common “Horn” relay

Relay is ON during the start procedure, and for 
a configurable duration.
In START mode, the relay is ON as long as the 
ON/START/Horn button is pressed.

CT_12 Output (NO type)

Auxiliary relay 13 CC_13 Common “Radio link” relay
Relay 13 is ON as long as the radio 
communication is achieved between the Base 
Station and its Remote Device.

CT_13 Output (NO type)

Auxiliary relay 14 CC_14 Common Relay 14 is ON when button 11 is pressed
CT_14 Output (NO type)

Auxiliary relay 15 CC_15 Common Relay 15 is ON when button 12 is pressed
CT_15 Output (NO type)

Auxiliary relay 16 CC_16 Common Relay 16 is ON when button 13 is pressed
CT_16 Output (NO type)
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Installation and Wiring
The description of the relays 13 to 18 depends on the Base Station and Remote Device;
Base Station:

Remote Device:

Power Supply and PE
Base Station wiring:

Safety
Base Station wiring:

Auxiliary relay 17 CC_17 Common Relay 17 is ON when button 14 is pressed
CT_17 Output (NO type)
CR_17 Output (NC type)

Auxiliary relay 18 CC_18 Common Relay 18 is ON when button 15 is pressed
CT_18 Output (NO type)
CR_18 Output (NC type)

References ZARB12•• ZARB18••
Motion & auxiliary standard 

relays
12 (Q1…Q12) 18 (Q1…Q18)

References ZART8L• ZART8D• ZARB12D•
Number of buttons 11 (8 configurable) 11 (8 configurable) 15 (12 configurable)

General Label Wiring description Factory setting description

Label Wiring description Factory setting description
PE Protected earth ground -
AC_Neutral /- Base Station power supply -
AC_Phase /+

Label Wiring description Factory setting description
Q0A_1 Safety relay 1 -
Q0A_2
Q0B_1 Safety relay 2
Q0B_2
IN0 Feedback loop -
S2_S3
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Installation and Wiring
Functionalities Description

Section 4.3
Functionalities Description

What Is in This Section?
This section contains the following topics:

Topic Page
Motion/Auxiliary Relays 109
Auxiliary Selector 111
Multi Base Control Base Selector 112
Detected Applicative Alarm 113
Unintended Operating Control (UOC) Function 114
Safeguarding Function 116
Special Functions 119
Safety Relay 121
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Installation and Wiring
Motion/Auxiliary Relays

Description
The motion/auxiliary relays are switched ON as long as the associated button is pressed.
Only up to 6 motion/auxiliary relays activation occurs at the same time.
If more than 2 motion/auxiliary relays switching are requested at the same time, then they are 
actuated in successive switching every 20 ms (except for UOC relays).
You can configure the motion/auxiliary relays with the eXLhoist Configuration Software.
For more details, refer to Relay Assignment (see page 230).

General Wiring Rules

The cables should be cross-sectional conductor area = 1.3 mm2 (AWG 16).
For more details, refer to Wiring Best Practices (see page 101).

Wiring
Q1…Q9 motion relay internal wiring (NO type):
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Installation and Wiring
Q10…Q16 motion/auxiliary relay wiring (NO type only):
Example for Q10…Q12:

 
Q17, Q18 auxiliary relay wiring (NO+NC type):

Motion Wiring
For wiring examples, refer to the Architecture examples (see page 328).

Auxiliary Wiring
The auxiliary buttons can be used, for example, to manage a:
 Vacuum/magnetic function (see page 334)
 Auxiliary Selector switch function (see page 111)
 Supplementary motion

Factory Setting
For details on factory setting (wiring and configuration), refer to factory setting description 
(see page 104).

WARNING
UNINTENDED EQUIPMENT OPERATION
Power line must be wired and protected with fuse or thermal magnetic switch (ex: Schneider 
Electric GV2) in compliance with local and national regulatory requirements for the rated current 
and voltage of the particular equipment.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
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Installation and Wiring
Auxiliary Selector

Description
The auxiliary selector button (2 or 3 positions) can be associated to relays.
With an adapted wiring, these relays enable/disable the motions of the selected device 
(hook/trolleys).
In single and slave mode, you can configure 1 auxiliary selector.
In Master mode, you can configure up to 2 auxiliary selectors.
You can configure the auxiliary selectors with the eXLhoist Configuration Software.
For more details, refer to Relay Assignment (see page 230).

General Wiring Rules

The cables should be cross-sectional conductor area = 1.3 mm2 (AWG 16).
For more details, refer to Wiring Best Practices (see page 101).
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Installation and Wiring
Multi Base Control Base Selector

Description
In MBC configuration, the master Remote Device have an MBC Base selector.
The MBC Base selector button is used to select which Base Stations are controlled (Base A, Base 
A+B, or Base B).
You can associate relays to the MBC Base selector button.
States for the MBC Base selector:

With an adapted wiring, the Base pairing A+B state can be used, for example, to inhibit Anticollision 
Safeguarding inputs and be able to move 2 bridges side by side.
You can configure the Base selector with the eXLhoist Configuration Software.
For more details, refer to Relay Assignment (see page 230).

General Wiring Rules

The cables should be cross-sectional conductor area = 1.3 mm2 (AWG 16).
For more details, refer to Wiring Best Practices (see page 101).

State Description
Base A Activated when you press the Base selector button to select the primary Base Station.
Base A+B Activated when you press the Base selector button to select the 2 Base Stations.
Base B Activated when you press the Base selector button to select the secondary Base Station.
Base pairing A+B Activated as long as the Base selector is in Base A+B state.
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Installation and Wiring
Detected Applicative Alarm

Overview
The ZARB18•• Base Station implements 6 inputs: IN1…IN6.
Different sensors can be connected to these inputs.
These inputs are dedicated for applicative alarms.

Description
The detected applicative alarms are only displayed on the ZART•D• Remote Device.
Factory settings:

You can configure the detected applicative alarm inputs with the eXLhoist Configuration Software.
For more details, refer to Alarm Assignment (see page 238).

General Wiring Rules

The cables should be cross-sectional conductor area = 0.75 mm2 (AWG 18).
The cable lengths should not exceed 50 m (164 ft).
For more details, refer to Wiring Best Practices (see page 101).

Wiring
Wiring diagram for the detected applicative alarm devices:

1-6 Detected applicative alarm sensors

Input Description
IN1 Overload pre-alarm
IN2 Overload alarm
IN3 Over wind pre-alarm
IN4 Over wind alarm
IN5 Over speed alarm
IN6 Generic alarm
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Installation and Wiring
Unintended Operating Control (UOC) Function

Overview
The Base Station can manage 3 UOC functions.
These relays have temporization that shall correspond to the decelerating time ramp of the drive. 
After this time, the UOC relay will switch OFF to enable the Safe Torque Off (STO according to EN 
IEC 61800-5-2) input on the drive.
The UOC function allows the Wireless Remote Control System to get a STOP category 1 according 
to EN 60204.

Description
A UOC relay is associated to one motion axis (4 motion buttons).
Once a motion button is pressed, the associated UOC relay is switched ON.
When all motion buttons are released, the UOC delay time starts.
The UOC relay is switched OFF after the UOC pre-defined delay.
UOC function diagram with a drive (the UOC relay is normally open (NO)):

T1 Drive deceleration time.
T2 UOC delay time.

You can configure the UOC with the eXLhoist Configuration Software.
For more details, refer to Relay Assignment (see page 230).

WARNING
UNINTENDED EQUIPMENT OPERATION
The UOC delay time must be longer than the drive deceleration time.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
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General Wiring Rules

The cables should be cross-sectional conductor area = 1.3 mm2 (AWG 16).
For more details, refer to Wiring Best Practices (see page 101).

Wiring
Depending on the DRIVE functionality and its application schematic, the UOC relay can be directly 
connected to the DRIVE Safe Torque Off (STO according to EN/IEC 61800-5-2) input or in serial 
with a contactor coil.
For wiring examples, refer to the Architecture examples (see page 328).
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Safeguarding Function

Overview
The ZARB18•• Base Station implement 12 inputs IN7…IN18.
These inputs are dedicated for limit switches/Motion Feedback to provide a protection to the hoist 
system.
eXLhoist can manage 2 types of safeguarding protection:
 Limit Switch: drive control of the motion.
 Motion Feedback: contactor solution for the motion.

Limit Switches Description
There are 4 inputs per axis that allow to:
 Stop the motion at minimum mechanical position.
 Disable the high speed of the direction when the hoist system is near the minimum position.
 Stop the motion at maximum mechanical position.
 Disable the high speed of the direction when the hoist system is near the maximum position.
These inputs are associated to motion buttons.
Once a limit switch is opened, the associated motion relay(s) is(are) switched OFF. 
You can configure the limit switches with the eXLhoist Configuration Software.
For more details, refer to Limit Switch/Motion Feedback (see page 236).
Principle of Limit switches function installation for 1 axis:

1 Mechanical target for limit switch triggering for stopping the motion direction (example: input IN7)
2 Mechanical target for limit switch triggering for slowing the motion direction (example: input IN8) 
3 Mechanical target for limit switch triggering for slowing the motion direction (example: input IN10)
4 Mechanical target for limit switch triggering for stopping the motion direction (example: input IN9)
5 Stationary part
6 Mobil part
7 Motion (example: button 1 or 1H)
8 Motion (example: button 2 or 2H)
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Motion Feedback Description
Instead of wiring NC limit switches, you can wire to safeguarding input contactor. This allows to 
detect contactor failure.
If the motion feedback function is configured in an axis, then the corresponding inputs can be 
configured according to the activation state; activation low (NC contact) or activation high (NO 
contact).
A delay time can be assigned for each axis. This delay time can be between 0.1 s…10 s by step 
of 0.1 second.
In Motion feedback, the number of inputs per axis can be:
 3 inputs in case of 3 contactors per axis
 4 inputs in case of 4 contactors per axis

MBC Specificity
When a Master Remote Device controls 2 Base Stations (Base selector = A+B), the Safeguarding 
inputs are shared by the 2 Base Stations. For example, when a stop condition is detected by the 
Base Station A, the Base Station B stops the same movements. 
Safeguarding inputs are shared in MBC mode when a Master Remote Device controls 2 Base 
Stations:

General Wiring Rules

The cables should be cross-sectional conductor area = 0.75 mm2 (AWG 18).
The cable lengths should not exceed 50 m (164 ft).
For more details, refer to Wiring Best Practices (see page 101).
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Wiring
Wiring diagram for the detected safeguarding devices:

1-6 Limit switches

For wiring examples, refer to the Safeguarding wiring examples (see page 336).

Factory Setting
For details on factory setting (wiring and configuration), refer to factory setting description 
(see page 104).
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Special Functions

Description
The Wireless Remote Control System manages 6 specific relays:

You can configure the specific relays with the eXLhoist Configuration Software.
For more details, refer to Relay Assignment (see page 230).

Relay Description
Horn This relay is switched ON during the start procedure, and for a configurable duration.

This relay is also switched ON, in START mode, as long as the ON/START/Horn is 
pressed.

Radio link This relay is switched ON as long as a RADIO communication is achieved between the 
Base Station and its Remote Device.

Unpairing Relay This relay is switched OFF when the Base Station is paired with a Remote Device.
This relay is switched ON when the Base Station is not paired with a Remote Device.
This relay is blinking, during the pairing selection, when the Base Station is selected 
but not confirmed by the Remote Device.

Start relay This relay is switched ON as long as the 2 safety relays are ON.
It occurs only in START mode and if all the safety conditions are fulfilled.
It can indicate when the motions are enabled.

Impulse Start relay This relay is switched ON for 1 second when the Wireless Remote Control System 
enters in Start mode.
It occurs only in START mode and if all the safety conditions are fulfilled.
It can indicate when the motions become enabled.

Maintenance relay This relay is used by Data Storage functionality (see page 309).
As soon as a Settable data value exceeds its threshold value, the maintenance relay 
becomes permanently activated.
The maintenance relay is deactivated only after a reset of the corresponding Settable 
data is performed through the eXLhoist Data Storage Recovery Software 
(see page 313).
The maintenance relay can be connected to a beacon on the machine or to a 
centralized maintenance HMI or monitoring.
The maintenance relay can be connected to the generic input alarm of the Base Station 
in order to inform the operator through the Remote Device ZART•D••.
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Application Example
A “Radio link” indication shall inform operator about the system communication status according 
to EN 15011:2011 standard.
It is recommended to use a Schneider Electric beacon:

1 Light wired to the “Radio link” relay
2 Light wired to the “Start relay” relay
3 Buzzer wired to the “Horn” relay (an additional flash light can be wired to this relay)

The beacon operating is described in the START mode description (see page 137).

General Wiring Rules

The cables should be cross-sectional conductor area = 1.3 mm2 (AWG 16).
For more details, refer to Wiring Best Practices (see page 101).

Factory Setting
For details on factory setting (wiring and configuration), refer to factory setting description 
(see page 104).
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Safety Relay

IN0 Feedback Loop Input
The IN0 input is dedicated to check the correct actuator functionality with the auxiliary contact 
state.
The E-STOP function can reach up to SIL 3 level only if all the relevant auxiliary contacts are 
connected between the IN0 input and the S2_S3 port terminal.

Q0A/Q0B Safety Relays
The safety relays are switched ON when ON/START/Horn button is activated and all the safety 
conditions are fulfilled.

General Wiring Rules

The input cables should be cross-sectional conductor area = 0.75 mm2 (AWG 18).
The input cable lengths should not exceed 50 m (164 ft).
For more details, refer to Wiring Best Practices (see page 101).

Wiring
For wiring examples, refer to the Architecture examples (see page 328).

Safety Details
For more details about safety, refer to Safety chapter (see page 63).
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Remote Device Installation

Section 4.4
Remote Device Installation

What Is in This Section?
This section contains the following topics:

Topic Page
Customize The Remote Device 123
First Commissioning 124
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Installation and Wiring
Customize The Remote Device

Overview
The Wireless Remote Control System is delivered with a factory configuration. 
Use the label set to customize the remote buttons in accordance with the motion/auxiliary 
configuration.

For details on factory setting (wiring and configuration), refer to factory setting description 
(see page 104).
You can also stick an empty label above the top side of the Remote Device, and write on it the label 
of the hoisting system driven by it.
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First Commissioning

Overview
The following procedures describe the first commissioning of a Wireless Remote Control System 
from a pack (Base Station + Remote Device).
The installation must be in accordance with the factory setting (see page 104). 
For commissioning an MBC configuration, refer to How to modify an MBC configuration 
(see page 165).
In other case, refer to eXLhoist Configuration Software (see page 187) and the Discovery 
procedure description (see page 157).

First Commissioning with 1 Base Station and the ZART8L
 

It is recommended to perform the verification test of the system (see page 85).

Step Action
1 Charge the Remote Device for more than 4 hours. (see page 167)
2 Install the Base Station (see page 92).
3 Power ON the Base Station.

NOTE: Following steps of the procedure must end in 5 minutes maximum.

4 Place yourself to an appropriate distance from the Base Station (around 10 m (32.8 ft)).
5 Press only the ON/START/Horn button more than 1 s.
6 Wait for the E-STOP LED to be permanently ON.

Result: The Wireless Remote Control System is in STOP mode (see page 135).
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First Commissioning with 1 Base Station and the ZART•D
 

Step Action
1 Charge the Remote Device for more than 4 hours. (see page 167)
2 Install the Base Station (see page 92).

NOTE: Save the Base Station ID. It is required during the Remote Device pairing procedure.

3 Power ON the Base Station.

NOTE: Following steps of the procedure must end in 5 minutes maximum.

4 Place yourself to an appropriate distance from the Base Station (around 10 m (32.8 ft)).
5 Press only the ON/START/Horn button more than 1 s.

Result: The Remote Device displays the ID list of detected Base Station:

6 Selects the ID of the new Base Station with buttons 5 and 6.
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Installation and Wiring
7 Press the button 7 (trigger) to validate.
Result:

The STATUS LED and the COM LED of the selected Base Station are blinking synchronously. 
If configured, the Unpairing relay is blinking.

8 Select the validation icon (check symbol) with buttons 1 and 2.
9 Press the button 7 (trigger) to validate.

Result: The Remote Device proposes to load the Configuration File from the Base Station to the 
Remote Device.

Step Action
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10 Press the button 7 (trigger) to validate.
Result: The Remote Device proposes to confirm the load of the Configuration File from the Base 
Station to the Remote Device.

11 Select the validation icon (check symbol) with buttons 1 and 2.
12 Press the button 7 (trigger) to validate.

Result: The Remote Device loads the Configuration File from the Base Station to the Remote 
Device.

Step Action
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It is recommended to perform the verification test of the system (see page 85).

13 Wait for the end of the Configuration File load:
Result:

The Remote Device automatically powers OFF.

Step Action
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Chapter 5
Using The Wireless Remote Control System

What Is in This Chapter?
This chapter contains the following sections:

Section Topic Page
5.1 Basic Uses 130
5.2 Functionalities 146
5.3 Discovering 157
5.4 How to Modify the Configuration 160
5.5 Remote Device Charge 167
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Using The Wireless Remote Control System
Basic Uses

Section 5.1
Basic Uses

What Is in This Section?
This section contains the following topics:

Topic Page
Main Modes Diagram 131
Power ON 132
E-STOP 133
STOP 135
START 137
Power OFF 140
Multi Base Control System Pairing 142
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Using The Wireless Remote Control System
Main Modes Diagram

Main Modes Diagram
The following diagram presents the main modes of the Wireless Remote Control System:

(1) Only for ZART8LM.
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Using The Wireless Remote Control System
Power ON

Overview
The aim is to describe how to power ON the Wireless Remote Control System.

Triggering Procedure
 

Result: The Remote Device is powered ON.
The discovery procedure is automatically launched. If the Wireless Remote Control System has 
been installed correctly, the Wireless Remote Control System goes automatically in STOP mode 
(see page 135).
In other case, refer to the discovery description (see page 157).
NOTE: If the button 7 (trigger) and the ON/START/Horn button are pressed simultaneously more 
or equal than 1 s, the Remote Device goes in diagnostic mode (see page 174).

Release
The Remote Device is powered OFF:
 By the Power OFF procedure (see page 140).
 Automatically when the Remote Device battery level is too low.
 Automatically after the Power-saving timeout. You can configure the Power-saving timeout in 

the eXLhoist Configuration Software. For more details, refer to Parameters (see page 223).

Step Action
1 Check that the Remote Device is powered OFF.
2 Power ON the Base Station.
3 Press only the ON/START/Horn button more than 1 s.
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Using The Wireless Remote Control System
E-STOP

Overview
The E-STOP function leads to go to the safe position of the Wireless Remote Control System when 
the operator presses the E-STOP red mushroom button.
In E-STOP mode, the motion/auxiliary relays and the safety relays are OFF.
NOTE: The E-STOP function of the Remote Device is available only when the E-STOP LED is ON.

Triggering Procedure
 

Wireless Remote Control System in E-STOP Mode
Remote Device:

Base Station:

Step Action
1 Press the E-STOP button.

Reference Description
ZART8L•  The START LED is OFF.

 The E-STOP LED is blinking.

ZART•D•  The STOP mode symbol is displayed:

 
 The E-STOP symbol is permanently displayed:

 
 The E-STOP LED is blinking.

Element Description
Relays  The safety relays are switched OFF.

 The motion/auxiliary relays are switched OFF.
 The “Start relay” is switched OFF.

LEDs  The STATUS LED is ON. 
 The POWER LED is ON.
 The COM LED is blinking.
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Using The Wireless Remote Control System
Release
Release procedure:

Result: The Wireless Remote Control System is in STOP mode (see page 135).

Specifics Information
You can configure the E-STOP RESET sequence in the eXLhoist Configuration Software.
For more details, refer to Parameters (see page 223).

Step Action
1 Verify that there is no more risk conditions.
2 Release the E-STOP button.
3 If an E-STOP RESET sequence is configured, type it with the motion buttons 1…6.
3 Press the button 7 (trigger).
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STOP

Overview
In STOP mode, the motion/auxiliary relays are disabled and the safety relays are OFF.

Triggering Procedure
The STOP mode is reached in the following cases:
 The OFF/STOP button is pressed (the Wireless Remote Control System was previously in 

START mode).
 No button pressed for more than the configured Standby timeout (see page 224).
 Wireless connection lost (out of range for example).
 Discovery after a Power ON.
Triggering procedure when the Wireless Remote Control System is in START mode:

Wireless Remote Control System in STOP Mode
Remote Device:

Step Action
1 Check that the Wireless Remote Control System is in START mode.
2 Press the OFF/STOP button.

Reference Description
ZART8L•  The START LED is:

 OFF if no START Access Sequence is configured

 Reverse flashing (see page 182) if a START Access Sequence is configured

 The E-STOP LED is ON.

ZART•D•  The STOP mode symbol is displayed:

 
 The E-STOP LED is ON.
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Using The Wireless Remote Control System
ZART•D• display from START mode to STOP mode:

The Base Station executes the following steps:
1 The motion/auxiliary relays are switched OFF.
2 If configured, the UOC relays are switched OFF after a pre-configured time delay.
3 The safety relays are switched OFF.
Base Station:

Release
From this mode, you can:
 Charge the Remote Device battery (see page 167).
 Power OFF the Remote Device (see page 140).
 Go to START mode (see page 137).

Specifics Information
You can configure the Standby timeout duration in the eXLhoist Configuration Software.
For more details, refer to Parameters (see page 223).

Element Description
Relays  The safety relays are switched OFF.

 The motion/auxiliary relays are switched OFF.
 The “Radio link” relay is switched ON.
 The “Start relay” is switched OFF.

LEDs  The STATUS LED is ON. 
 The POWER LED is ON.
 The COM LED is blinking.
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START

Overview
The START mode is the only mode in which:
 You can command the motions (see page 147).
 You can command the auxiliary function (see page 149).
 You can command the horn (see page 156).
 The safety relays are switched ON.

Triggering Procedure
Required conditions: The Wireless Remote Control System must be in STOP mode.
Triggering procedure:

START Details
It is recommended to use a Schneider Electric beacon:

1 Light wired to the “Radio link” relay
2 Light wired to the “Start relay”
3 Buzzer wired to the “Horn” relay (an additional flash light can be wired to this relay)

Step Action
1 If a START Access Sequence is configured, type it with the motion buttons 1…6.
2 Press only the ON/START/Horn button more than 1 s.
3 Wait during the START warning time (ZART•D• vibrations, “Horn” relay is switched ON).
EIO0000001505 09/2018 137



Using The Wireless Remote Control System
Beacon description in the operating modes: (example with ZART•D•)

Step Hoisting system 
signaling

ZART•D•

Before Power ON the Remote Device

STOP mode
The motions are not enabled yet.

Between STOP mode and START mode:
 The ZART•D• vibrate facility is 

activated.
 The Horn sounds for the configured 

time.
 The motions are not enabled yet.

START mode
The motions are enabled.
The Impulse start relay is on for 1 s.
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Wireless Remote Control System in START Mode
Remote Device:

Base Station:

Release
To leave the START mode:
 You can go to STOP mode (see page 135).
 You can go to E-STOP mode (see page 133).
 The Wireless Remote Control System goes automatically to STOP mode when no button is 

pressed for more than the configured Standby timeout (see page 224).

Specifics Information
You can configure the START access, the Standby timeout, and the Horn duration in the eXLhoist 
Configuration Software.
For more details about the START access, the Standby timeout, refer to Parameters 
(see page 223).
For more details about the Horn duration, refer to Relay Assignment (see page 230).

Reference Description
ZART8L•  The START LED is ON.

 The E-STOP LED is ON.

ZART•D•  The START mode symbol is displayed: 

 
 The E-STOP LED is ON.

Element Description
Relays  The safety relays are switched ON.

 The motion/auxiliary relays are enabled.
 The “Radio link” relay is switched ON.
 The “Start relay” is switched ON.
 The “Impulse start relay” is switched ON for 1 s.

LEDs  The STATUS LED is ON. 
 The POWER LED is ON.
 The COM LED is blinking.
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Power OFF

Overview
This function switches OFF the Remote Device.

Triggering Procedure
Required conditions: The Wireless Remote Control System must be in STOP mode.
The "Power OFF function" is triggered in the following cases:
 The OFF/STOP button is pressed.
 No button pressed for more than the configured timeout: Standby timeout + Power Saving 

timeout.
 The Remote Device battery level is low.
 Fall of the Remote Device.
Triggering procedure when the Wireless Remote Control System is in STOP mode: 

Wireless Remote Control System in Power OFF Mode
Remote Device:

ZART•D• display from STOP mode to Power OFF:

Step Action
1 Check that the Wireless Remote Control System is in STOP mode
2 Press only the OFF/STOP button more than 2 s

Reference Description
ZART8L•  All the LEDs are OFF.

ZART•D•  The display is inactive.
 The E-STOP LED is OFF.
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Base Station:

Release
From this mode, you can:
 Power ON the Remote Device (see page 132).
 Charge the Remote Device battery (see page 167).

Specifics Information
You can configure the Standby timeout and the Power Saving timeout in the eXLhoist 
Configuration Software.
For more details, refer to Parameters (see page 223).

Element Description
Relays  The safety relays are switched OFF.

 The motion/auxiliary relays are switched OFF.
 The “Radio link” relay is switched OFF.
 The “Start relay” is switched OFF.

LEDs  The STATUS LED is ON. 
 The POWER LED is ON.
 The COM LED is OFF.
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Multi Base Control System Pairing

Overview
In Multi Base Control (MBC), two Single Systems work together. For example:
 System A: a Master Remote Device with its primary Base Station
 System B: another Remote Device (master or slave) with its primary Base Station.
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MBC Pairing Principle
A Base Station can only be paired and controlled by one Remote Device.
By default, or after a configuration modification, the Remote Device A is only paired with the Base 
Station A and the Remote Device B is paired with the Base Station B.
When a Remote Device is Powered OFF, the Base Station is still considered as “paired” and 
cannot be paired with another Remote Device until it gets “unpaired” following the unpairing 
procedure.
MBC pairing of a Master Remote Device A: 

Pairing/Unpairing of the MBC Pairing
To allow the Remote Device A to control Base Station B or 2 Base Stations simultaneously, you 
must:

Step Action
1 Unpair the Remote Device B (master or slave) with Base Station B.
2 Unpair the Master Remote Device A with Base Station A.
3 Pair the Master Remote Device A with desired Base Stations.
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Using The Wireless Remote Control System
To return in the original configuration: Master Remote Device A controls Base Station A and 
Remote Device B (Master or slave) controls Base Station B, you must:

MBC Unpairing Procedure
To allow a Base Station get “unpaired” from a Remote Device, you must:

Step Action
1 Unpair the Master Remote Device A with Base Station B.
2 Pair the Master Remote Device A with Base Station A.
3 Pair the Remote Device B (Master or slave) with Base Station B.

Step Action
1 Go to diagnostic mode (see page 174).
2 ZART•DM result:

The unpairing screen displays the label of the paired Base Station:

The unpairing logo blinks.

NOTE: If the Remote Device is paired with 2 Base Stations, the label of the 2 Base Stations are 
displayed.
ZART8LM result:
“1” and “2” LED are flashing.

3 Press button 7 (trigger) to confirm the unpairing request.
Result:
 The ZART8LM Remote Device automatically powers OFF.
 The ZART•DM Remote Device goes to pairing screen (see page 145).
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MBC Pairing Procedure
To allow a Base Station get “paired” to a Remote Device you must:

Step Action
1 Power ON the unpaired Remote Device.

ZART8LM result:
The ZART8LM automatically pairs with its primary Base Station and goes to STOP mode.
ZART•DM result:
The ZART•DM Remote Device goes to pairing screen:

2 For Master Remote Device, press the Base selector button to select the label of the Base Station 
to pair (the primary, the secondary, or both Base Stations).

NOTE: Only pairable Base Stations are displayed.

3 Press button 7 (trigger) to confirm the pairing request.
Result: The Remote Device pairs with the selected Base Stations and goes to STOP mode.
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Section 5.2
Functionalities

What Is in This Section?
This section contains the following topics:

Topic Page
Standard Motion 147
Auxiliary Function 149
Multi Base Control Base Selector 150
Auxiliary Selectors 152
Horn 156
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Standard Motion

Overview
In START mode, the motion buttons activate the associated motion relays that command the 
hoisting system movements.

Triggering Procedure
Required conditions: The Wireless Remote Control System must be in START mode 
(see page 137).
Triggering procedure: 

Result: The associated relays are switched ON as long as the motion button is pressed.
The Remote Device has no specific result.

Release
Release procedure:

Result: The associated relays are switched OFF.

Restrictions for Motion/Auxiliary Use
 

Step Action
1 Check that the Wireless Remote Control System is in START mode.
2 Press a motion button 1, 1H, 2, 2H, 3, 3H, 4, 4H, 5, 5+7, 6, 6+7 (see page 30).

Step Action
1 Release the motion button.

Type Description
Number of 
simultaneous 
motions

Only up to 6 motion/auxiliary relays can be activated at the same time (excluding the 
UOC relays).
If more than 6 motion/auxiliary relays are requested (excluding the UOC relays), then the 
last motion relay request is not taken into account.

Interlocking If 2 buttons dedicated to the same motion axis are pressed in opposite sense 
(interlocking), then the motion is stopped in these both directions.
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Specifics Information
In the eXLhoist Configuration Software, you can configure:
 Motion/auxiliary buttons associated to relays (see page 230).
 Motion/auxiliary buttons interlocking (see page 225).
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Auxiliary Function

Overview
In START mode, the auxiliary buttons activate the associated relays to command auxiliary action 
(for example to command open and close grab).

Triggering Procedure
Required conditions: The Wireless Remote Control System must be in START mode 
(see page 137).
Triggering procedure: 

Result: The associated relays are switched ON as long as the auxiliary button is pressed.
The Remote Device has no specific result.

Release
Release procedure:

Result: The associated relays are switched OFF.

Specifics Information
In the eXLhoist Configuration Software, you can configure:
 Motion/auxiliary buttons associated to relays (see page 230).
 Motion/auxiliary buttons interlocking (see page 225).

Step Action
1 Check that the Wireless Remote Control System is in START mode.
2 Press an auxiliary button (10, 10+7, 11, 11+7, 12, 12+7, 13, 13+7, 14, 14+7, 15, 15+7) (see page 30).

Step Action
1 Release the auxiliary button.
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Multi Base Control Base Selector

Description
Multi Base Control (MBC) = one Remote Device commands one or two Base Stations. For more 
details, refer to MBC Mode (see page 21) and to MBC Pairing (see page 142).
Once the Master Remote Device is paired with 2 Base Stations, the MBC Base selector button 
allows to switch between the primary, the secondary, and both Base Stations.
The MBC Base selector button is only available with the ZART•DM Remote Device configured as 
Master.

Triggering Procedure
Required conditions: The Wireless Remote Control System must be in STOP mode 
(see page 135) or in START mode (see page 137).
Triggering procedure: 

Wireless Remote Control System Result
Remote Device:
For the ZART8L•: not supported.
For the ZART•DM display: the Base Station label indicates which bridge(s) is(are) paired / 
selected: 

For more details, refer to ZART•D• Display Parts Identification (see page 33).

Step Action
1 Check that the Wireless Remote Control System is in STOP mode or in START mode.
2 Press the MBC Base Selector button to loop between the several positions.

ZART•DM display

Primary Base 
Station (283) paired

The 2 Base Stations (283 and 476) are paired.
Press the MBC Base selector button to select the Base Station to control.

Secondary Base 
Station (476) 

paired.Primary Base Station 
(283) selected.

The 2 Base Stations 
(283 and 476) are 

selected.

Secondary Base 
Station (476) 

selected.
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Base Station result:
The associated relays are switched ON.
For more details, refer to relay assignment (see page 233).

In MBC configuration, when both Base Stations are selected, the motions asked with the Remote 
Device are realized simultaneously by the 2 Base Stations.
In MBC configuration, the “Radio link” relay of the connected Base Station switches ON:

Specifics Information
At the first Power ON or after a new configuration, the MBC Base Selector position is 1. For further 
Power ON, the Selector position is the last known Selector position.
You can configure the Selector in the eXLhoist Configuration Software.
For more details, refer to Relay Assignment (see page 230).

Relay Selector position A Selector position A+B Selector position B
RADIO link Base A Base B Base A Base B Base A Base B
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Auxiliary Selectors

Description
There are 2 different configurations to use the auxiliary selector button:
 Trolley selector (2 or 3 positions): to manage 2 trolleys with one Base Station.
 Hook selector (2 positions): to manage 2 hooks with one Base Station.

Triggering Procedure
Required conditions: The Wireless Remote Control System must be in STOP mode 
(see page 135) or in START mode (see page 137) depending on the Auxiliary selector 
configuration (see page 223).
Triggering procedure: 

Wireless Remote Control System Result
Remote Device result:
For the ZART8L•: the Selector LEDs are activated depending on the selection done.
For the ZART•D• display: the Auxiliary Selector symbol indicates which trolley(s)/hook(s) is(are) 
selected: 

For more details, refer to ZART•D• Display Parts Identification (see page 33).

Base Station result:
The associated relays are switched ON.
For more details, refer to relay assignment (see page 233).

Step Action
1 Check that the Wireless Remote Control System is in STOP mode or in START mode depending 

on the Auxiliary selector configuration.
2 Press the Auxiliary Selector button more than 1 s to loop between the several positions.

Nb of position Description
2

3
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MBC Specifications
You can configure up to 2 Auxiliary selector buttons to the ZART•DM Remote Device when it is 
configured as a Master.
Auxiliary selector button of the Remote Device can be assigned to:
 1 Base Station, 

or
 2 Base Stations (same action to the 2 Base Stations in the same time).
Example with one Auxiliary selector button assigned to two Base Stations:

 Auxiliary selector: Trolleys 1+2 operative on bridge A
 MBC Base selector: Primary and secondary Base Stations selected

1 Remote Device
2 Bridge A: Trolley 1
3 Bridge A: Trolley 2
4 Bridge A: Primary Base Station
5 Bridge B: Trolley 1
6 Bridge B: Trolley 2
7 Bridge B: Secondary Base Station
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Example with two Auxiliary selector buttons respectively assigned to one Base Station:

 Auxiliary selector: Trolley 1 operative on bridge A
 Auxiliary selector: Trolley 2 non-operative on bridge A
 Auxiliary selector: Trolleys 1+2 operative on bridge B
 MBC Base selector: Primary and secondary Base Stations selected

1 Remote Device
2 Bridge A: Trolley 1
3 Bridge A: Trolley 2
4 Bridge A: Primary Base Station
5 Bridge B: Trolley 1
6 Bridge B: Trolley 2
7 Bridge B: Secondary Base Station
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Example with one Auxiliary selector button assigned to only one Base Station:

 Auxiliary selector: Trolley 1 operative on bridge A
 Auxiliary selector: Trolley 2 non-operative on bridge A
 MBC Base selector: Primary and secondary Base Stations selected

1 Remote Device
2 Bridge A: Trolley 1
3 Bridge A: Trolley 2
4 Bridge A: Primary Base Station
5 Bridge B: Trolley
6 Bridge B: Secondary Base Station

Specifics Information
At the first Power ON or after a new configuration, the Selector position is 1. For further Power ON, 
the Selector position is the last known Selector position.
You can configure the auxiliary Selectors in the eXLhoist Configuration Software.
For more details, refer to Relay Assignment (see page 230).
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Horn

Overview
From STOP mode to START mode, the “Horn” relay is switched ON for a predefined duration time.
In START mode, as long as you press the ON/START/Horn button, the “Horn” relay is switched 
ON.

Triggering Procedure
Triggering procedure: 

Result: The “Horn” relay is switched ON as long as the ON/START/Horn button is pressed.
The Remote Device has no specific result.

Release
Release procedure:

Result: The “Horn” relay is switched OFF.

Specifics Information
The Horn duration during start can be configured in the eXLhoist Configuration Software.
For more details, refer to Relay Assignment (see page 230).

Step Action
1 Check that the Wireless Remote Control System is in START mode.
2 Press the ON/START/Horn button.

Step Action
1 Release the ON/START/Horn button.
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Section 5.3
Discovering

Discovering

Overview
The discovering function is developed to be as automatic as possible.
This function manages 2 different tasks:
 The pairing of the system: association between a Remote Device and a Base Station
 The Configuration File Upload/Download: this file contains the Wireless Remote Control System 

configuration information.
This function is launched at each Remote Device Power ON. In normal use, this function is 
automatic. You have to realize intermediate operations during:
 A device replacement (see page 247)
 The first commissioning (see page 124)
 A configuration modification (see page 160).
NOTE: This function is only applicable to ZART•D Remote Device.
EIO0000001505 09/2018 157



Using The Wireless Remote Control System
Discovering Diagram
The following diagram presents the detailed Discovering function:

Pairing
The pairing is the action to associate a Base Station with a Remote Device.
Each Base Station have a unique ID.
The pairing test is launched at each Remote Device power ON.
As long as the pairing test is OK, the validation procedure is not requested to the operator.
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Configuration File
The Configuration File is stored in the Remote Device and in the Base Station.
The Configuration File can be created or modified in the eXLhoist Configuration Software  
(see page 187).
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Section 5.4
How to Modify the Configuration

What Is in This Section?
This section contains the following topics:

Topic Page
How to Modify a Single Configuration 161
How to Modify a MBC Configuration 165
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How to Modify a Single Configuration

Configuration Modification
The following procedure describes how to modify the system configuration:

It is recommended to perform the verification test of the system (see page 85).

Step Action
1 Connect the Remote Device to a PC (see page 192).
2 Start the eXLhoist Configuration Software (see page 204).
3 Create or open a project (see page 205).
4 Modify the configuration of the project (see page 215).
5 Save the project (see page 213).
6 Select Communication → Store to Device.
7 If enabled, enter the transfer password of the Configuration File already stored in the Remote Device.
8 Wait for the end of the Configuration File load in the Remote Device.
9 Disconnect the Remote Device to the PC.

10 Power ON the Base Station.

NOTE: Following steps of the procedure must end in 5 minutes maximum.

11 The Configuration File must be loaded from the Remote Device to the Base Station.
Refer to:
 Configuration File load With a ZART8L• (see page 162).
 Configuration File load With a ZART•D• (see page 163).
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Configuration File Load with a ZART8L•
After the modification of the configuration with the eXLhoist Configuration Software:

It is recommended to perform the verification test of the system (see page 85).

Step Action
1 Power ON the Remote Device.

Result: The STATUS LED and the COM LED of the selected Base Station are blinking 
synchronously. If configured, the Unpairing relay is ON.
The START, “1”, and “2” LED of the Remote Device are flashing.

2 Press the button 7 (trigger) to validate.
3 If the Configuration File in the Base Station is protected by a Configuration File transfer 

password, enter it.
4 Wait for the end of the Configuration File load (around 20 seconds).

The Configuration File is automatically loaded from the Remote Device to the Base Station.
During the load, the START LED and “2” LED are flashing (see page 182).

5 The Remote Device automatically powers OFF.
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Configuration File Load with a ZART•D•
After the modification of the configuration with the eXLhoist Configuration Software:

Step Action Result
1 Power ON the Remote Device. The STATUS LED and the COM LED of the 

selected Base Station are blinking 
synchronously. If configured, the Unpairing 
relay is ON.

2 Press the button 7 (trigger) to validate. The Remote Device proposes to load the 
Configuration File from the Base Station to the 
Remote Device.

3 Change the direction of the Configuration File 
load with buttons 5 and 6.

4 Press the button 7 (trigger) to validate. The Remote Device proposes to confirm the 
load of the Configuration File from the Remote 
Device to the Base Station.
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It is recommended to perform the verification test of the system (see page 85).

5 Select the validation icon (check symbol) with 
buttons 1 and 2.

-

6 Press the button 7 (trigger) to validate. -
7 If the Configuration File (stored in the Base 

Station) has a transfer password, a padlock is 
displayed:

Enter this Configuration File transfer password 
with the buttons 1 to 6.

-

8 The Remote Device loads the Configuration 
File from the Remote Device to the Base 
Station.

Wait for the end of the Configuration File load.

The Remote Device automatically powers OFF.

Step Action Result
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How to Modify a MBC Configuration

Overview
In MBC, two Single Systems work together. For example:
 System A: a Master Remote Device with its primary Base Station
 System B: another Remote Device (master or slave) with its primary Base Station.

NOTE: Each system have a unique Configuration File. To configure an MBC System, you have to 
manage 2 Configuration Files (one per Base Station).

MBC Configuration Modification
The following procedure describes how to modify the MBC system configuration:

Step Action
1 Connect the Remote Device A to a PC (see page 192).
2 Start the eXLhoist Configuration Software (see page 204).
3 Click Connect button to Create a project for the system A (with the Configuration File of the 

connected Remote Device.
4 Modify the configuration of the project (see page 215).

Main parameters:
 Remote Device as a Master
 Enter Base Station A ID as the Primary Base Station ID
 Enter Base Station B ID as the Secondary Base Station ID

5 Save the project (see page 213) of the System A.
1 In Tandem, use the same Remote Device with two Master configurations.
2 In Tandem, it is recommended to save as the configuration A into configuration B and exchange the Base 

Stations IDs.
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It is recommended to perform the verification test of the system (see page 85).

6 Select Communication → Store to Device.
7 Wait for the end of the Configuration File load in the Remote Device A.
8 Disconnect the Remote Device A to the PC.
9 Power ON the Base Station A.

NOTE: Following steps of the procedure must end in 5 minutes maximum.

10 The Configuration File must be loaded from the Remote Device A to the Base Station A.
Refer to Configuration File load with a ZART•D• (see page 163).

11 Connect the Remote Device B to the PC (see page 192)(1).
12 Click Connect button to Create a project for the system B(2) (with the Configuration File of the 

connected Remote Device.
13 Modify the configuration of the project (see page 215).

Main parameters:
 Remote Device as a Master or a slave
 Enter Base Station B ID as the Primary Base Station ID
 Enter Base Station A ID as the Secondary Base Station ID

14 Save the project (see page 213) of the System B.
15 Select Communication → Store to Device.
16 Wait for the end of the Configuration File load in the Remote Device B.
17 Disconnect the Remote Device B to the PC.
18 Power ON the Base Station B.

NOTE: Following steps of the procedure must end in 5 minutes maximum.

19 The Configuration File must be loaded from the Remote Device B to the Base Station B.
If Slave, refer to Configuration File load with a ZART8L• (see page 162).
If Slave or Master, refer to Configuration File load with a ZART•D• (see page 163).

Step Action

1 In Tandem, use the same Remote Device with two Master configurations.
2 In Tandem, it is recommended to save as the configuration A into configuration B and exchange the Base 

Stations IDs.
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Section 5.5
Remote Device Charge

Remote Device Charge

Required Conditions
 The Remote Device must only be charged indoor with the ZARC01 charger.
 The Remote Device temperature range must be 10…60 °C (50…140 °F).
NOTE: At the first commissioning, you must charge the Remote Device for 4 hours.
NOTE: The Remote Device charge time is around 15 minutes long at the maximum if the 
temperature range is 10…35 °C (50…95 °F), and is longer if the temperature is higher than 35 °C 
(95 °F).

NOTICE
UNOPERATIVE REMOTE DEVICE
Do not charge the Remote Device at a temperature under 10 °C (50 °F).
Failure to follow these instructions can result in equipment damage.

WARNING
BATTERY LIFESPAN, RISK OF EXPLOSION AND FIRE
Do not dispose of electric tools together with household waste material.
In observance of european directive 2002/96/EC on wasted electrical and electronic equipment 
and its implementation in accordance with national law, electric tools that have reached the end 
of their life must be collected separately and returned to an environmentally compatible recycling 
facility.
Failure to follow these instructions can result in death, serious injury, or equipment damage.
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Procedure
 

Step Action
1 Power OFF the Remote Device.
2 On the bottom of the Remote Device, remove the protective cap.

1 Remote Device battery charge connector
2 Protective cap

3 Connect the charger ZARC01 to the Remote Device battery charge connector.
4 Plug the charger ZARC01 to the dedicated power source.
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NOTE: As soon as the Remote Device Charge starts, the communications between the Remote 
Device and the Base Station are stopped.

5 Wait for around 15 minutes at 25 °C (77 °F).
During the charge:
 ZART8L•: the battery LED is flashing.
 ZART•D•: the blinking battery symbol indicates the battery level:

The battery is fully charged when:
 ZART8L•: the battery LED is permanently ON.
 ZART•D•: the battery symbol is permanently displayed.

For more details, refer to Diagnostic (see page 177).
NOTE: The time duration for charge of the Remote Device depends on the ambient 
temperature.

6 Unplug the charger to the dedicated power source.
7 Unconnect the charger to the Remote Device battery charge connector.
8 On the bottom of the Remote Device, place back the protective cap.

Step Action
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Chapter 6
Diagnostic

What Is in This Chapter?
This chapter contains the following sections:

Section Topic Page
6.1 Base Station Diagnostic 172
6.2 ZART•D Diagnostic 173
6.3 ZART8L Diagnostic 182
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Base Station Diagnostic

Section 6.1
Base Station Diagnostic

Diagnostic

Description
The Base Station have 3 LED indicators: 

Special case:
STATUS and COM LEDs are synchronized reverse flashing: pairing confirmation request.

 LED  Color State Description
STATUS Green ON The Wireless Remote Control System is working properly.

Blinking Refer to the chapter Troubleshooting (see page 319).
OFF Base Station Power OFF or internal fault detected.

COM Yellow ON Call Schneider Electric support.
Blinking The communication is established between the Base Station and the 

Remote Device.
OFF No communication between the Base Station and the Remote Device.

POWER White OFF Base Station powered OFF.
ON Base Station powered ON.
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Section 6.2
ZART•D Diagnostic

What Is in This Section?
This section contains the following topics:

Topic Page
Diagnostic Mode 174
Battery Level of the Remote Device 177
Radio Communication Indicator 178
E-STOP LED 179
Applicative Alarms Signals 180
Detected Failure Displays 181
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Diagnostic Mode

Overview
The ZART•D• has a specific diagnostic mode display:
 To test the Wireless Remote Control System configuration.
 To pair/unpair Remote Device.

Procedures to Activate the Diagnostic Mode
The diagnostic mode on the ZART•D• indicates the inputs and relays states of the Base Station.
From STOP mode:

From Power OFF mode:

Step Action
1 Go to STOP mode (see page 135).
2 Simultaneously press the buttons 1H and 2H, and release immediately.
3 Less than 5 seconds later, simultaneously press the buttons 3H and 4H.
4 Release the buttons 3H and 4H.

Result: The Remote Device displays the Diagnostic mode in STOP mode.

Step Action
1 Simultaneously press the button 7 (trigger) and the ON/START/Horn button more or equal than 

1 second.

NOTE: Only the Remote Device information are accessible. 
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Diagnostic Mode in STOP Mode
In STOP mode, use the buttons 1 and 2 to alternate between the screens:

The Unpairing screen allows Unpairing the Remote Device with its paired Base Station. For more 
information, refer to MBC pairing description (see page 142).
Press ON/START/Horn button more or equal than 1 second to display the Diagnostic mode in 
START mode.

Diagnostic Mode in START Mode
If the Remote Device is paired with one Base Station, the Remote Device displays dynamically the 
I/O status of the Base Station:

1 IN1...IN18 states: up for input = 1, down for input = 0
2 Relays 1...18 states: up for output = 1, down for output = 0

If the Remote Device is paired with 2 Base Stations, the Remote Device leaves the diagnostic 
mode and goes in START mode.

Unpairing Remote Device 
information

Primary Base Station 
information

Secondary Base Station 
information

Only in MBC mode Single and MBC modes Single and MBC modes Only in MBC mode for 
Master Remote Device
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Procedure to Leave the Diagnostic Mode
From START mode:

From STOP mode:

From any diagnostic screen:

Step Action
1 Press STOP button to go to STOP mode

Step Action
1 Press STOP button to leave the Diagnostic mode.

Step Action
1 Press only the OFF/STOP button more than 2 seconds to Power OFF the Remote Device.
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Battery Level of the Remote Device

ZART•D

Display Description
Battery charge level is high

Battery charge level is medium

Battery charge level is low

This display occurs at least 10 minutes before the Remote Device powers OFF.
In addition, the Remote Device vibrator function is activated for 1 second.
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Radio Communication Indicator

ZART•D•

NOTE: In MBC mode, when the 2 Bases Stations are paired, the Remote Device displays the 
primary Radio Communication level.

Display ZART•D• radio communication level with the Base Station
High

Medium

Low

Very low

No radio communication
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E-STOP LED

Description

For more details, refer to E-STOP LED description (see page 133).

E-STOP LED Description
Permanently ON E-STOP is operational and not triggered.
Blinking E-STOP is operational and triggered.
Permanently OFF E-STOP is not operational.
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Applicative Alarms Signals

Overview
Some devices can be connected to the ZARB18• Base Station to provide detected applicative 
alarms signals that can be displayed on the ZART•D.

ZART•D
When applicative alarms signals come from ZARB18• Base Station, the ZART•D Remote Device 
involves a symbol display and 3 seconds of vibration every 10 minutes as long as the alarm signal 
is active.
The Remote Device displays the following symbols: 

NOTE: The applicative alarms are only information, the Wireless Remote Control System does not 
change its functional mode.

Display Status Description
Permanently ON Overload pre-alarm
Blinking Overload alarm

Permanently ON Over wind pre-alarm
Blinking Over wind alarm

Blinking Over speed alarm

Blinking Generic alarm
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Detected Failure Displays

ZART•D
The ZART•D Remote Device can display the following symbols: 

Display Status Description
Blinking Configuration File download failure detected

Blinking Configuration File upload failure detected

Blinking Remote Device battery charge failure detected

Blinking Main contactor feedback loop IN0 / S2_S3 failure detected or 
motion contactor failure detected when the motion feedback 
function is used.

Blinking The "Restricting pairing" happens 5 minutes after the power 
ON and forbid the pairing with a new Base Station.
For more details, refer to troubleshooting (see page 319).
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ZART8L Diagnostic

Section 6.3
ZART8L Diagnostic

ZART8L• LED Diagnostic

Overview
This section describes the ZART8L• Display LEDs (see page 35).

LED Status Chronogram 
The following diagram presents the different status of the ZART8L• LEDs:
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Start LED

Battery LED
Charger ZARC01 not connected:

Label Status
A OFF
B ON
C Normal blink
D Fast blink
E Flash step 1
F Flash step 2
G Reverse flash step 1

Label Status Description
B ON The system is in START mode with radio operational
C Normal blink Radio not established or START mode not yet confirmed
F Reverse flash step 1 A password has not yet been provided & validated (either for before 

START sequence, or after unlocking the E-STOP before START)
D Fast blink Wrong Configuration File 
E Flash step 1 The Remote Device is connected to a PC.
A OFF To represent other states than the previous ones

Label Status Description
B ON Battery charge level is high

Battery charge level is medium
C Normal blink Battery charge level is low
D Fast blink Battery charge level is very low

The battery capacity just allows 10 minutes of normal operation.
A OFF The battery is fully discharged or the Remote Device is Power OFF. 
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Charger ZARC01 connected:
Once the Remote Device is connected to the battery charger, the battery LED flashes 3 times 
(status E = Flash step 1). After the 3 flashes, the battery LED status changes to the following ones:

Auxiliary Selector LEDs
The “1” LED:

The “2” LED:

Set of LEDs
Power ON - Check LEDs:
At Remote Device Power ON, the 4 LEDs (START, Battery, 1, and 2) flash one time (status E = 
Flash step 1).
Remote Device failure detected:
If a Remote Device internal failure is detected, the 4 LEDs go in the following status:
 The START LED is in status E = Flash step 1
 The BATTERY LED is in status E = Flash step 1
 The “1” LED is in status E = Flash step 1
 The “2” LED is in status E = Flash step 1

Label Status Description
B ON Battery charge level is full (No need to charge or end of charge)
E Flash step 1 Battery charge in progress
C Normal blink Impossible to charge (charger failure detected) or temperature out of 

the allowed boundaries
A OFF Impossible to charge (battery too low to be charged)

Label Status Description
B ON The “1” or the “1+2” auxiliary selector position is selected and confirmed
C Normal blink The “1” or the “1+2” auxiliary selector position is required but not yet confirmed
A OFF The auxiliary selector position “1” is NOT selected

Label Status Description
B ON The “1+2” or the “2” auxiliary selector position is selected and 

confirmed
C Normal blink The “1+2” or the “2” auxiliary selector position is required but not yet 

confirmed
A OFF The auxiliary selector position “2” is NOT selected
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Configuration file download:
During the transfer of a Configuration File (from the Remote Device to the Base Station):
 The START LED is in status E = Flash step 1
 The “2” LED is in status F = Flash step 2
Remote Device reset:
When you press the reset button: until the “1” and “2” LED come in the following status:
 The “1” LED is in status E = Flash step 1
 The “2” LED is in status A = OFF

E-STOP LED

Label Status Description
B ON E-STOP is operational and not triggered.
C Normal blink E-STOP is operational and triggered.
A OFF E-STOP is not operational.
EIO0000001505 09/2018 185



Diagnostic
186 EIO0000001505 09/2018



Harmony eXLhoist
eXLhoist Configuration Software
EIO0000001505 09/2018
eXLhoist Configuration Software

Chapter 7
eXLhoist Configuration Software

What Is in This Chapter?
This chapter contains the following sections:

Section Topic Page
7.1 Introduction to eXLhoist Configuration Software 188
7.2 User Interface 194
7.3 Project Management 201
7.4 Project and System Configuration 215
7.5 Remote Device Configuration 222
7.6 Base Station Configuration 229
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Introduction to eXLhoist Configuration Software

Section 7.1
Introduction to eXLhoist Configuration Software

What Is in This Section?
This section contains the following topics:

Topic Page
What is eXLhoist Configuration Software? 189
Installation 191
Connect a Remote Device to the PC 192
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What is eXLhoist Configuration Software?

Introduction
eXLhoist Configuration Software is a graphic user interface allowing you to manage the 
configuration of the Wireless Remote Control System.

Software Features
Main software features of eXLhoist Configuration Software:
 Standard Windows® interface
 Application browser and multiple window views
 Programming and configuration support
 Communication with controller

Standard Windows® Interface
Key standard Windows® features:
 Easy use of keyboard or mouse
 Dockable windows
 Standard menu organization
 Tooltips, status bar, and shortcut menus
 Online help including context-sensitive help

Controller Communication and Control
Main eXLhoist Configuration Software features for remote support:
 Connecting and disconnecting a remote
 Downloading and uploading remote configuration files

Additional Information
Refer to the following for additional information:
 For information on standard Windows® interface features, refer to Microsoft Windows® 

documentation and help files.
 For context-sensitive help, first click in the main window and then press F1 or click the help 

buttons in dialog boxes.
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Conventions
The following typographic conventions are used in this operation guide.

Format Represents
Bold For user input, enter words or phrases shown in bold as they appear. Menu names 

and options, commands and toolbar names, and dialog box names and options are 
also shown in bold type.

UPPER CASE Keyboard names, combinations, and sequences are shown in all uppercase 
letters. For example, the keyboard shortcut for creating a new application is 
CTRL+N. To perform this shortcut, press and hold the CTRL key and then press 
the N key.

File → Open The arrow indicates a menu selection. In this instance, go to the File menu to select 
the Open command.
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Installation

Introduction
The software can be downloaded from www.schneider-electric.com.
It must be installed via an administrator account.

Prerequisites
eXLhoist Configuration Software supports the following Windows® platforms:
 Windows® 7 32/64 bits
 Windows® 8.1 32/64 bits
 Windows® 10 32/64 bits only for eXLhoist Configuration Software version ≥ v4.0
eXLhoist Configuration Software requires the following minimal configuration:
 Dual core processor
 RAM: 2 GB
 Required disk space: 2 GB
 Windows® 7 32 bits

Installation Process
To install eXLhoist Configuration Software, follow the steps below:

Step Action
1 Double-click the program file (setup.exe).
2 If the .NET® framework 3.5 SP1 is not already installed, the installer automatically installs it.

NOTE: An Internet connection is required.

3 Follow all the steps. 

NOTE: It is recommended to follow the steps concerning the driver installation of the 
TCSMCNAM3M002P USB to RS-485 converter (with RJ45 plug) to avoid inoperable 
communication with the connected Remote Device.
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Connect a Remote Device to the PC

Introduction
The connection is made using the USB to RS-485 converter (with RJ45 plug).
Before connecting the Remote Device to the PC:
 It is recommended to Power OFF the Remote Device.
 The eXLhoist Configuration Software must be installed.

Description
The figure illustrates the connection to a personal computer:

1 Personal computer
2 USB to RS-485 converter (with RJ45 plug): TCSMCNAM3M002P
3 Remote Device

The PC does not supply the Remote Device. As long as the Remote Device is connected to the 
PC, it is recommended to charge the remote (see page 167) during the process.

NOTICE
INOPERABLE EQUIPMENT
 Always connect the communication cable to the PC before connecting it to the device.
 Only use the Schneider Electric cable TCSMCNAM3M002P.
Failure to follow these instructions can result in equipment damage.
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Remote Device Display
As long as the Remote Device is connected to the PC: 
ZART8L•: The Start LED is flashing.
ZART•D•: a dedicated screen is displayed 
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User Interface

Section 7.2
User Interface

What Is in This Section?
This section contains the following topics:

Topic Page
Starting Screen 195
Main Window 196
Status Bar 197
Toolbar 198
Menu Bar 199
Tree View 200
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Starting Screen

Introduction
The eXLhoist Configuration Software starting window is displayed at software launch. It provides 
easy access to the main functions: 
 Create a new project.
 Open an existing project.
 Connect to a Remote Device.

Description
The illustration shows the eXLhoist Configuration Software starting screen: 

For more details, refer to Create a project (see page 205).

Button Description
Create a Project Allows you to create a new project with default values.
Open a Project Allows you to open an existing project. Project files have the “xpf” extension.
Connect Allows you to create a project with the data stored in a Remote Device. 

The data are loaded from the Remote Device to the PC.
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Main Window

Introduction
The eXLhoist Configuration Software main window provides access to menus and commands, 
windows, and toolbars.

Description
The illustration shows the eXLhoist Configuration Software main window: 

Area Description
1 Status bar (see page 197)
2 Toolbar (see page 198)
3 Menu bar (see page 199)
4 Tree view (see page 200)
5 Project configuration (see page 216)
196 EIO0000001505 09/2018



eXLhoist Configuration Software
Status Bar

Introduction
The status bar is a panel at the bottom of the main window that displays information about the 
application and the connected device. The status bar can be turned on or off by selecting View → 
Status Bar from the menu bar.

Description
The status bar displays:
 Status messages and prompts
 Project status
EIO0000001505 09/2018 197



eXLhoist Configuration Software
Toolbar

Introduction
The toolbar is a panel at the top of the main window which provides access to the main commands 
using icons.
The toolbar can be turned on or off by selecting View → Toolbar from the menu bar.

Description
The illustration shows the eXLhoist Configuration Software toolbar:

Element Description
1 Go to Start Page: Displays the start page, any opened project must be closed. If the project is 

not saved, a dialog box asks to save the project.
2 New Project: Creates new project, any opened project must be closed. If the project is not saved, 

a dialog box asks to save the project.
3 Open Project: Opens a project saved on your computer.
4 Save: Saves modifications to an existing project.
5 Save As: Saves an open project under a name and/or in a new location.
6 Page Setup: Ables to configure the printing page setup.
7 Print Preview: Displays the print preview.
8 Print: Prints the project.
9 Identify Device: Displays information related to the connected Remote Device.
10 Edit Connection (see page 209).
11 Connect to Device: Establishes the connection between the Remote Device and the PC.
12 Disconnect from Device: Disconnects the connection between the Remote Device and the PC.
13 Load Values From Device: Loads the parameters from the connected Remote Device to the 

project file.
If no project is opened, this command loads the Remote Device information to the project file.
If a project is opened, this command loads the Remote Device configuration to the project. 
Project data are overwritten.

14 Store Values to Device: Transfer configuration from project to the Remote Device.
If no project is opened, this command downloads the existing project file information to the 
Remote Device.
If a project is opened, this command transfers the project information to the Remote Device.
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Menu Bar

Introduction
The menu bar is a panel at the top of the main window which provides access to the command 
menus.

Description
The illustration shows the eXLhoist Configuration Software menu bar:

Menu Description
File Available to launch file related operations (New, Open, Export, Print, Save, Close, and 

so on).
View Available to toggle the toolbar and status bar visibility. 
Communication Available to manage the communication-related operation.
Device Available to manage:

 The Transfer Configuration File Password (see page 210).
 The Data Storage (see page 309).

Tools Available to switch the language of the eXLhoist Configuration Software.

NOTE: Application restart needed.

Help Available to display the Help and About of the eXLhoist Configuration Software.
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Tree View

Introduction
The eXLhoist Configuration Software tree view provides access to the connected Remote Device 
parameters.

Description
The illustration shows the eXLhoist Configuration Software tree view:

The following tabs are available from Remote Device tree view:
 Parameters (see page 223)
 Interlocking (see page 225)
 Device Identity (see page 227)
The following tabs are available from Base Station tree view:
 Relays Assignment (see page 230)
 Limit Switch/Motion Feedback (see page 236)
 Alarm Assignment (see page 238)
 Data storage Assignment (see page 240)
 Device Identity (see page 244)
The following tabs are available from Option Card tree view (if present):
 I/O (see page 278)
 Serial Link (see page 279)
 Display (see page 280)
 Overload (see page 282)
 Device Identity (see page 283)
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Project Management

Section 7.3
Project Management

What Is in This Section?
This section contains the following topics:

Topic Page
Diagram 202
Start and Exit eXLhoist Configuration Software 204
Creating a Project 205
Edit a Connection 209
Project Passwords Management 210
Load the Configuration into the Remote Device 212
Save a Project 213
Export to PDF 214
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Diagram

Uses Cases
The main use cases of the eXLhoist Configuration Software are:
 Create a project.
 Open an existing project.
 Open a new project using data from Remote Device connected.
 Save project.
 Close project.
 Generate the configuration documentation and the Base wiring diagram to export in “.pdf” files.
 Transfer configuration from PC to Remote Device.
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The diagram illustrates the use cases:
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Start and Exit eXLhoist Configuration Software

Start eXLhoist Configuration Software
The installation procedure for eXLhoist Configuration Software creates one or more of the following 
options for starting the software, depending on selections made during installation.
Select one of the following options to start eXLhoist Configuration Software:
 Double-click the eXLhoist Configuration Software icon on the Windows® desktop.
 Select the eXLhoist Configuration Software entry from the Windows® programs menu.
 Select Run from the Windows® start menu and browse for the eXLhoist Configuration Software 

program.
eXLhoist Configuration Software starts and the starting screen is displayed.

Exit eXLhoist Configuration Software
To exit eXLhoist Configuration Software:

Step Action
1 Select File → Exit from the main menu.

If there is no change, the application closes and eXLhoist Configuration Software exits to the 
Windows® desktop.
If there are changes, an exit dialog box is displayed prompting you to save changes.

2 Select Yes to save changes and exit eXLhoist Configuration Software.
Select No to discard changes and exit.
Select Cancel to return to eXLhoist Configuration Software with changes intact.
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Creating a Project

Overview
As shown in the eXLhoist Configuration Software diagram, there are 3 ways to start a project:
 Create a new project with default values (see page 206).
 Open an existing project (see page 207).
 Create a new project with the configuration stored in a connected Remote Device 

(see page 207).
These 3 ways can be realized form the starting screen but also from the main menu.
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Create a New Project with Default Values
Follow the procedure to create a new project with default values.

Step Action
1 From the starting screen, click Create a project button.

Note: From the main menu, select File  → New.
2 A device system configuration window is displayed:

Select the appropriate devices.
3 Click Create button.

Result: The project window is activated.
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Open an Existing Project
Follow the procedure to open an existing project from your PC:

Note: If you do not enter the correct project password, the project is nevertheless opened but in 
“Locked” mode. In this mode, only the Device Identity tab content is displayed.

Create a New Project with the Configuration Stored in a Remote Device
Follow the procedure to create a new project with the configuration stored in a connected Remote 
Device:

Step Action
1 From the starting screen, click Open a project button.

Note: From the main menu, select File  → Open.
2 A browser window is displayed.

Select the project file (“.xpf”).
3 Click Open.
4 If the project file is locked, a window is displayed.

Enter the project password (see page 211).
Click Enter.
The project window is activated.

Step Action
1 Connect a Remote Device to the PC (see page 192). 
2 From the starting screen, click Connect button.
3 If the communication between the PC and the Remote Device is not established, a window is 

displayed:

Click Configure to display the Edit Connection windows (see page 209).
Click Connect to retry the connection.
Click Cancel to cancel the connect procedure.
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NOTE: If you do not enter the correct project password, the project is nevertheless opened in 
“Locked” mode. In this mode, only the Device Identity tab content is displayed.

4 If the configuration in the Remote Device has a transfer Configuration File password, a window 
is displayed.
Enter the Transfer Password (see page 210) with the keyboard of the PC.
Click Enter.

5 Wait during the transfer.
Note: A progress bar is displayed during the transfer.

6 If the project file is locked, a window is displayed.
Enter the project password (see page 211).
Click Enter.
The project window is activated.

Step Action
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Edit a Connection

Overview
Follow the procedure to modify the communication settings for the connected device:

Step Action
1 Connect a Remote Device to the PC (see page 192). 
2 From the main menu, select Communication  → Edit Connection.
3 A window is displayed:

Select the COM Port.
4 Click Test.
5 Click OK to validate and close the window.

Click Cancel to close the window.
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Project Passwords Management

Overview
You can configure 2 passwords to the project:
 The transfer password of the Configuration File
 The project password

Transfer Password
The transfer password ables to protect the Configuration File stored in the Base Station against:
 Overwriting
 Wrong pairing
 Download by inappropriate person
The transfer password is asked before each Configuration File transfer:
 After a modification of the system configuration (see page 161)
 During a remote replacement (see page 253)
To improve the machine configuration protection, it is recommended to configure a Configuration 
File transfer password.
Follow the procedure to create or modified the transfer password:

The transfer password is stored in the project and in the Configuration File.
During configuration, use the keyboard of the PC to enter the transfer password.
In normal use (not connected to a PC), use the motion buttons 1...6 of the Remote Device to enter 
the transfer password.

Step Action
1 From the main menu, select Device → Transfer Password → Create Password.

Result: A window is displayed.
2 To modify an existing password, enter the previous password in the Old Password field.
3 Enter the new transfer Configuration File password in the New Password and in the Confirm 

Password fields.

NOTE: Password must be 2 digits up to 6 digits.
Digits allowed are 1, 2, 3, 4, 5 and 6.

4 Click OK.
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Project Password
The project password is asked before opening a “Locked” project.
If you do not enter the correct project password, the project is nevertheless opened but in “Locked” 
mode. In this mode, only the Device Identity tab content is displayed. 
Follow the procedure to create or modified the project password:

Follow the procedure to unlock a project (opened without the correct project password):

Step Action
1 From the main menu, select File → Password → Project Password.

Result: A window is displayed.
2 To modify an existing password, enter the previous password in the Old Password field.
3 Enter the new project password in the New Password and in the Confirm Password fields.

NOTE: Password can contain from 1 to 20 characters.
Characters allowed are a…z, A…Z, and 0…9.
All other characters are non-allowed ( + ° _ - % ’ .).

4 Click OK.

Step Action
1 From the main menu, select File → Password → Unlock Project.

Result: A window is displayed.
2 Enter the project password.
3 Click OK.
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Load the Configuration into the Remote Device

How To ...
Follow the procedure to load the configuration from the PC to the Remote Device:

Step Action
1 Connect a Remote Device to the PC (see page 192). 
2 Create or open a project (see page 205). 
3 From the main menu, select Communication → Store to device.
4 If enabled, enter the transfer password of the Configuration File already stored in the Remote 

Device.
5 Wait during the transfer.
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Save a Project

How To ...
Follow the procedure to save the project file on the PC:

It is possible to duplicate and change the name of the project file by selecting File → Save as.

Step Action
1 From the main menu, select File → Save.

Result: A browser window is displayed.
2 Choose the directory.
3 Click Save.
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Export to PDF

How To ...
Follow the procedure to export the configuration to a PDF file:

Follow the procedure to export the Base wiring diagram to a PDF file:

Step Action
1 From the main menu, select File → Export → Export to PDF.

Result: A browser window is displayed.
2 Choose the directory and the name of the export file.
3 Click Export.

Result: The export file is created.
4 A question window asks you to open or not the export file.

Click Yes to open the export file.
Click No to go back to the project workspace.

Step Action
1 From the main menu, select File → Export → Base Wiring Diagram.

Result: A browser window is displayed.
2 Choose the directory and the name of the export file.
3 Click Export.

Result: The export file is created.
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Project and System Configuration

Section 7.4
Project and System Configuration

What Is in This Section?
This section contains the following topics:

Topic Page
Project Configuration 216
System Configuration 219
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Project Configuration

Overview
In this tab, you can configure the Wireless Remote Control System main features.
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Project Topology Settings
The Project Topology Settings area allows you to select the topology of your system:
 Single
 Standalone Tandem
 Master-Master Tandem
 Master-Slave Tandem
 Large Crane
Project Topology Settings area:

For more information, refer to Main applications (see page 17).

System Configuration
The System Configuration area allows you to select the main features of each system:
 System Name
 Base Reference
 Option Card Reference
System Configuration area:
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You must enter the parameters of the System-A Base Station (Primary Base):

If the Remote Device is configured as a Master, you must enter the parameters of the System-B 
Base Station (Secondary Base):

Step Action
1 Enter the ID of the Base Station.

Format: 00 80 F4 0X XX XX (0X XX XX  is an hexadecimal value from 0 00 00 to 3 FF FF).
This ID can be read on the Label of theBase Station.

2 Select in the list a Machine Label number (0…999).
This label number is displayed on the ZART•D• to identify the selected Base Station/Bridge.

Step Action
1 Enter the ID of the Base Station.
2 Select in the list a Machine Label number (0…999). 
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System Configuration

Overview
In this tab, you can configure the Wireless Remote Control System parameters.

Remote Device Settings
The Remote Device Settings area allows you to configure the main features of your system:
 The Remote Device main parameters
 The Base Station Selection.
 The Auxiliary Selectors.
Remote Device Settings area:
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Select in the list the Nb Button of the Base selector that will be used to select Base Station. For 
more details, refer to MBC Base selector description (see page 150).
With an adapted wiring, the Auxiliary Selectors enable/disable the motions of the selected device 
(hook/trolleys):

For more details, refer to Auxiliary selector description (see page 152).

Base Station Settings
The Base Station Settings area allows you to configure following features of the Base Station:
 Enable the Base Station firmware update.
 In case of a tandem topology, enable the tandem stop synchronization.
Base Station Settings area:

Step Action
1 Select the Auxiliary Selector Enable checkbox.

If the Remote Device is configured as a Single or a Slave, only the Auxiliary Selector 1 can be 
configured.

2 Select in the Nb Button list the button to be used as auxiliary selector.
For ZART8••: it is possible to assign button 10...11.
For ZART12••: it is possible to assign button 10...15.

3 Select 2 or 3 in the Nb Position list.
4 Click in the Change in RUN area to enable/disable the Auxiliary selector use in START mode.

If disabled, the Auxiliary Selector is only usable in STOP mode.
5 Click in the Base Station area to make enabled/disabled the use of the Auxiliary selector with 

the corresponding Base Station.
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Radio Settings
The Radio Settings area allows you to configure the radio main features:
 The Base Station radio range.
 The Remote Device radio range
 Enable the primary Base Station restricted pairing.
Radio Settings area:

You can limit the radio level of your system.
You can select for the Base Station and for the Remote Device:
 Nominal: standard radio level
 Reduced: reduced radio level
The factory setting value is Nominal.
 
The Primary Base Restricted pairing function manages the Base Station pairing restriction:
 If the Restricted pairing is enabled, then the Base Station will accept the connection only with 

the Remote Device paired with the Base Station. The pairing can only be done:
 During 5 minutes after a Power OFF/Power ON cycle of the Base Station

or 
 after an unpairing request in MBC mode (see page 142).

 If the restricted pairing is disabled, then the Base Station will accept the connection with all 
Remote devices configured with the ID of the Base Station.

The factory setting value is Enable.
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Remote Device Configuration

Section 7.5
Remote Device Configuration

What Is in This Section?
This section contains the following topics:

Topic Page
Parameters 223
Interlocking 225
Device Identity 227
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Parameters

Overview
In this tab, you can configure the Wireless Remote Control System parameters.

Start Access Sequence
When START access sequence is enabled, the operator must enter this sequence to go in START 
mode.
Click Enable checkbox to enable/disable it.
The allowed buttons for this sequence are 1, 2, 3, 4, 5, 6.
The sequence can have 1 to 6 steps. 
The sequence can use same button several times.

E-STOP RESET Sequence
E-STOP RESET sequence is asked to the operator to reset the Remote Device after an E-STOP. 
If reset sequence is empty or disable, the operator has to press the button 7 (trigger).
Click Enable checkbox to enable/disable it.
The user must press button 7 (trigger) to validate the end of sequence.
The allowed buttons for this sequence are 1, 2, 3, 4, 5, 6.
The sequence can have 1 to 6 steps.
The sequence can use same button several times.
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Set Up Sequence
When SET UP access sequence is enabled, the operator must enter this sequence to go in 
SET UP mode.
Click Enable checkbox to enable/disable it.
The allowed buttons for this sequence are 1, 2, 3, 4, 5, 6.
The sequence can have 1 to 6 steps. 
The sequence can use same button several times.

Standby Timeout
The Remote Device goes automatically from START mode to STOP mode if no buttons are 
pressed during the Standby Timeout delay.
Click Enable checkbox to enable/disable it.
You can modify the duration: 1…60 minutes.
The factory setting value is 15 minutes. 

Power Saving Timeout
When the Wireless Remote Control System is in STOP mode due to Standby Timeout, if no button 
is pressed during this Power saving Timeout, the Remote Device automatically powers OFF.
Click Enable checkbox to enable/disable it.
You can modify the duration: 1…300 minutes.
The factory setting value is 15 minutes. 

Remote Fall and Shock Detection
When the function is enabled, if a Remote Device fall or shock is detected, the Remote Device 
powers OFF and the Base Station waits for a Remote Device connection.
Click Enable checkbox to enable/disable it.
The factory setting value is Disable.
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Interlocking

Overview
In this tab, you can configure the buttons combinations that cannot operate simultaneously.

Configuration

Example of the factory setting: 
The button 1 and 2 are associated to the same axis, for the opposites directions.
The button 1 must not operate while the button 2 is pressed.
The button 2 must not operate while the button 1 is pressed.
If the buttons are pressed simultaneously, the movement is stopped.

Step Action
1 Click a cell to interlock (or not) 2 buttons (or buttons combinations).

Result: When the buttons are interlocked, the empty cell has now an associated symbol: .
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Restriction Due To Remote Device
This tab is automatically modified according to the selected/connected Remote Device:

Configuration in MBC
When the Remote Device is configured as Master, 2 interlocking tables are displayed:
 One interlocking table when the Remote Device commands the primary Base Station.
 Another interlocking table when the Remote Device commands the primary Base Station and 

the secondary Base Station.

Modifications on the primary table are automatically done on the second table.
Modifications on the second table are not automatically done on the primary table.

Reference Disable buttons
ZART8L• 12…15+7
ZART8D• 12…15+7
ZART12D• -

Step Action
1 Click a cell to interlock (or not) 2 buttons (or buttons combinations).

Result: When the buttons are interlocked, the empty cell has now an associated symbol: .
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Device Identity

Overview
From this tab, you can read generic information from the Remote Device:
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Description
At the activation, the fields are clear.
Click Read to display generic information coming from the connected Remote Device. If there is 
no Remote Device connected, you are informed by a popup and all fields are cleared.
Remote Device general information: 

Information is updated and stored in the Remote Device after a download Configuration File from 
PC.
The Remote Device and the Base Station have additional information in the areas Reserved for 
Schneider Electric use.
If the Remote Device is configured as a Master, another Base Station information area is displayed 
for the second Base Station.

Field Description
Reference Remote Device reference.
Firmware Version Firmware version of the Remote Device.

Format xx.yy.zzzz.tttt (where xx is major version, yy is minor version, zzzz 
is the quality evolution index, and tttt is internal revision index)

Configuration File version Version of the Configuration File stored in the Remote Device.
Format xxx.yyy (where xxx is major version and yyy is minor version).

Radio ID Radio ID of the Remote Device
Family eXLhoist
Code EAN13 Code EAN13 of the Remote Device.

ZART8L: 3606480610356
ZART8D: 3606480610363
ZART12D: 3606480610370
ZART8LM: 3606481138309
ZART8DM: 3606481138293
ZART12DM: 3606481138286

Last Download Date of the last load of a Configuration File in the Remote Device.
Application name Name of the project file (Last 30 characters).
Manufacturer Schneider Electric
DTM Version Version of the DTM.
Configuration Information
Software Creation Version

Version of the eXLhoist Configuration Software used at the project creation 
time (Never change after).

Configuration Information
Last Modification Software Version

Version of the eXLhoist Configuration Software used at the last project 
modification time.
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Base Station Configuration

Section 7.6
Base Station Configuration

What Is in This Section?
This section contains the following topics:

Topic Page
Relay Assignment 230
Limit Switch/Motion Feedback 236
Alarm Assignment 238
Data Storage Assignment 240
Device Identity 244
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Relay Assignment

Overview
In this tab, you can:
 Associate one or more relays to:
 The motion buttons.
 The auxiliary buttons.
 The auxiliary selectors.
 The Base selector.
 The special functions.
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 Configure the UOC function.
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Restriction Due To Remote Device
This tab is automatically modified according to the selected/connected Remote Device:

Generic Description
The main use of this tab is to configure the association between the buttons and the relays.
To associate a button to a relay:

As long as the button is pressed, the associated relays are activated.
The cells in gray cannot be assigned.
4 relays maximum can be associated with the motion buttons (1…6+7).

Button 7 Standalone
Click the button 7 Standalone checkbox to enable/disable the function:
 Button 7 standalone:

In this configuration, the buttons 5+7, 6+7, 10+7, 11+7, 12+7, 13+7, 14+7 and 15+7 are 
disabled.
For example, button 7 standalone can be used as a validation button. Refer to button 7 
validation button wiring example (see page 340).

 Button 7 coupled with other button:
In this configuration, the buttons 5+7, 6+7, 10+7, 11+7, 12+7, 13+7, 14+7 and 15+7 are 
enabled.
For example, button 7 coupled with other button can be used as a second speed with buttons 
5, 6, 10, 11, 12, 13, 14, and 15.

Reference Disable relay column Disable buttons rows
ZART8L 13...18 12…15+7
ZART8LM - 12…15+7
ZART8D• - 12…15+7
ZART12D• - -

Step Action
1 Click a cell to associate a button to a relay.

Result: The empty cell has now an associated symbol  
2 To be more explicit, you can click in the Name text zone of a button to modify it (24 characters 

maximum).
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Auxiliary Selector
The Auxiliary Selector is only visible if it is configured in Remote Device Settings (see page 219).
With an adapted wiring, the Auxiliary Selectors enable/disable the motions of the selected device 
(hook/trolleys)

For example: 

For more information, refer to auxiliary selectors description (see page 152).

Step Action
1 Click a cell to associate a relay to a selector position.

Result: The empty cell has now an associated symbol  
2 To be more explicit, you can click in the Name text zone of a button to modify it (24 characters 

maximum).
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Base Selector
The Base Selector is only usable if the Remote Device is configured as a Master in Remote Device 
Settings (see page 219).
The Base selector is used to select the Base Station to be controlled. 
You can associate a relay to the Base selector position:

The Base Pairing 1+2 relay is activated when the Remote Device is connected to the 2 Base 
Stations. This relay can be used if a PLC is managing the Tandem functionality (see page 21).
For example: 

Special Functions Configuration
The special functions configuration consists in associate a special function to a relay: 

The 6 special functions are:
 Horn
 Horn duration

This value is the Horn duration activation during the Start procedure.
You can modify the duration: 0…60 s.
The factory setting value is 1 second.

 Radio link
 Unpairing relay
 Start relay
 Impulse Start relay
 Maintenance relay
For more information, refer to special functions description (see page 119).

Step Action
1 Click a cell to associate a relay to a selector position or the Base pairing 1+2.

Result: The empty cell has now an associated symbol  

Step Action
1 For each of the 6 special functions, click a cell to associate a relay.
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UOC Configuration
The UOC configuration consists in associate a motion axis to a relay.
This relay can be wired to the DRIVE Safe Torque Off (STO) or in serial with a contactor coil.

For example: 

The relay 14 is ON when one or more of relays 1, 2, 3 is ON.
When relays 1, 2 and 3 are OFF, the UOC delay starts.
The relay 14 goes OFF when the UOC delay is expired.
For more details, refer to UOC description (see page 114).

Step Action
1 Click the UOC Enable checkbox.

NOTE: There is a UOC function for the 3 axis.

2 Select the associated relay in the Relay list.

Result: Corresponding cells are automatically filled by the symbol .
3 Enter the UOC delay (0.1…99.9 seconds).
EIO0000001505 09/2018 235



eXLhoist Configuration Software
Limit Switch/Motion Feedback

Overview
In this tab, you can configure the Safeguarding inputs:
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Safeguarding Function Configuration
The Safeguarding function configuration consists in enable/disable the Safeguarding inputs.
When the Safeguarding input is activated, the associated motion button is considered as 
unpressed and the associated relays are switched OFF.
The association between motion buttons and Safeguarding inputs are unmodifiable:

Follow the procedure to configure safeguarding inputs:

For more details, refer to limit switches/Motion Feedback description (see page 116).

Motion button 1 1H 2 2H 3 3H 4 4H 5 5+7 6 6+7
Safeguarding 
input

IN7 IN8 IN9 IN10 IN11 IN12 IN13 IN14 IN15 IN16 IN17 IN18

Step Action
1 Select the Enable checkbox of an input Nb (Input 7...Input 18).
2 For each axis, select the input type: Limit Switch or Motion Feedback.
3 For each axis, if Motion Feedback is selected:

 Select in Activate state list:
 High (NO)
 Low (NC)

 Select the Number of inputs per axis:
 3 Inputs
 4 Inputs

 Enter the Delay (0.1…10 s)
 Select the Unintended detection and enter the corresponding delay (0.1…10 s)
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Alarm Assignment

Overview
In this tab, you can configure the Applicative Alarm states.

The Base Station can provide detected alarms information to the ZART•D•.
Voltage free sensors can be connected to Base Station.

For more information, refer to Detected applicative alarms wiring (see page 113).
The bottom of the table allows configuring the Data Storage of the Detected applicative alarms. For 
more details, see next page.

Step Action
1 Click High or Low to select the active state of each alarm.

With a NO type switch, select High.
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Configure Data Storage Alarm Input Assignments
When you used a ZARB18•• Base Station, you can configure threshold for each of 6 inputs 
associate to the ZARB18•• Base Station.
For each input, you can configure:
 Activation count threshold
 Activation time threshold in hour
 Pulsating time configuration
 Pulsating count threshold
The following procedure describes how to configure input threshold:

For more details, refer to Data Storage principle (see page 310). 

Step Action
1 Click Alarm Assignment Tab:

2 Unlock Data Storage parameters (see page 314)
3 For input to be configured, configure threshold assignments:

 Activation count threshold (0…1000000)
 Activation time threshold in hour (0...87658 hour)
 Pulsating time in second (0…10 s with step 0.1 s)
 Pulsating count threshold (0…10000)
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Data Storage Assignment

Overview
Data Storage function allows to store in the Base Station cumulative operation hours and number 
of operations of the:
 Motions and auxiliary buttons
 Special functions
 Alarm inputs
For more details, refer to Data Storage overview (see page 310).

Configure Data Storage Axis Parameters
You can configure up to 8 axis associate to Data Storage.
For each axis, you can configure:
 Associated buttons of the Remote Device
 Associated label of the bridge movement
 Auxiliary selector position
 Activation count threshold
 Activation time threshold
 Pulsating time configuration
 Pulsating count threshold
 Backtracking time configuration (depend on axis configuration)
 Backtracking count threshold (depend on axis configuration)
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The following procedure describes how to configure axis parameters:

Step Action
1 Unlock Data Storage parameters (see page 314)
2 Click Data Storage Assignment tab:

3 For axis to be configured, click Axis Label area.
Result: The Axis Label Selector window opens:

(1) For axis configured with only one direction, it is not possible to measure backtracking.
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For more details, refer to Data Storage principle (see page 310).

Data Storage Application Example
Example of a System with 2 trolleys:

4 Drag and drop corresponding label.
One or two labels can be assigned on each axis. The list of labels is identical to the kit of adhesive 
labels for Remote Device. So you have the same labels on Remote Device buttons and the axis 
assignment.
Click OK to close the Axis Label Selector window.

5 Click a cell to select Remote Device button corresponding to axis movement.

Result: The empty cell has now an associated symbol 
6 If used, click a cell to select auxiliary selector position associate to axis.
7 Configure threshold assignments:

 Activation count threshold (0…1000000)
 Activation time threshold in hour (0...87658 hours)
 Pulsating time in second (0…10 s with step 0.1 s)
 Pulsating count threshold (0…1000000)
 Backtracking time(1) in second (0…10 s with step 0.1 s)
 Backtracking count threshold (1000000)

Step Action

(1) For axis configured with only one direction, it is not possible to measure backtracking.
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Axis Description:

Configure Data Storage Special Function Threshold
You can configure activation threshold for each of 4 Special functions:
 Horn.
 Radio Link.
 Base Pairing 1+2.
 Start Relay.
Each of 4 special functions is defined in Relays Assignment tab (see page 230).
For each Special function, you can configure:
 Activation count threshold
 Activation time threshold
The following procedure describes how to configure Special Function threshold:

Axis Nb Description
1 Travel
2 Transverse trolley 1
3 Transverse trolley 2
4 Hoist trolley 1
5 Hoist trolley 2
6 Rotation hook 1
7 Rotation hook 2
8 -

Step Action
1 Click Data Storage Assignment tab.
2 For Special Function to be configured, configure threshold assignments:

 Activation count threshold (0…1000000)
 Activation time threshold in hour (0…87658 hours)
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Device Identity

Overview
From this tab, you can read generic information from the Base Station:

Description
At the activation, the fields are clear.
Click Read to display generic information coming from the connected Remote Device. If there is 
no Remote Device connected, you are informed by a popup and all fields are cleared.
Base Station general information: 

Information is updated and stored in the Remote Device after a download Configuration File from 
PC.
The Remote Device and the Base Station have additional information in the areas Reserved for 
Schneider Electric use.
If the Remote Device is configured as a Master, another Base Station information area is displayed 
for the second Base Station.

Field Description
Base Station Type Base Station type.
Firmware Version Firmware version of the Base Station.

Format xx.yy.zzzz.tttt (where xx is major version, yy is minor version, zzzz 
is the quality evolution index, and tttt is internal revision index)

Radio ID Radio ID of the Base Station
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Chapter 8
Maintenance / Device Replacement

What Is in This Chapter?
This chapter contains the following sections:

Section Topic Page
8.1 Maintenance 246
8.2 Device Replacement 247
8.3 Remote Device Resets 258
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Maintenance

Section 8.1
Maintenance

Maintenance

Remote Device Cleaning
When the surface or the frame of the display gets dirty, soak a soft cloth in water with a neutral 
detergent, wring the cloth tightly, and wipe the display.

Periodic Check Points
Monthly check point for the ZARB•W Base Station: check the good terminal block tightening.
For more information, refer to the Safety chapter (see page 63).

NOTICE
EQUIPMENT DAMAGE
Do not use paint thinner, organic solvents, or a strong acid compound to clean the equipment.
Failure to follow these instructions can result in equipment damage.
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Device Replacement

Section 8.2
Device Replacement

Overview
The Configuration File management allows some device replacement.

What Is in This Section?
This section contains the following topics:

Topic Page
Base Station Replacement 248
ZART•D• Replacement 253
ZART8L Replacement 257
EIO0000001505 09/2018 247



Maintenance / Device Replacement
Base Station Replacement

New Base Station Replacement
Follow the procedure to replace a Base Station by a new one:

Step Action
1 Execute a Remote Pairing Reset (see page 258).
2 Install the new Base Station.
3 Power ON the new Base Station.

NOTE: The following steps of the procedure must end in 5 minutes maximum.

4 Place yourself with the Remote Device to an appropriate distance from the Base Station (around 
10 m (32.8 ft)).

5 Press only the ON/START/Horn button on the Remote Device more than 1 s.
Result: The Remote Device looks for Base Stations:

6 Wait until the scan of Base Station ends.
Result: The Remote Device displays the ID list of detected Base Stations:
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7 Selects the ID of the new Base Station with buttons 5 and 6.
This ID can be read on the label of the Base Station.

8 Press the button 7 (trigger) to validate.
Result:

The STATUS LED and the COM LED of the selected Base Station are blinking synchronously. 
If configured, the Unpairing relay is blinking.

9 Select the validation icon (check symbol) with buttons 1 and 2.
10 Press the button 7 (trigger) to validate.

Result: The Remote Device proposes to load the Configuration File from the Base Station to the 
Remote Device.

Step Action
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11 Change the direction of the Configuration File load with buttons 5 and 6.
Result: 

12 Press the button 7 (trigger) to validate.
Result: The Remote Device proposes to confirm the load of the Configuration File from the 
Remote Device to the Base Station.

13 Select the validation icon (check symbol) with buttons 1 and 2.
14 Press the button 7 (trigger) to validate.

Step Action
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15 If the Configuration File (stored in the Base Station) has a transfer password, a padlock is 
displayed:

Enter this Configuration File transfer password with the buttons 1 to 6.
16 The Remote Device loads the Configuration File from the Remote Device to the Base Station.

Step Action
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It is recommended to perform the verification test of the system (see page 85).

17 Wait for the end of the Configuration File load.
Result:

18 Power OFF the Remote Device.

Step Action
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ZART•D• Replacement

Replacement of a ZART•D• by an out-of-the-box One
Procedure to replace an out of order ZART•D• by an out-of-the-box one:

Step Action
1 Power ON the Base Station.

NOTE: The following steps of the procedure must end in 5 minutes maximum.

2 Place yourself with the Remote Device to an appropriate distance from the Base Station 
(around 10 m (32.8 ft)).

3 Press only the ON/START/Horn button on the Remote Device more than 1 s.
Result: The Remote Device looks for Base Stations:

4 Wait until the scan of Base Station ends.
Result: The Remote Device displays the ID list of detected Base Stations:

5 Selects the ID of the appropriate Base Station with buttons 5 and 6.
This ID can be read on the label of the Base Station.
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6 Press the button 7 (trigger) to validate.
Result:

The STATUS LED and the COM LED of the selected Base Station are blinking synchronously. 
If configured, the Unpairing relay is blinking.

7 Select the validation icon (check symbol) with buttons 1 and 2.
8 Press the button 7 (trigger) to validate.

Result: The Remote Device proposes to load the Configuration File from the Base Station to 
the Remote Device.

Step Action
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9 Press the button 7 (trigger) to validate.
Result: The Remote Device proposes to load the Configuration File from the Base Station to 
the Remote Device.

10 Select the validation icon (check symbol) with buttons 1 and 2.
11 Press the button 7 (trigger) to validate.
12 If the Configuration File (stored in the Base Station) has a transfer password, a padlock is 

displayed.
Enter this Configuration File transfer password with the buttons 1 to 6.

13 The Remote Device loads the Configuration File from the Base Station to the Remote Device.

Step Action
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It is recommended to perform the verification test of the system (see page 85).

Replacement of a ZART•D by an Already Configured One
Replacement of an out of order ZART•D by an already configured one:

14 Wait for the end of the Configuration File load:
Result:

15 Power OFF the Remote Device.

Step Action

Step Action
1 Do a Remote Factory Reset (see page 258).
2 Execute the procedure Replacement of an out of order ZART•D by a new one (see page 253).
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ZART8L Replacement

Replacement of an ZART8L
Procedure to replace a ZART8L:

It is recommended to perform the verification test of the system (see page 85).

Step Action
1 Connect the Remote Device to a PC (see page 192).
2 Start the eXLhoist Configuration Software (see page 204).
3 Open the existing project of the Remote Device to replace (see page 207).
4 Select Communication → Store to Device.
5 Wait for the end of the Configuration File load in the Remote Device.
6 Disconnect the Remote Device to the PC.
7 Power ON the Base Station.

NOTE: The following steps of the procedure must end in 5 minutes maximum.

8 Power ON the Remote Device.
Result: The STATUS LED and the COM LED of the Base Station are blinking synchronously. 
If configured, the Unpairing relay is ON.
The “1” and “2” LED of the Remote Device are flashing.

9 Press the button 7 (trigger) to validate.
Result: The Configuration File is automatically loaded from the Remote Device to the Base 
Station.

10 Wait for the end of the Configuration File load (around 20 seconds).
During the load, the START LED and “2” LED are flashing (see page 182).

11 The Remote Device automatically powers OFF.
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Remote Device Resets

Section 8.3
Remote Device Resets

Remote Device Resets

Procedure
 

Step Action
1 Power ON the Remote Device.
2 On the rear of the Remote Device, unscrew the 2 Torx screws, diameter 3.5 mm (0.14 in).
3 Remove the cover.
4 Press and maintain the reset button for the appropriate duration (see page 259).

For the ZAR•D:
When the first delay is reached (for Pairing reset), 
the remote displays:

When the second delay is reached (for Factory 
reset), the remote displays:

5 Release the reset button.
5 Place back the cover.
6 Screw the 2 screws to mount the cover.
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Remote Device rear view:

1 Cover
2 RJ45 socket
3 Reset button
4 2 Torx screws, diameter 3.5 mm (0.14 in)

Reset Information
 

Title t = Reset button 
duration press

Remote Device reaction

Simple reset t < 5 s  Remote Device reboot.

Pairing reset 5 s ≤ t < 20 s  Remote Device reboot.
 Erase in the remote memory the stored Base Station ID. The remote is no 

more paired with Base Station.
Factory reset t > 20 s  Remote Device reboot.

 Erase in the remote memory the stored Base Station ID. The remote is no 
more paired with Base Station.

 Delete the Configuration File. The Remote Device goes back to factory 
settings.
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Chapter 9
Added Features Card

What Is in This Chapter?
This chapter contains the following sections:

Section Topic Page
9.1 Overview 262
9.2 Wiring 268
9.3 Software Configuration 276
9.4 Modbus SL Communication 284
9.5 Added Features Card Operation 302
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Overview

Section 9.1
Overview

What Is in This Section?
This section contains the following topics:

Topic Page
Added Features Card Overview 263
Added Features Card Characteristics 264
Added Features Card Installation 266
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Added Features Card Overview

Overview
The ZARCFBA01 Added Features Card is an optional card designed to extend the functionalities 
of the Base Station ZARB18W• by adding:
 4 analog inputs (current or voltage)
 Modbus SL slave RTU (Remote Terminal Unit) features for the communication between the 

Base Station and a Modbus master (typically a PLC).

Package Content
Applicable items that could be included in the Added Features Card package:

1 Added Features Card
2 4 M3 screws
3 Modbus removable terminal
4 Instruction Sheet
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Added Features Card Characteristics

Environment
The Added Features Card specifications are described in the table:

Specification Details Value
Product certifications - CE
Environment - RoHS Compliant
Option card life time - 10 years
Degree of pollution - 3
Operating temperature - -25…70 °C (-13…158 °F)
Storage temperature - -40…70 °C (-40…158 °F)
Operating humidity range - 0…97 %
Storage humidity range - 0…97 %
Altitude Operation

Storage
0…2000 m (0…6561.7 ft)
0…3000 m (0…9842.5 ft)

Vibration Standards IEC 60947-1 Annex Q
IEC 61131-2, Pr NF EN 60255-1
IEC 60068-2-6, Test Fc

For each axis:
2 Hz…13.2 Hz: ±1 mm (±0.039 in)
13.2 Hz…100 Hz: ±6.86 m/s² (0.7 gn)

DNV / BV / LROS / GL / RINA 2 Hz…8.14 Hz: ±7.5 mm (±0.295 in)
8.14 Hz…150 Hz: 19.6 m/s² (2 gn)

Shock IEC 60947-1 Annex Q
IEC 61131-2
IEC 60068-2-27, Test Ea

Peak acceleration:
147 m/s² (15 gn) for 11 ms

24V dc Power supply - OCV1 (24 Vdc SELV)
Voltage dips for 24V dc - 5 ms
Resistance to radiated fields IEC 61000-4-3, criteria A 10 V/m (80 MHz < f < 1 GHz)

3 V/m (1.4 GHz < f < 2.0 GHz)
1 V/m (2 GHz < f < 2.7 GHz) 

Immunity to fast transient IEC 61000-4-4, 24 Vdc power supply 2 kV (direct), and 4 kV with safety criteria 
according to IEC 62061

IEC 61000-4-4, analog inputs and 
shield, Modbus serial line shield, CM

2 kV in direct on the shield of analog 
inputs
2 kV with coupling clamp for the dc input 
and dc output

Surge immunity IEC 61000-4-5, analog inputs shield, 
Modbus serial line shield

CM (line to ground): 1 kV

IEC 61000-4-5, between the power 
supply wires (Differential mode)

1 kV, direct coupling with a load in serial 
with the relay contact, criteria A
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Immunity to conducted magnetic 
fields

IEC-61000-4-6, Modbus shield, analog 
inputs shield

150 kHz…80 MHz: 10 V

Emission disturbances Conducted & radiated disturbances Class A

Specification Details Value
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Added Features Card Installation

Installation

DANGER
HAZARD OF ELECTRIC SHOCK, EXPLOSION OR ARC FLASH
 Disconnect all power from all equipment including connected devices prior to removing any 

covers or doors, or installing or removing any accessories, hardware, cables, connectors or 
wires except under the specific conditions specified in this user guide.

 Always use a properly rated voltage sensing device to confirm that the power is off.
 Unplug the power cable from both the equipment and the power supply.
 Replace and secure all covers, accessories, hardware, cables, and wires and confirm that a 

proper ground connection exists before applying power to the equipment.
 Use only the specified voltage when operating this equipment and any associated products.
Failure to follow these instructions will result in death or serious injury.

NOTICE
RISK OF DAMAGE TO THE CONNECTOR
Ensure good positioning of the Added Features Card onto the spacers to avoid damage to the 
connector.
Failure to follow these instructions can result in equipment damage.
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Procedure to install the Added Features Card:

Step Action
1 Power off the Base Station ZARB18W•.
2 Wait until the POWER LED becomes OFF (around 20 seconds).
3 Unscrew the 4 screws at the front of the Base Station.
4 Remove the cover.
5 Place the Added Features Card onto the spacers.
6 Screw the 4 M3 mounting screws (Tightening torque = 0.8 Nm (7.08 lb.-in)).

1 Mounting screws
7 Install the Base Station cover.
8 Screw the 4 screws to fasten the Base Station cover.
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Wiring

Section 9.2
Wiring

What Is in This Section?
This section contains the following topics:

Topic Page
Added Features Card Wiring 269
Added Features Card Analog inputs 271
Added Features Card Modbus SL Connector 274
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Added Features Card Wiring

Added Features Card Terminals

1 Modbus SL connector
2 Line termination resistance jumper
3 Modbus activity LEDs
4 Analog inputs terminals
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Wiring Procedure

Step Action
1 Power off the Base Station.
2 Wait until the POWER LED becomes OFF (around 20 seconds).
3 Unscrew the 4 screws at the front of the Base Station ZARB18W•.
4 Remove the cover.
5 When necessary, remove the cap of the Base Station dedicated hole and install a cable gland 

from the kit ZARC06 (see page 41) (Tightening torque = 4±0.2 N.m (35.4±0.2 lb.-in)).

 
6 Introduce the cable through a cable gland.

For the analog inputs wires, use a twisted-pair shielded cable with a ground connection at a 
maximum distance from the Base Station of 0.3 m (0.984 ft).

7 Connect the wires in the dedicated terminals. Use, if necessary, cable ends. For more details, 
refer to Wiring Best Practices (see page 101).

8 Tight the cable gland.
9 Install the Base Station cover.

10 Screw the 4 screws to fasten the Base Station cover.
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Added Features Card Analog inputs

Analog Inputs Connector Overview
The Added Features Card embeds 4 analog inputs on a screw terminal.

1 Physical analog input 1
2 Physical analog input 2
3 Physical analog input 3
4 Physical analog input 4
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Analog Inputs Wiring
Each of the 4 analog inputs can be used as voltage or current analog input depending on the wiring:

1 Physical analog input 1
2 Physical analog input 2
3 Physical analog input 3
4 Physical analog input 4

Current sensor wiring example: Voltage sensor wiring example:
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Electrical characteristics 

Characteristic Description
Voltage analog input range 0…10 Vdc

-10…+10 Vdc
Current analog input range 0…20 mA

4…20 mA
-20…+20 mA

Cable type Twisted-pair shielded
Maximum cable length 30 m (98.42 ft)
Permissible continuous overload on inputs. Voltage 0…10 Vdc: 15 Vdc

Voltage -10…+10 Vdc: -15 Vdc…+15 Vdc
Current 0…20 mA: 30 mA
Current 4…20 mA: 30 mA
Current -20…+20 mA: -30 mA…+30 mA

Input conversion resistor for current inputs. 100 Ω 0.1 % 25 ppm 0.1 W
Analog input resolution 12 bits of value + 1 bit of sign
Absolute accuracy error -25 °C…+70 °C: +/- 1 % of full scale

At 25 °C: +/- 0.2 % of full scale
Absolute accuracy error in EMC perturbation +/- 2.5 % of full scale with 1000-4-3 EMC perturbations 

(with software filter deactivated):
 80 MHz…1 GHz:10 V/m 
 1.4 GHz…6 GHz: 3 V/m

conforming to EN/IEC 61000-4-3
Conversion time 10 ms
Type of filters  Hardware first order embedded filter

 Software filter accessible through the eXLhoist 
configuration software: n*10 ms
 Minimum filtering time: 10 ms (n = 1)
 Maximum filtering time: 10 s (n = 1000)

Input impedance Current input: ≤ 50 Ω
Voltage input: ≥ 1 MΩ

Digital value format ZART8D•, ZART12D• Remote Devices screen: 3 digit in 
decimal.
Analog values are available in Word and Float16 format 
through modbus (see page 286).
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Added Features Card Modbus SL Connector

Modbus SL Connector Overview
The Added Features Card embeds a Modbus serial line removable screw terminal:

1 Data 1
2 Data 0
3 Shield
4 0 V / GND Modbus

Modbus SL Wiring
Daisy chain architecture is possible by connecting 2 wires in each connection point of the terminal, 
using a double cable end.
A built-in line termination resistance can be connected by the mean of a jumper:
By default, the jumper provided is placed onto the 2 upper pins, which activates the line termination 
resistance.
Disconnect the jumper if the Added Features Card is not at the end of the network.

1 Line termination resistance connected. 2 Line termination resistance disconnected.
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Schematic diagram

Protection against interferences:
 Use the Schneider Electric cable with 2 pairs of shielded twisted conductors (reference: 

TSXCSA100, TSXCSA200, and TSXCSA500).
 Keep the Modbus cable separated from the power cables (0.3 m (0.98 ft) minimum).
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Software Configuration

Section 9.3
Software Configuration

What Is in This Section?
This section contains the following topics:

Topic Page
Added Features Card Software Configuration Overview 277
Added Features Card Analog Inputs Configuration 278
Added Features Card Modbus SL Configuration 279
Added Features Card Display Configuration 280
Added Features Card Overload Configuration 282
Added Features Card Device Identity 283
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Added Features Card Software Configuration Overview

Overview
The Added Features Card tabs are accessible if the Added Features Card has been selected in 
the Configure System window while creating a new project.
The system Configuration can be modified in the Project Configuration window (see page 216).
In the Project Configuration tree view, the Added Features Card ZARCFBA01 is down to the Base 
Station of each System.
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Added Features Card Analog Inputs Configuration

Overview
In the I/O tab, you can configure the analog inputs of the Added Features Card:

Configuration
For each ANALOG 0x, the following is available:
 Enable/Disable the analog input in the Enable column.
 Select one of the 4 physical inputs for the desired analog input.

It is not possible to use the same physical input twice.
 Set a customized Label for the analog input (up to 20 digits).
 Select the Type of physical input:
 0-10 V
 0-20 mA
 4-20 mA
 +/-10 V
 +/-20 mA

 A Filter value (x10 ms) can be applied on the physical input value.
NOTE: Physical inputs configured in this tab must be used in the display tab.
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Added Features Card Modbus SL Configuration

Overview
In the Serial Link tab, you can configure the Modbus SL communication channel of the Added 
Features Card:

Configuration
The Modbus Serial Link can be set using the following:
 Baud rate from 1200 to 38400 bps.
 Parity:
 none
 even
 odd

 Stop bits:
 1
 2

 The Modbus address from 1 to 247.
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Added Features Card Display Configuration

Overview
In the Display tab, you can configure the display for the functions related to the Added Features 
Card:
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Configuration
For each of the 2 screens, up to 2 lines can be configured. The following is available:
 Set an alphanumerical prefix (1 digit) and select its display state.
 Select the value to display and select its display state:
 One of the 4 physical inputs value and/or
 a Modbus register value.

An automatic Integer to Float conversion can be selected.
 Set an alphanumerical suffix for the displayed value (up to 4 digits) and select its display state.
 Preset the calibration value (see page 305).
If at least 2 screens are involved in the settings (see page 303):
 The Screen Swap Push Button can be selected.
If at least 1 physical analog input is involved in the settings:
 The Tare function can be activated (see page 308) and the related button can be selected.
The ASCII Display function can be activated (see page 304), and the following settings are 
available:
 the Modbus address from 0 to 255.
 The maximum string length (up to 64 ASCII characters).
 The position of the ASCII display screen during START mode:
 End position.
 First position.
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Added Features Card Overload Configuration

Overview
In the Overload tab, you can configure the overload function for the analog inputs of the Added 
Features Card:

Configuration
For each of the 4 Overload 0x function, the following is available:
 Enable/Disable the overload function in the Used column.
 Select one of the 4 physical inputs for the desired function.

It is not possible to use the same physical input twice.
 Set the Alarm threshold value.
 Enable/Disable the pre-alarm function in the Pre-alarm column.
 Set the Pre-alarm threshold value in percent.
 Set an Hysteresis value in percent.
 Select the Up motion button for the related function.
282 EIO0000001505 09/2018



Added Features Card
Added Features Card Device Identity

Overview
From the Device Identity tab, you can read generic information from the Added Features Card:
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Modbus SL Communication

Section 9.4
Modbus SL Communication

What Is in This Section?
This section contains the following topics:

Topic Page
Added Features Card Modbus SL Communication 285
Modbus Protocol 295
Supported Modbus Functions 296
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Added Features Card Modbus SL Communication

Added Features Card Modbus SL Characteristics

Characteristic Description
Insulation 500 Vac
Line termination resistance Built-in, 150 Ω (0.5 W) / 1 nF

Factory setting: connected 
Modbus device type Slave
Physical layer RS-485
Transmission type Modbus RTU capable
Address range 1…247
Baud rate 4800 bps

9600 bps
19200 bps (factory setting)
38400 bps

LED indicators Yellow LEDs to display the Modbus activity(1)

Connector type 4 points removable screw terminal
Pitch: 5.08 mm (0.19 in.)

(1) Both LEDs are blinking in a proper send/receive communication.
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Read / Write Modbus Mapping Table

Device Address Description Data type Read / Write
Remote Device 0000(h) Analog Display Modbus

ASCII Display Modbus
Vibrator for ASCII Display (Register + 1)

Word R/W

… Word R/W
00FF(h) Word R/W

Remote Device
and
Base Station

0F00(h) Button states 1 (see page 288) Word R

0F01(h) Button states 2 (see page 288) Word R

0F02(h) Base Station states (MSB) & selector 
state (LSB) (see page 289)

Word R

0F03(h) Base Station error code (MSB) & Base 
Station role (LSB) (see page 289)

Word R

0F04(h) DI 1 Base Station (IN0 to IN15) 
(see page 293)

Word R

0F05(h) DI 2 Base Station (IN16 to IN18) 
(see page 294)

Word R

0F06(h) DO 1 (Safety Relays to Relay 14) 
(see page 294)

Word R

0F07(h) DO 2 (Relay 15 to Relay 18) 
(see page 294)

Word R

0F08(h) Reserved Word R

0F09(h) Reserved Word R

0F0A(h) Reserved Word R

… - - R
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Added Features Card 0F30(h) Analog Value 1 Word R

0F31(h) Analog Value 1 Float 16 R

0F32(h) Analog Value 2 Word R

0F33(h) Analog Value 2 Float 16 R

0F34(h) Analog Value 3 Word R

0F35(h) Analog Value 3 Float 16 R

0F36(h) Analog Value 4 Word R

0F37(h) Analog Value 4 Float 16 R

0F38(h) Reserved - -

0F39(h) Reserved - -

0F3A(h) Analog Input 1 Low Float 16 R

0F3B(h) Analog Number 1 Low Float 16 R

0F3C(h) Analog Input 1 High Float 16 R

0F3D(h) Analog Number 1 High Float 16 R

0F3E(h) Analog Input 2 Low Float 16 R

0F3F(h) Analog Number 2 Low Float 16 R

0F40(h) Analog Input 2 High Float 16 R

0F41(h) Analog Number 2 High Float 16 R

0F42(h) Analog Input 3 Low Float 16 R

0F43(h) Analog Number 3 Low Float 16 R

0F44(h) Analog Input 3 High Float 16 R

0F45(h) Analog Number 3 High Float 16 R

0F46(h) Analog Input 4 Low Float 16 R

0F47(h) Analog Number 4 Low Float 16 R

0F48(h) Analog Input 4 High Float 16 R

0F49(h) Analog Number 4 High Float 16 R

0F4A(h) Analog inputs error Word R

Reserved 0F4B(h) Reserved - -

… - -
FFFF(h) - -

Device Address Description Data type Read / Write
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Button states 1 Register 0F00(h)

Button states 2 Register 0F01(h)

Bit Description
Bit 0 Button 1 state Value 0: The button is released.

Value 1: The button is pressed.Bit 1 Button 1H state
Bit 2 Button 2 state
Bit 3 Button 2H state
Bit 4 Button 3 state
Bit 5 Button 3H state
Bit 6 Button 4 state
Bit 7 Button 4H state
Bit 8 Button 5 state
Bit 9 Button 6 state
Bit 10 Button 7 state
Bit 11 Reserved
Bit 12 Reserved
Bit 13 Button 8 state
Bit 14 Button 8 state
Bit 15 Button 9 state

Bit Description
Bit 0 Button 10 state Value 0: The button is released.

Value 1: The button is pressed.Bit 1 Button 11 state
Bit 2 Button 12 state
Bit 3 Button 13 state
Bit 4 Button 14 state
Bit 5 Button 15 state
Bit 6…Bit 15 Reserved -
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Base Station states & selector state Register 0F02(h)

Base Station error code & Base Station role Register 0F03(h)

Base Station role (LSB)

Bit Description
Bit 0 Trolley / Hook 1 Selector. Value 0: No configuration.

Value 1: Trolley / Hook 1 state.
Value 2: Trolley / Hook 2 state.
Value 3: Trolley / Hook 1+2 state.

Bit 1
Bit 2

Bit 3 Bridge Selector. Value 0: No configuration.
Value 1: Bridge 1 state.
Value 2: Bridge 2 state.
Value 3: Bridge 1+2 state.

Bit 4

Bit 5 Unpairing acknowledge. Value 0: No unpairing acknowledgment.
Value 1: Unpairing acknowledgment.

Bit 6 Trolley / Hook 2 Selector. Value 0: No configuration.
Value 1: Trolley / Hook 1 state.
Value 2: Trolley / Hook 2 state.
Value 3: Trolley / Hook 1+2 state.

Bit 7

Bit 8 Base Station state Value 0: Not Used
Value 1: Base Station is in STOP state
Value 2: Base Station is in RUN state
Value 3: Not Used
Value 4: Base Station is in E-STOP state (E-Stop engaged)
Value 5: Base Station is in E-STOP state (E-Stop 
disengaged)
Value 6: Base Station is in INx test failure state
Value 7: Base Station is in SAFE-STOP Failure state

Bit 9
Bit 10

Bit 8…Bit 15 Reserved -

Value(h) Description

0(h) Single
1(h) Primary
2(h) Secondary
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Error code (MSB)

Value(h) Function Description

1(h) - Detected error during the configuration phase of the CC2541, create advertising phase
2(h) E-STOP E-Stop counters detected error
3(h) RAD COM The bit motion diag in the payload from REMOTE is the same with previous frame
4(h) STOP I1 inactive, I2 inactive, stop word null
5(h) I1 inactive, I2 inactive, other values than 0 or stop word not in accordance with (m1_m2) 

index
6(h) i1 inactive, I2 active, other values than 0 or stop word not in accordance with (m1_m2) index
7(h) I1 active, I2 inactive, other values than 0 or stop word not in accordance with (m1_m2) index
8(h) i1 active, i2 active, other values than 0 or stop word not in accordance with (m1_m2) index
9(h) - No response from UC2 (for verifiy UC1 UC2 task)
0A…0F(h) Reserved -
10(h) UC COM The frame received from the another UC contains a length detected error
11(h) The frame received from the another UC contains a CRC8 detected error
12(h) RAD COM The server handle in the HCI event is different with the server handle in the payload from 

REMOTE
13(h) The server handle is different than 0x10, 0x20 or 0x30
14(h) The telegram id received from the another UC is the same between 2 frames
15(h) UC COM The states between UC1 and UC2 are different
16(h) The state received from UC1 is not valid
17(h) EEPROM An error has been detected when reading the configuration file in the EEPROM
18(h) An error has been detected when reading default configuration file primary in the EEPROM 

just written
19(h) An error has been detected when writing the configuration file received from Remote
1A(h) An error has been detected when reading the DS file in the EEPROM
1B(h) An error has been detected when reading the default configuration file secondary in the 

EEPROM just written
1C…1F(h) Reserved -
20(h) CHECK The state of the contact is different with the state of the command of the safety relays
21(h) Reserved -
22(h) CHECK An error has been detected between the UC number read of input and the UC number 

received from another UC
23(h) An error has been detected when testing the power supply
24(h) An error has been detected when testing the output loop-back
25(h) EEPROM The UC state read in the EEPROM is not STOP_STATE or 

E_STOP_STATE_DISENGAGED
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26(h) CHECK An error has been detected when testing the limit switches
27(h) Base ID address detected error between UC1 and UC2
28(h) RAM detected error in the configuration file structure
29(h) - UC2 counter input task detected error
2A(h) - Firmware version detected error
2B(h) - The Base ID is not from 0x0080F4000000 to 0x80F403FFFF
2C(h) - The Vendor ID value is not from 0x0001 to 0xEEEE
2D(h) - The Vendor ID value is not the same between UC1 and UC2
2E…2F(h) Reserved -
30(h) RAD COM An error has been detected in the state button received from REMOTE
31(h) The single CRC computed by UC1 is different from the single CRC received from REMOTE
32(h) The COMM_ID_CRC computed by UC1 is different from the COMM_ID_CRC received from 

REMOTE
33(h) The type HCI event received from CC2541 in the event frame is not 0x04
34(h) The event code received from CC2541 in the event frame is not 0xFF
35(h) The opcode of the event received from CC2541 in the event frame is unknown
36(h) UC COM The number of bytes received from UC2 is not correct
37(h) INPUT An error has been detected when reading the PCB version
38(h) An error has been detected when reading the PCB version
39(h) RAD COM The MBC_CRC computed by UC1 is different from the MBC_CRC received from the other 

BASE
3A(h) - A detected error from UC1 is received
3B(h) - A detected error from UC2 is received
3C…3F(h) Reserved -
40(h) SAFETY ESM detected error
41(h) CRC flash detected error
42(h) Parameter flash detected error CRC
43…4F(h) Reserved -

Value(h) Function Description
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50(h) SAFETY Counter task error: task UC1 communication with UC2
51(h) Counter task error: task UC1 check
52(h) Counter task error: task UC1 RAD receive
53(h) Counter task error: task UC1 safety
54(h) Counter task error: task UC1 RAD send
55(h) Counter task error: task UC1 output
56(h) Counter task error: task UC2 input
57(h) Counter task error: task UC2 receive from UC2
58(h) Counter task error: task UC2 send to UC1
59(h) Counter task error: task UC2 check
5A(h) Counter task error: task UC2 safety
5B(h) Counter task error: task UC2 RAD sniff
5C(h) Counter task error: task UC1 data storage
5D(h) Counter task error: task UC1 input
5E(h) Counter task error: task UC1 Modbus
5F(h) Counter task error: task UC1 page display
60(h) - UC number detected error
61(h) - Hardware detected error
62…69(h) Reserved -
6A(h) SAFETY Counter task error: task UC1 send IOT data
6B…6F(h) Reserved -
70(h) - SRDY line detected error
71(h) - Send_Byte_SPI1: error of flag spiREG1.BUF (wait for the end of sending SPI1)
72(h) - Send_Frame_To_CC2541: error of flag spiREG1.FLG (wait for the end of sending SPI1)
73(h) - Read_Byte_SPI1: error of flag spiREG1.FLG (wait for the end of receiving SPI1)
74…7F(h) Reserved -
80(h) MBC Lifesign detected error
81…CF(h) Reserved -

Value(h) Function Description
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DI 1 Base Station (IN0 to IN15) Register 0F04(h)

D0(h) SAFERTOS Detected error safertos for UC1: RAD receive task
D1(h) Detected error safertos for UC1: RAD send task
D2(h) Detected error safertos for UC1: communication with UC2 task
D3(h) Detected error safertos for UC1: initialization task
D4(h) Detected error safertos for UC1: link establish task
D5(h) Detected error safertos for UC1: output task
D6(h) Detected error safertos for UC1: verify UC2 task
D7(h) Detected error safertos for UC2: RAD sniff task
D8(h) Detected error safertos for UC2: input task
D9(h) Detected error safertos for UC2: receive from UC1 task
DA(h) Detected error safertos for UC2: send to UC1 task
DB(h) Detected error safertos for check task
DC(h) Detected error safertos for safety task
DD(h) Detected error safertos for safe stop failure task
DE(h) Detected error safertos for IT SPI2
DF(h) Detected error safertos for IT SRDY line
E0(h) Detected error safertos for UC1: data storage task
E1(h) Detected error safertos for UC1: Modbus task (option card)
E2(h) Detected error safertos for UC1: input task (option card)
E3(h) Detected error safertos for UC1: page display task
E4(h) Detected error safertos for UC1: send data IOT task
E5…FF(h) Reserved -

Value(h) Function Description

Bit Description
Bit 0 Digital input 1 Value 0: The digital input is at inactive state.

Value 1: The digital input is at active state.… …
Bit 15 Digital input 16
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DI 2 Base Station (IN16 to IN18) Register 0F05(h)

DO 1 (Safety relays to Relay 14) Register 0F06(h)

DO 2 (Relay 15 to Relay 18) Register 0F07(h)

Analog Inputs Error Register 0F4A(h)

Bit Description
Bit 0 Digital input 17 Value 0: The digital input is at inactive state.

Value 1: The digital input is at active state.Bit 1 Digital input 18
Bit 2…Bit 15 Reserved -

Bit Description
Bit 0 Safety relay 19 Value 0: The digital output is at inactive state.

Value 1: The digital output is at active state.Bit 1 Safety relay 20
Bit 2 Digital output 1
… …
Bit 15 Digital output 14

Bit Description
Bit 0 Digital output 15 Value 0: The digital output is at inactive state.

Value 1: The digital output is at active state.Bit 1 Digital output 16
Bit 2 Digital output 17
Bit 3 Digital output 18
Bit 4…Bit 15 Reserved -

Bit Description
Bit 0 Analog input 1 Value 0: No error detected.

Value 1: An error has been detected. The input data is 
considered as not reliable.

Bit 1 Analog input 2
Bit 2 Analog input 3
Bit 3 Analog input 4
Bit 4…Bit 15 Reserved -
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Modbus Protocol

Introduction
The transmission mode used is RTU. The frame does not contain message header and end of 
message bytes.

The data is transmitted in binary code.
CRC16: cyclical redundancy check.
The end of the frame is detected on a silence greater than or equal to three characters.

Principle
Only one device can transmit on the line at any time.
The master manages the exchanges and only it can take the initiative.
It interrogates each of the slaves in succession
No slave can send a message unless it is invited to do so.
The master repeats the question when there is an incorrect exchange, and declares the 
interrogated slave unavailable if no response is received within a given time period.
If a slave does not understand a message, it sends an exception response to the master. The 
master may or may not repeat the request.
Direct slave-to-slave communications are not possible.
For slave-to-slave communication, the application software must therefore be designed to 
interrogate a slave and send back data received to the other slave.
The 2 types of dialogue are possible between master and slaves:
 The master sends a request to a slave and waits for its response
 The master sends a request to all slaves without waiting for a response (broadcasting principle)

Addresses
Address specification:
 The device Modbus address can be configured from 1 to 247.
 Address 0 coded in a request sent by the master is reserved for broadcasting. Slave devices 

take account of the request, but do not respond to it.

Slave address Request code Data CRC16
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Supported Modbus Functions

Introduction
The device supports the following Modbus functions:

Read Holding Registers
This function can be used to read all words of the device, both input words and output words.
Request

Response

Request frame

Function Name Code Description Remarks
Dec. Hex

Read Holding 
Registers

03 03h Read N output words Maximum PDU length: 63 words

Write Multiple 
Registers

16 10h Write N output word Maximum PDU length: 61 words

(Subfunction) 
Read Device 
Identification

43/14 2Bh/0Eh Encapsulated interface 
transport/Read device 
identification

−

Function code 1 byte 03h

Starting address 2 bytes 0000h...FFFFh

Quantity of registers 2 bytes 1...63 (3Fh)

Function code 1 byte 03h

Byte count 1 byte 2 x N(1)

Register value N(1) x 2 bytes −

(1) N: Quantity of registers

Slave no. 03h No. of first word No. of words CRC16
Hi Lo Hi Lo Lo Hi

1 byte 1 byte 2 bytes 2 bytes 2 bytes
Hi = high-order byte, Lo = low-order byte.
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Response frame

Detected error

Exception code values meaning:
 02h: Starting address is not correct.
 03h: Quantity of registers ≥7Dh.

Write Multiple Register
This function can be used to write all input words of the device.
Request

Response

Request frame

Slave no. 03h Number of bytes read First word value Last word value CRC16
Hi Lo Hi Lo Lo Hi

1 byte 1 byte 1 byte 2 bytes 2 bytes 2 bytes
Hi = high-order byte, Lo = low-order byte.

Detected error code 1 byte 83h

Exception code 1 byte 02h...03h

Function code 1 byte 10h

Starting address 2 bytes 0000h...00FFh

Quantity of registers 2 bytes 1...63 (3Fh)

Function code 1 byte 10h

Byte count 1 byte 2 x N(1)

Register value N(1) x 2 bytes −

(1) N: Quantity of registers

Slave no. 10h No. of first word Number of words Number of 
bytes

Value of first word CRC16
Hi Lo Hi Lo Hi Lo Lo Hi

1 byte 1 byte 2 bytes 2 bytes 1 byte 2 bytes 2 bytes
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Response frame

Detected error

Exception code values meaning:
 02h: Starting address is not correct.
 03h:
 Quantity of registers ≥7Bh.
 Byte count ≠ Register value (2 x Quantity of registers).

Read Device Identification
The table provides the device identification details:

Slave no. 10h No. of first word No. of words CRC16
Hi Lo Hi Lo Lo Hi

1 byte 1 byte 2 bytes 2 bytes 2 bytes

Detected error code 1 byte 83h

Exception code 1 byte 02...03h

Category ID Name / Description Type Length
Basic
Read Device Id 
01h…03h

00h VendorName ASCII String 1Dh

01h ProductCode ASCII String 01h

02h MajorMinorRevision ASCII String 07h

Regular
Read Device Id 
02h…03h

03h Vendor URL ASCII String 021h

04h Product Name ASCII String 08h

05h Model Name ASCII String 07h

Extended
Read Device Id 03h

80h Base BLE ID ASCII String 0Ch

84h Detail Base Firmware Version Byte 06h

87h Vendor ID of Base Device Byte 02h

88h SupportedActivationKeybyBaseDevice Byte 02h
298 EIO0000001505 09/2018



Added Features Card
Example transaction for a basic read device identification:
Request frame

Response frame

Content of the objects:
Vendor name

Product Code

MajorMinorRevision

Slave no. 2Bh Type of MEI
0Eh

Read Device Id
01h

Object Id
00h

CRC16
Lo Hi

1 byte 1 byte 1 byte 1 byte 1 byte 2 bytes

Slave no. 2Bh Type of MEI
0Eh

Read Device Id
01h

Degree of conformity
02h

1 byte 1 byte 1 byte 1 byte 1 byte

Number of additional frames
00h

Next object Id
00h

Number of objects
03h

1 byte 1 byte 1 byte

Id of object
00h

Length of object
12h

Value of object
“Schneider Electric”

1 byte 1 byte 18 bytes

Id of object
01h

Length of object
1Dh

Value of object
ZARB18W: “3606480610370”

1 byte 1 byte 29 bytes

Id of object
02h

Length of object
07h

Value of object
“xxx.yyy”

1 byte 1 byte 7 bytes
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Vendor URL

Product Name

Model Name

Base BLE ID

Detail Base Firmware version

Vendor ID of Base Device

Supported Activation Key by Base Device

Id of object
03h

Length of object
21h

Value of object
“http://www.schneider-electric.com”

1 byte 1 byte 33 bytes

Id of object
04h

Length of object
08h

Value of object
“eXLhoist”

1 byte 1 byte 8 bytes

Id of object
05h

Length of object
07h

Value of object
“ZARB18W”

1 byte 1 byte 7 bytes

Id of object
80h

Length of object
0Ch

Value of object
xxxxxxxxxxxx

1 byte 1 byte 12 bytes

Id of object
84h

Length of object
06h

Value of object
XXh.YYh.ZZZZh.TTTTh

1 byte 1 byte 6 bytes

Id of object
87h

Length of object
02h

Value of object
LSBh.MSBh

1 byte 1 byte 2 bytes

Id of object
88h

Length of object
02h

Value of object
Byte2h.Byte1h

1 byte 1 byte 2 bytes
300 EIO0000001505 09/2018



Added Features Card
Detected error

Exception code values meaning:
 01h:
 Function code not supported.
 Type of MEI not supported.

 02h: Object Id not supported.
 03h: Read Device Id Id not supported.

Detected error code 1 byte 83h

Exception code 1 byte 01...03h
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Section 9.5
Added Features Card Operation

What Is in This Section?
This section contains the following topics:

Topic Page
Added Features Card Page Management 303
Added Features Card ASCII Display 304
Added Features Card Calibration 305
Added Features Card Overload 307
Added Features Card Tare 308
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Added Features Card Page Management

Page Management
The Remote Device can display up to 3 pages:
 2 pages with 2 Analog values display
 1 page with ASCII Display
Page swap push button is needed to change the page displayed in START mode. For more 
information on the Page swap configuration, refer to Display configuration (see page 280).
This allows the operator to have a feedback from the machine through:
 Analog inputs data.
 Plain text messages dynamically updated by the PLC.
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Added Features Card ASCII Display

Overview
This screen displays information read from the PLC as ASCII characters.
This screen is present in diagnostic mode or in START mode, depending on the configuration on 
eXLhoist Configuration Software.
In START mode, this screen can be set as first or end position.
This screen contains 4 line of 16 ASCII characters.
The Modbus frame must contain the following:
 Start byte: 02h
 32 words for 64 ASCII characters in hexadecimal
 Stop byte: 03h

In eXLhoist Configuration Software, it is necessary to configure:
 The start address Modbus implemented on the PLC
 The maximum number of characters (40h for 64 characters)

For more information, refer to Display configuration (see page 280).

ASCII Display
This plain text area allows to use the screen of the Remote Device as a remote display for the 
operator.
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Calibration
The calibration of the analog inputs must be realized during commissioning phase.
Procedure example to calibrate Analog 01 input for weight measurement:

Step Action
1 Fill calibration parameters on eXLhoist Configuration Software in order to pre-set the values.

For more information, refer to Display configuration (see page 280).
2 Place a light weight (0.5 tons for example).
3 Press buttons 1H+2H then 3H+4H.

Result: The Remote Device enter the diagnostic mode (see page 174).
4 Press button 7 (trigger).

Result: The Calibration menu is selected.
5 Enter the password if required.
6 Press button 7 (trigger).

Result: Analog 01 is the first analog input.
7 Select MIN and press button 7 (trigger).

Result: MIN is selected.
8 Increase or decrease value from the pre-set value with buttons 5 and 6 to get close to the correct 

weight.
9 Press button 7 (trigger).

Result: Remote Device powers off.
10 Power on the Remote Device.

Result: Automatic Configuration File transfer is displayed.
11 Power cycle the Remote Device.
12 Place a heavy weight (10 tons for example).
13 Press buttons 1H+2H then 3H+4H.

Result: The Remote Device enter the diagnostic mode (see page 174).
14 Press button 7 (trigger).

Result: The Calibration menu is selected.
15 Enter the password if required.
16 Press button 7 (trigger).

Result: Analog 01 is the first analog input.
17 Select MAX and press button 7 (trigger).

Result: MAX is selected.
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Repeat the procedure for the other analog inputs.

18 Increase or decrease value from the pre-set value with buttons 5 and 6 to get close to the correct 
weight.

19 Press button 7 (trigger).
Result: Remote Device powers off.

20 Power on the Remote Device.
Result: Automatic Configuration File transfer is displayed.

21 Power cycle the Remote Device.
Result: Analog 01 is calibrated.

Step Action
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Added Features Card Overload

Overload
The overload function is configured with eXLhoist Configuration Software (see page 282).
Up to 4 overloads can be configured (1 for each analog input).
The following parameters must be configured:
 Alarm threshold
 Pre-alarm enable/disable
 % of the alarm threshold for the Pre-alarm
 Hysteresis (%)
 Button motion up (Motion up is not allowed during the overload)
There are 2 Overload relays:
 1 Alarm
 1 Pre-alarm
NOTE: There are 2 signalizations on the Remote Device for Alarm and Pre-alarm working in the 
same way as Overload with Base Station input.In Single mode, Overload function and Overload 
with Base Station input are complementary.
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Tare
Tare push button must be configured to set a tare on 1 analog input value. To configure the button 
associated to the function in eXLhoist Configuration Software, refer to Display configuration 
(see page 280).
Procedure to execute the tare function:

Step Action
1 Press the Tare push button.

Result: The Remote Device enter the tare mode
2 Press the button corresponding to the analog input to select.

Result: The selected analog input line is blinking.
3 Press the Tare push button more than 1 s.

Result: The tare function is validated.
4 Press return button to finish the tare process.
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Chapter 10
Data Storage

What Is in This Chapter?
This chapter contains the following topics:

Topic Page
Data Storage Overview 310
Data Storage Configuration 313
Data Storage Recovery 315
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Data Storage Overview

Overview
Data Storage function allows to store in the Base Station cumulative operation hours and number 
of operations of the:
 Motions and auxiliary buttons
 Alarm inputs
The Data Storage function generates 2 kinds of data:
 Non-settable and non-resettable data,
 Settable and resettable data. Thresholds can be assign to theses settable and resettable data. 

If stored data overpasses the threshold value, the maintenance relay is permanently activated.

Principle
Depending on the Base Station type, up to 8 axis and 6 inputs can be assigned for the data storage.
Each axis can be assign to 1 or 2 buttons and 1 auxiliary selector.
If 2 buttons are assigned to an axis (for example forward and reverse), the Base Station stores for 
this axis:
 Cumulative operation hours
 Number of operations(1)

 Number of pulsating(2) operations
 Number of backtracking(3) operations
If one button is assigned to an axis, the Base Station stores for this axis:
 Cumulative operation hours
 Number of operations(1)

 Number of pulsating(2) operations
(1) Number of operations: 
The number of operations is the number of an axis direction command (for example, the number 
of hoist operations of up and down movement activated). Each forward and each reverse 
command increases the count by one.
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(2) Pulsating:
If the same direction movement command (forward or reverse) is given within a period TPulsating in 
seconds, a pulsating event is recorded and a count is incremented by one.
A pulsating incident is defined as followed:
 A falling edge on a forward command followed by a rising edge of a forward command within a 

configurable time in seconds (TPulsating).
 A falling edge on a reverse command followed by a rising edge of a reverse command within a 

configurable time in seconds (TPulsating).

Schneider Electric recommends using TPulsating = 2 s but TPulsating is configurable from 0.1 s to 5 s 
with a step = 0.1 s.
(3) Backtracking: 
If different direction movement commands (forward and reverse) are given within a period 
TBacktracking in seconds, a backtracking event is recorded and a count is incremented by one. If 
both forward and reverse movement commands are received simultaneously, no backtracking 
operation is recorded.
A backtracking incident is defined as followed:
 A falling edge on a forward command followed by a rising edge of a reverse command within a 

configurable time in second (TBacktracking).
 A falling edge on a reverse command followed by a rising edge of a forward command a 

configurable time in second (TBacktracking).

Schneider Electric recommends using TBacktracking = 2 s but TBacktracking can be configurable 
between 0.1 s and 5 s with a step of 0.1 s.
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Maintenance Relay
A Maintenance relay can be configured on the Base Station among the existing relays.
If Settable and resettable data overpasses the threshold value, the maintenance relay is 
permanently activated.
The maintenance relay is deactivated only after a reset of the corresponding Settable and 
resettable data is performed through the eXLhoist Data Storage Recovery Software.
The maintenance relay can be connected to a beacon on the machine or to a centralized 
maintenance HMI or monitoring.
The maintenance relay can be connected to the generic input alarm of the Base Station in order to 
inform the operator through the Remote Device ZART•D•.

System Component
With eXLhoist Configuration Software, you can configure Axis assignments, thresholds, and 
maintenance relay assignment.
With eXLhoist Data Storage Recovery Software, the maintenance operator can:
 Download the data stored in the Base Station. The Remote Device is the gateway between the 

Base Station and eXLhoist Data Storage Recovery Software.
 Set / Reset counters in the Base Station.
 Save in a CSV file the data stored in the Base Station.
The Data storage access is protected by a password. This password allows reading, setting, 
downloading, and resetting Data Storage data.
The Data Storage functionality requires the eXLhoist Data Storage Recovery Software use. For 
further details, consult your Regional Schneider Electric Sales Office.
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Data Storage Configuration

Configuration Modification
The following procedure describes how to create and modify the system configuration

Step Action
1 Connect the Remote Device to a PC (see page 192).
2 Start the eXLhoist Configuration Software (see page 204).
3 Create or open a project (see page 205).
4 Unlock Data Storage Parameters (see page 314).
5 Modify the configuration of the data storage parameters:

 Configure a maintenance Relay (see page 230)
 Configure Data Storage Axis Parameters (see page 240)
 Configure Data Storage Special Functions Threshold (see page 243)
 Configure Data Storage Alarm Input Assignments (see page 239)

6 Save the project (see page 213).
7 Select Communication → Store to device(1).
8 If enabled, enter the transfer password of the Configuration File already stored in the Remote 

Device.
9 Wait for the end of the Configuration File load in the Remote Device.
10 Disconnect the Remote Device to the PC.
11 Power ON the Base Station.

NOTE: The following steps of the procedure must end in 5 minutes maximum.

12 The Configuration File must be loaded from the Remote Device to the Base Station.
Refer to:
 Configuration File load With a ZART8L• (see page 162).
 Configuration File load With a ZART•D• (see page 163).
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Unlock Data Storage Parameters
When you create a new project, all Data Storage parameters are locked by a Data Storage 
Password.
The Data Storage Password is asked:
 By eXLhoist Configuration Software when you create or modify a configuration with Data 

Storage parameters.
 By eXLhoist Data Storage Recovery Software when you load data stored in Base Station.
The following procedure describes how to create the Data Storage password:

When a Data Storage password is configured, you can unlock Data Storage access:

Configure a Maintenance Relay
In Relay assignment tab (see page 230), you can configure the Maintenance Relay associate to 
Data Storage Functions.
When one or more Data monitored exceed corresponding threshold configured by eXLhoist 
Configuration Software, Maintenance Relay is ON.
When the user resets data monitored or changes corresponding threshold to a value upper than 
measured value, Maintenance Relay is OFF.

Step Action
1 Click Device → Data Storage Password → Create Password to create a Data Storage 

password.
2 Enter and confirm a Data Storage password.
3 Click OK.

Step Action
1 Click Device → Data Storage Access.
2 Enter the Data Storage password.
3 Click OK.

Result: you have access to:
 The threshold assignment of the Detected applicative alarm (see page 238)
 The Data Storage tab (see page 240)
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Data Storage Recovery

General Recovery Procedure
The following procedure describes how to recovery and/or modify the data stored in the Base 
Station:

Step Action
1 Power ON Base Station.
2 Connect the Remote Device to a PC (see page 192).
3 Start the eXLhoist Data Storage Recovery Software.
4 Click Data Storage recovery:
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5 Select Base Station to recover data and click Next button:

This operation can take several minutes.
6 If asked, enter the Data Storage Password then click Next button.

If you loose your Data Storage Password, contact Schneider Electric customer service.
7 Then you can:

 Click Save Data Storage to save the data stored (see page 317)
 Click Set / Reset data to modify the data stored (see page 318)

Step Action
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Save Data Stored in the Base Station
The following procedure describes how to save data stored in the Base Station:

Step Action
1 Unroll steps 1…7 of the general recovery procedure (see page 315).
2 Click Save data Storage.
3 Click Browse to select the directory where you want to save Data Storage File in CSV format:

4 Click Save to save file.
5 When data are stored, a popup appears. Click OK.
6 Click View File to open file in a spreadsheet application (for example: Microsoft® Excel).
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Set or Reset Data Stored in the Base Station
The following procedure describes how to change data stored in the Base Station:

Step Action
1 Unroll steps 1…7 of the general recovery procedure (see page 315).

Or
Click Previous in last step of Save data stored in the Base Station procedure.

2 Click Set / Reset data to update value in Base Station.
3 A popup informs you. Click OK if you agree.
4 A window appears where you can show data read and change data in Base Station:

5 Select checkbox to reset the selected value.
Select grouped checkboxes to reset many values at same time.

6 Enter desired value on corresponding Set Value columns.
7 Click Send to Base Station button to update data stored in Base Station.
318 EIO0000001505 09/2018



Harmony eXLhoist
Troubleshooting
EIO0000001505 09/2018
Troubleshooting

Chapter 11
Troubleshooting

Troubleshooting

Troubleshooting

Diagnostic Possible cause Solution
Configuration File download issue
When you want to download the Configuration 
File from/into the Remote Device, a dialog box 
displays the following message:
Configuration File version not supported by 
Configuration software.

The Configuration File of 
a Remote Device which 
firmware version ≥ v4.0 
cannot be downloaded 
with a eXLhoist 
Configuration Software 
version≤ v3.0.

Use a eXLhoist Configuration Software 
which version ≥ v4.0.

The Configuration File of 
a Remote Device which 
firmware version = v3.0 
cannot be downloaded 
with a eXLhoist 
Configuration Software 
version≤ v2.0.

Either use a eXLhoist Configuration 
Software which version = v3.0
or update the Remote Device firmware 
to version v4.0 and use a eXLhoist 
Configuration Software which version 
≥ v4.0.

The Remote Device cannot be paired to the Base 
Station.

The pairing can be 
blocked by the “restricting 
pairing” function.
The “restricting pairing” 
happens 5 minutes after 
the Base Station power 
ON and forbid the pairing 
with a new Remote 
Device.

Power OFF the Remote Device.
Power OFF the Base Station until the 
POWER LED is OFF.
Power ON the Base Station.
Power ON the Remote Device: the 
Remote Device shall be paired to the 
Base Station before 5 minutes.

Base Station
POWER LED COM LED STATUS LED
ON Blinking ON
Remote Device
ZART• E-STOP LED Blinking 
ZART8L Start LED OFF
ZART•D•
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The E-STOP is not available.
It is not possible to go to START mode.

IN0 feedback loop wiring 
issue

Check that the IN0 input is correctly:
 Connected to S2_S3 for E-STOP 

SIL2.
 Connected to S2_3 through the 

main contactor auxiliary contact for 
SIL3.

Base Station
POWER LED COM LED STATUS LED
ON Blinking ON
Remote Device
ZART• E-STOP LED OFF
ZART8L Start LED OFF
ZART•D•

Unintended Motion detection issue
Pre-requisite: 
 Base Station firmware version V3.x.
 Unintended motion detection activated in the 

configuration.

Incorrect wiring Check the electrical contacts of each 
relay and contactors.

Base Station
POWER LED COM LED STATUS LED
ON Blinking ON
Remote Device
ZART• E-STOP LED OFF
ZART8L Start LED OFF
ZART•D•

The main contactor does not switch OFF in case 
of E-STOP triggering

Incorrect safety relay 
wiring

Perform a correct wiring between the 
Base Station safety relays contacts 
and the main contactor coil.Base Station

POWER LED COM LED STATUS LED
ON Blinking OFF
Remote Device
ZART• E-STOP LED ON
ZART8L Start LED ON
ZART•D• Not Applicable

Diagnostic Possible cause Solution
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eXLhoist STOP or fallback
Sometimes the Remote Device switches to STOP 
mode.
Or
Sometimes the eXLhoist system stop working 
and restarts.

Wrong alarm inputs 
biasing involving eXLhoist 
STOP or fallback

Use a relay or an optocoupler to isolate 
the signal.

Base Station
POWER LED COM LED STATUS LED
ON OFF OFF Voltage dips involving 

eXLhoist STOP or 
fallback

Check the electrical network wiring, 
especially the main contactor wiring.
If no mistakes are detected, then 
connect the Base Station power supply 
to 230 Vac.
If power supply voltage cannot be 
changed, contact your Schneider 
Electric customer support.

Remote Device
ZART• E-STOP LED OFF
ZART8L Start LED OFF
ZART•D• Not Applicable

Remote Device powers OFF often
The ZART8L• powers OFF often (ex: once per 
hour).
Or 
If the START button is pressed, then the ZART•D• 
powers OFF. 

Remote Device battery 
gauge calibration issue

Connect the Remote Device to the 
ZARC01 power supply and charge the 
Remote Device battery for 10 hours 
10…40 °C (50…104 °F).

NOTE: The Remote Device should be 
charged for 10 hours every month. It 
allows getting the right battery gauge 
calibration.

Base Station
POWER LED COM LED STATUS LED
ON OFF ON
Remote Device
ZART• E-STOP LED OFF
ZART8L Start LED OFF
ZART•D• OFF

Diagnostic Possible cause Solution
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Remote Device battery does not charge The Remote Device 
battery is or has been 
charged under 10 °C 
(50 °F).

Charge the Remote Device battery at a 
temperature 10…40 °C (50…104 °F).
If it does not work, contact your 
Schneider Electric customer support.

Base Station
POWER LED COM LED STATUS LED
- - -
Remote Device
ZART• E-STOP LED OFF
ZART8L Batt LED Blinking
ZART•D•

It is no more possible to use the Base Station 
which is non-operational

Base Station firmware 
issue

If an OEM or maintenance person has 
updated the firmware 
Then:
Power ON/Power OFF the Base 
Station five times in less of 1 minute 
until the STATUS LED is fixed.

NOTE: Wait the POWER LED 
switching OFF. 
If it does not work, then use the 
eXLhoist Configuration Software to 
launch the Base Station firmware 
update one more time.
If it does not work, contact the 
Schneider Electric customer support.

Base Station
POWER LED COM LED STATUS LED
ON OFF Blinking
Remote Device
ZART• E-STOP LED OFF after 3 

blinking
ZART8L Start LED OFF
ZART•D• OFF

The Remote Device Powers OFF often
(from once a week to several times a day)

Accelerometer issue Use a Remote Device which firmware 
version ≥ v3.0, then use the eXLhoist 
Configuration Software and configure 
the Remote Fall and Shock detection 
as disabled.

Base Station
POWER LED COM LED STATUS LED
ON OFF ON
Remote Device
ZART• E-STOP LED OFF
ZART8L Start LED OFF
ZART•D• OFF

Diagnostic Possible cause Solution
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The eXLhoist radio range is too high - Use a Base Station which firmware 
version ≥ v3.0, then use the eXLhoist 
Configuration Software and configure 
the Primary Base radio level and/or the 
Remote radio level to Reduced.

Base Station
POWER LED COM LED STATUS LED
ON Blinking ON
Remote Device
ZART• E-STOP LED ON
ZART8L Start LED ON
ZART•D• ON
The Horn duration time of 1 second is too long - Reduce the Horn duration between 

0.1 s and 1 s through an external 
modular relay RE17RMMW.
If you use a Base Station which 
firmware version ≥ v3.0, you can use 
the eXLhoist Configuration Software 
(version ≥ v3.0) and configure the 
Horn duration to 0 s.

Base Station
POWER LED COM LED STATUS LED
ON Blinking ON
Remote Device
ZART• E-STOP LED ON
ZART8L Start LED ON
ZART•D• ON

Diagnostic Possible cause Solution
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Appendix A
Architecture Examples

What Is in This Chapter?
This chapter contains the following topics:

Topic Page
Tested Architectures 328
Vacuum/Magnetic Application Example 334
Safeguarding Wiring Examples 336
Room Lighting Application Example 339
Validation Button Wiring Examples 340
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Tested Architectures

Overview
Schneider Electric provides the basis of tested architecture. You can adapt these architectures to 
your individual requirements. The specified architectures have been tested under actual service 
conditions. Your specific application requirements may be different from those assumed for these 
projects. In that case, you have to adapt the architecture to your particular needs. To do so, you 
need to consult the specific product documentation that you may find necessary to modify or adapt. 
Pay particular attention and conform to any safety information, different electrical requirements, 
and normative standards that would apply to your modifications and/or adaptations. Some or all of 
the architectures may contain recommendations of products that are not available in your country 
or location, or may imply or recommend wiring, products, procedures, or controller logic and/or 
functions that are in conflict with your local, regional, or national electrical or safety codes and/or 
normative standards. 

The use and application of the architectures require expertise in the design of control systems. 
Only you, the designer or integrator, can be aware of all the conditions and factors present during 
installation and setup, operation, and maintenance of the machine or process, and can therefore 
determine the associated equipment, the functions, the related safety provisions and interlocks 
which can be effectively and properly used. When selecting control equipment, and any other 
related equipment or software for a particular application, you must also consider any applicable 
local, regional, or national standards and/or regulations. 

WARNING
REGULATORY INCOMPATIBILITY
Be sure that all equipment applied and systems designed comply with and conform to all 
applicable local, regional, and national regulations and standards. 
Failure to follow these instructions can result in death, serious injury, or equipment damage.
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Description
Schneider Electric has tested some possible architectures:

Stop category depends on the UOC function/wiring (see page 114).
E-STOP and STOP SIL level depends on the IN0 and S2_S3 wiring (see page 121).

Safety Case 1

The E-STOP function of the Remote Device is SIL2. 

Architectures Hoisting Trolley Translation E-STOP
STOP

 Motion Stop 
category

According To
EN 61508
EN 13849

EN 61508
EN 13849

EN 60204

Safety case 1 (see page 329)
Contactor

Contactor Contactor SIL2/Cat 3

SIL1/Cat 2
Cat 0Safety case 2 (see page 330)

Safety case 3 (see page 331)
ATV32 ATV32

SIL3/Cat 4
Safety case 4 (see page 332)

ATV71
SIL3/Cat 4

Cat 1
Safety case 5 (see page 333) SIL3/Cat 4
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Safety Case 2

The E-STOP function of the Remote Device is SIL2.
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Safety Case 3

The E-STOP function of the Remote Device is SIL3.
Drive1 and Drive2 are motor drives. 
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Safety Case 4

The E-STOP function of the Remote Device is SIL3.
Drive1, Drive2, and Drive3 are motor drives. 
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Safety Case 5

The E-STOP function of the Remote Device is SIL3.
Drive1, Drive2, and Drive3 are motor drives. 
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Vacuum/Magnetic Application Example 

Description
A possible use of auxiliary buttons is a Vacuum/Magnetic function.

Configuration
Example of system configuration

As already done in the factory setting, it is recommended to use buttons at different sides of 
Remote Device for load release function (operator uses both hands).

Vacuum/Magnetic Description
Triggering “Vacuum/Magnetic ON“ button is assigned to 1 relay.

When the operator presses the “Vacuum/Magnetic ON” button, the magnetic is 
activated through the associated relay.

Releasing To release the load, simultaneously press ”Vacuum/Magnetic OFF 1” and 
“Vacuum/Magnetic OFF 2” buttons.
“Vacuum/Magnetic OFF 1” button should be assigned to 1 NO+NC relay.
“Vacuum/Magnetic OFF 2” button should be assigned to 1 different NO+NC relay. 

Topic Configured button Associated relay
Vacuum/Magnetic ON 13 Q16

Vacuum/Magnetic OFF 1 14 Q17
Vacuum/Magnetic OFF 1 15 Q18
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Safeguarding Wiring Examples

Overview
eXLhoist can manage 2 types of safeguarding protection:
 Limit Switch: drive control of the motion.
 Motion Feedback: contactor solution for the motion.

Limit Switch Example with an ATV71
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Motion Feedback Example with NO Auxiliary Contact with 3 Wires Command

Motion Feedback Example with NC Auxiliary Contact with 3 Wires Command
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Motion Feedback Example with NC Auxiliary Contact with 4 Wires Command
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Room Lighting Application Example

Description
It is possible to manage room lighting applications. An auxiliary button commands an impulse relay 
on the room lighting circuit.

Configuration
There is no specific configuration needed. You have to associate an auxiliary button to a relay.

Wiring Example

NOTE: Schneider Electric offers modular impulse relays which are bistable switches designed to 
control load power mainly for lighting applications.
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Validation Button Wiring Examples

Overview
The button 7 can be configured as standalone. In this configuration, you can use it as a validation 
button.

Button 7 Standalone as Validation Button Example
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A
AWG

(American wire gauge) The standard that specifies wire section sizes in North America 

C
CCF

(Common Cause of Failure)

CSA
(Canadian standards association) The Canadian standard for industrial electronic equipment in 
hazardous environments.

CSV
(comma-separated values) A CSV file stores tabular data (numbers and text) in plain text. Each 
line of the file is a data record. Each record consists of one or more fields, separated by commas.

D
DTM

(Device Type Manager) Classified into 2 categories:
 Device DTMs connect to the field device configuration components.
 CommDTMs connect to the software communication components.
The DTM provides a unified structure for accessing device parameters and configuring, operating, 
and diagnosing the devices. DTMs can range from a simple graphical user interface for setting 
device parameters to a highly sophisticated application capable of performing complex real-time 
calculations for diagnosis and maintenance purposes.

E
E-STOP

Emergency stop (according to EN ISO13850:2008) function that is intended to:
 Avert arising, or reduce existing, hazards to persons, damage to machinery or to work in 

progress,
 Be initiated by a single human action.

EMC
ElectroMagnetic Compatibility 
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EN
EN identifies 1 of many European standards maintained by CEN (European Committee for 
Standardization), CENELEC (European Committee for Electrotechnical Standardization), or ETSI 
(European Telecommunications Standards Institute).

F
Firmware

The operating system (OS) of a device 

H
HFT

(Hardware Fault Tolerance)

I
ID

IDentification.

IEC
(International Electrotechnical Commission) A non-profit and non-governmental international 
standards organization that prepares and publishes international standards for electrical, 
electronic, and related technologies.

IP
(Ingress Protection) The protection classification according to IEC 60529.

L
LED

(Light Emitting Diode) An indicator that illuminates under a low-level electrical charge.

M
MAC address

(Media Access Control address) A unique 48-bit number associated with a specific piece of 
hardware. The MAC address is programmed into each network card or device when it is 
manufactured.

MBC
(Multi Base Control) A Remote device can control up to 2 Base Stations.
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MTTF
(Mean Time To Failure)

N
NC

(Normally Closed) A contact pair that closes when the actuator is de-energized (no power is 
applied) and opens when the actuator is energized (power is applied).

NEMA
(National Electrical Manufacturers Association) The standard for the performance of various 
classes of electrical enclosures. The NEMA standards cover corrosion resistance, ability to help 
protect from rain, submersion, and so on. For IEC member countries, the IEC 60529 standard 
classifies the ingress protection rating for enclosures.

NO
(Normally Open) A contact pair that opens when the actuator is de-energized (no power is applied) 
and closes when the actuator is energized (power is applied).

P
PC

(Personal Computer)

PE
(Protective Earth) A common grounding connection to help avoid the hazard of electric shock by 
keeping any exposed conductive surface of a device at earth potential. To avoid possible voltage 
drop, no current is allowed to flow in this conductor (also referred to as Protective ground in North 
America or as an equipment grounding conductor in the US national electrical code).

PFD
(Probability of Failure on Demand)

PFH
(Probability of Failure per Hour)

PL
(Performance Level)

R
RJ45

A standard type of 8-pin connector for network cables.
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S
SELV

(Safety Extra Low Voltage) A system that follows IEC 61140 guidelines for power supplies is 
protected in such a way that voltage between any 2 accessible parts (or between 1 accessible part 
and the PE terminal for class 1 equipment) does not exceed a specified value under normal 
conditions or under inoperable conditions.

SFF
(Safe Failure Fraction)

SIL
(Safety Integrity Level) (according to IEC 61508) 

START warning time
Time between the STOP mode and START mode. During this time, the Horn is activated, the 
motion and auxiliary function are not enabled.

STO
(Safe Torque Off).

U
UL

(Underwriters Laboratories) A US organization for product testing and safety certification.

UOC
(Unintended Operating Control) The UOC function allows control of a drive STO input.
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